
 

 

User Guide for Origin 2020 
 



 

 

Copyright © 2020 by OriginLab Corporation  

  

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by 
any means without the written permission of OriginLab Corporation.  

  

OriginLab, Origin, and LabTalk are either registered trademarks or trademarks of OriginLab Corporation. Other 
product and company names mentioned herein may be the trademarks of their respective owners.  

  

  

  

  

  

OriginLab Corporation  

One Roundhouse Plaza  

Northampton, MA 01060  

USA  

(413) 586-2013  

(800) 969-7720  

Fax (413) 585-0126



 

 





 

v 

Table of Contents 
User Guide for Origin 2020 .......................................................................................................................... 1 

Table of Contents ....................................................................................................................................... v 

1 Introduction ................................................................................................................................... 1 

2 Installing and Updating Origin .......................................................................................................... 3 

3 Origin Resources ............................................................................................................................ 9 

4 OriginPro ..................................................................................................................................... 13 

5 What's New in 2020 ...................................................................................................................... 17 

6 The Origin Interface ...................................................................................................................... 27 

7 Origin File Types ........................................................................................................................... 51 

8 Import Data ................................................................................................................................. 53 

9 Workbooks Worksheets Columns .................................................................................................... 71 

10 Matrix Book Matrix Sheet Matrix Objects ......................................................................................... 107 

11 Graphing .................................................................................................................................... 123 

12 Customizing Graphs ..................................................................................................................... 163 

13 Graphical Exploration of Data ........................................................................................................ 203 

14 Gadgets ...................................................................................................................................... 225 

15 Data Analysis .............................................................................................................................. 229 

16 Statistics .................................................................................................................................... 253 

17 How to Handle Repetitive Tasks ..................................................................................................... 263 

18 Publishing and Export ................................................................................................................... 281 

19 Apps for Origin ............................................................................................................................ 295 

20 Programming in Origin ................................................................................................................. 303 

21 Customizing Origin ....................................................................................................................... 309 

22 Sharing Origin Files ...................................................................................................................... 321 

23 Origin Toolbars ............................................................................................................................ 325 

Index ..................................................................................................................................................... 343 





 

1 

1 Introduction 

Welcome, and thank you for using Origin! 

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists 
and engineers. What sets Origin apart from other applications is the ease with which you can customize and 
automate your data import, analysis, graphing and reporting tasks. 

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use, 
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch 
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple 
files or datasets. 

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your 
findings. And to help you get the most from Origin, we offer first-class customer and technical support, 
training and consulting services. 

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the 
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing 
and Image Handling. 

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new 
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who 
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or 
two about Origin that you had overlooked previously. 

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software's main 
menu) and numerous other learning resources exist. For a complete listing of available resources, see the 
Origin Resources chapter of this guide. 

 
Some things to look for in this guide: 

 

We have added short tutorials to numerous topics throughout this guide. These short 
tutorials are intended to give you a quick introduction to a key Origin feature. These 
tutorials will be marked with this icon. 

 

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are 
marked with this icon. 

 

Features that are new to this version of Origin will be marked with this icon. 

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing 
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter 
of this guide. 

http://www.originlab.com/doc/User-Guide/OriginPro
http://www.originlab.com/doc/User-Guide/Resources
http://www.originlab.com/doc/User-Guide/Resources
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2 Installing and Updating Origin 

2.1 Notes for Upgrade Users 

      

• The Origin upgrade installs into a new program folder - it does not update a previous version. It is 

therefore not necessary to install or uninstall a previous version of Origin before upgrading. 

• If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin 

2018 and later versions share a common license file and User Files Folder. The first time you run Origin 

2020, it should be licensed and know where your User Files are located. 

• If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see 

Selecting a User Files Folder, below). You will also be asked if you want to transfer your User Files and 

other workplace settings. Provided your Maintenance has not expired, you should not have to re-license 

your software. If your Maintenance has expired, you will need to re-license your Origin 2020 software 

(See Registering Origin, below). 

• If you are upgrading from Origin 2016 or earlier, you will need to complete the license management 

process. When your upgrade is launched for the first time, a license dialog will display asking for your 

Product Key If you have custom Origin files from your previous version, you can transfer them to your 

new User Files Folder. From the Preferences menu, select Transfer User Files. 

 
Lastly, we want to point out that your Origin software has some great new features. For more information on 
key features by version, see the originlab.com/VersionComparison page on our website. 

2.2 Notes for Administrators of Multi-user Packages 

 Instructions for getting started with the multi-seat node-locked and concurrent network packages are 
available on the OriginLab website (originlab.com/GetStarted). 

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform 
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin 
installation package for distribution. Information on the MSI installer and alternate deployment techniques can 
be found on our website: 

• MSI Installation 

• Silent Install 

• Building an Installation Package 

• Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix. 

2.3 Installing Origin 

Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a 
virtualization software. For more information, see the Running Origin on Mac using Virtualization 
Software, on the OriginLab website. 

There are three steps that must be completed to prepare Origin for use: 

• Installation 

http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
https://www.originlab.com/VersionComparison
https://www.originlab.com/getstarted
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/MSIInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/SilentInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/BuildanInstallPackage
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/RemoteAccessServer
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
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• Selecting a User Files Folder 

• License management 

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not 
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original 
version does not have to be installed when running the upgrade. 

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes 
an Origin installation button. If the startup program does not automatically run, you can browse the DVD to 
launch the setup.exe. 

 

Please note that Origin and OriginPro 2020 are only available as 64-bit versions. 

2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed 

If you already have the trial version of Origin installed on your computer, you can convert it to the full product 
or upgrade. 

• If you have purchased the Origin package with node-locked license management, run Origin and select 

Help:Convert Trial to Product; or you can use Help: Activate License, click the “Or if you have 

purchased already” radio button and choose Activate for this computer. In either case, you will be 

asked to enter the Product Key that was generated when you registered your software purchase on 

originlab.com. 

• For all other license management packages, run the Origin Add or Remove Files program located in the 

Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator 

permissions). When the Origin setup program starts, select the Modify option and then select Install 

Product (requires serial number). 

2.3.2 How to Correct or Change your Serial Number After you Complete an 

Installation 

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or 
Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a 
log in account with administrator permissions). When the Origin setup program starts, select the Modify 
option and then click Yes to change your serial number. 

2.4 Selecting a User Files Folder 

 Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data: 

• If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is 

unchanged. 

• If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF. 

You must choose a different path from your old UFF. 

• If you are upgrading from Origin 2017, you will also be prompted to transfer the contents of your old UFF 

and your toolbar and workspace configurations. 

https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
http://www.originlab.com/doc/License/Single-User-Node-Locked-Lic
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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• If you initially decline to copy your user files from an earlier version, you can do so by running the Origin 

software and selecting Preferences: Transfer User Files. For more information, see Transfer User Files. 

 

Consider these points in selecting your UFF: 

• If you have a mobile computer, it is best to select a location on your computer rather than on your 

network. 

• For non-mobile computers, you can select a location on the computer or on the network, as long as you 

have stable access to the folder.  

• Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin 

users, please see the chapter on Sharing Origin Files, later in this Guide. 

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the 
UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your 
UFF at any time while running Origin. From the Preferences menu, select Options and then click the System 
Path tab. 

2.5 Licensing Origin 

All Origin packages include license management. The type of license management provided with your package 
is determined at the time of your Origin purchase. 

2.5.1 Node-locked 

 Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by 
entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are 
provided for computers with no internet access. 

2.5.2 Concurrent Network 

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin 

administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains 
a license for this server from the OriginLab website, and then sets up a license service. The license service 
counts and restricts the number of Origin computers that can run concurrently. For more information, see the 
Help Center on the OriginLab website (originlab.com/HelpCenter). 

2.5.3 Dongle 

 A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the 
computer's USB port to run Origin. From Origin 2019, dongles are cross-version. Activate your dongle for 
version 2020 by entering a Product Key in the License Activation dialog when you start Origin 2020 at the 
first time. In-dialog instructions are provided for computers with no internet access. Once done, you can use 
this dongle for Origin installed with the same serial number on any other computers without re-activating the 
dongle. 

2.6 Registering Origin 

 Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors. 
Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing 
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center 
dialog, which provides direct access to Apps and App updates from your Origin software, requires that your 

installation be registered. 

http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/User-Guide/Sharing-Files
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter


UserGuide 

6 

For Node-locked licenses, registration is completed automatically when you enter a Product Key into the 
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About 
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin 
installation. 

 

For all other license management packages, open Origin, and then select Register on-line... from the Help 
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on 
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration 
ID into the Registration dialog to complete the process. The About Origin dialog should now display your 
Registration ID. 

2.7 Maintenance 

 Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free 
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting 
services, and a home-use license. 

• To check if your Origin package includes Maintenance, select the Help menu and then select About 

Origin. If your package includes Maintenance, the About Origin dialog will show your Maintenance 

expiration date. 

• To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor. 

• As your maintenance expiration date approaches, Origin will display a maintenance expiration message 

with a link to the OriginLab website to learn how to renew your maintenance. This reminder message 

provides a check box to prevent showing in the future. 

2.8 Service Releases 

 When called for, OriginLab publishes free service releases (patches). A service release typically provides bug 
fixes and may include some minor improvements. All customers are encouraged to apply service releases to 
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for 
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab 
website (originlab.com/Support). 

2.9 Notification of Upgrade 

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on 
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin 
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance 
customers by email. However, to make sure you receive notification of a new version release, please create an 
account on the OriginLab website (originlab.com) and select the check box in your user profile to receive 
"product updates". 

https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=SUPPORT
https://www.originlab.com/
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2.10 Setting the Origin Display Language 

 Origin packages sold to organizations in a limited number of countries, including Japan, Germany, 
Switzerland, Austria, Liechtenstein, and China, may support running Origin with English display, or with 
Japanese, German or Chinese display. To access this language control, select Change Language from the 
Help menu. 

2.11 System Transfers - Deactivating a License 

   

2.11.1 Node-locked Licenses (Computer ID-based) 

A system transfer is required if you plan to replace your licensed Origin computer with a different computer. 

• If Origin can still be used on your computer: 

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your 
Computer ID will be removed from OriginLab’s server so that you can install and activate on another 
computer. 

• If your licensed Origin computer is no longer available: 

1. Log into your portal at www.originlab.com. 

2. Under Licensing, click the Manage my License(s) link. 

3. Click on the Serial Number associated with the license that you want to deactivate. 

4. Click the go link in the Deactivation column. 

2.11.2 Concurrent Networks 

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not 
required when replacing an Origin computer. 

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available 
from the Support area of the OriginLab website. 

2.12 Uninstalling Origin 

 To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, 
or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays 
providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as 
prompted. 

https://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
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The Remove program deletes all folders and files that were installed by the Origin setup program. It also 
deletes folders and keys created by the installer in the Windows registry. 
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3 Origin Resources 

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor, 
your Origin distributor may provide additional resources. Please contact your distributor to learn more. 

3.1 Direct Support Resources for Origin 

 For Information On ... Go Here 

Technical Support 

• Contact information for OriginLab 

or your Origin Distributor  

• Report a bug 

• Suggest a feature 

originlab.com/Support 

Chat Online 

• Chat online with an OriginLab 

representative 

originlab.com 
 
... and click the Chat icon in the 
upper-right corner 

User Forum 

• Share information with and get 

help from the Origin user 

community 
originlab.com/Forum 

Training and 
Consulting 

• Making optimal use of OriginLab 

products 

• Help in developing custom tools 

for your particular application 

originlab.com/Support 

3.2 Resources Installed with your Origin Software 

   

 For Information On ... Go Here 

Learning Center 

• Load graph samples and 

analysis samples 

• Transfer User Files when 

upgrading to the latest version 

• Learning Center for direct 

access to Tutorials, Videos, 

Origin Blog, User Forum and 

Help: Learning Center (or press F11) 
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social media pages. 

Help Files 

• Online or local (CHM) Help for 

Origin (GUI, Programming) 
Help: Check for Updates (to update 
CHM files) 

Context-sensitive 
Help 

• Control-by-control explanation 

of Origin dialog boxes 

• The dialog box must be open 

• Some dialogs have multiple 

sections/tabs and you may 

have to click on that 

section/tab to set the focus 

Press F1 when the dialog box is open 
 
or 
 

Click in the upper-right corner of the 
dialog box 

Start Menu 
- Windows-like 

Search 

• Recent files 

• Help with problems or 

questions that arise while 

using Origin 

• Direct access to Origin features 

and dialog boxes 

• Open or search for Apps 

relevant to a particular task 

• Location of Origin menu 

commands for searched-for 

features 

Press F1 when no dialog box is 

open 

 

or 

 

Click the Start menu icon at the 

bottom-left of the workspace.  

 

 
For additional information on using 
this feature, see 
The Origin Interface, Start Menu. 

Tutorials 

• Step-by-step instructions on 

performing many Origin 

operations, from the simple to 

the complex 

Help: Origin : Tutorials 

3.3 Online Resources for Origin 

 

 For Information On ... Go Here 

http://www.originlab.com/doc/User-Guide/Origin-Interface
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Online 
Documentation 

• Product documentation 
originlab.com/Doc 

Help Center 

• Resources list 

• Installation and License 

Documentation 

• Contact Info 

originlab.com/HelpCenter 

Video Tutorials 

• Help with a wide range of 

Origin's key features originlab.com/Videos 

Webinars 

• Live and recorded webinars 

highlighting key features originlab.com/Webinars 

Origin Blog 

• Blog posts with plenty of 

software tips and tricks blog.originlab.com 

Case Studies 

• How others are using Origin in 

their work originlab.com/CaseStudies 

Graph Gallery 

• Outstanding examples of Origin 

graphs, many of them submitted 

by the Origin community 
originlab.com/GraphGallery 

 

Information on key Origin features often can be found by just doing a quick web 
search. Open a browser and search on phrases such as... "Origin shortcut keys", 
"LabTalk graph legend", or "OriginC NAG functions". 
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4 OriginPro 

 

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis 
tools and capabilities. If you don't know which product you have -- Origin or OriginPro -- look to the title 
bar. 

 

 

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by contacting your 
Origin representative. 

4.1.1 Curve Fitting 

 In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the 
following: 

• Linear fitting with X error. 

• Nonlinear fitting with X and Y errors (orthogonal regression). 

• Fitting with implicit functions (orthogonal distance regression). 

• Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two 

datasets to one model. 

• Global fitting of multiple curves using different functions, with the option of sharing parameters. 

 
For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting. 

4.1.2 Surface Fitting 

  With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including 
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function. 

• Fit worksheet data (XYZ) or matrix data (Z values). 

• Locate and fit multiple peaks using one of several peak identification methods. 

• Automatic peak parameter initialization. 

• Apply constraints and bounds to parameters and fix parameter values. 

• Output parameter and statistical results plus residual curves. 

• Find specific Z values along the fit surface and include them in your output. 

• Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use. 

 
For more information, see this web page: Surface Fitting. 

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/LinearAndPolynomialFitting
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/NonlinearFitting
http://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting#Surface_Fitting_PRO
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4.1.3 Peak Fitting 

 OriginPro includes the Peak Analyzer tool with support for the following: 

• Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative). 

• Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined, 

None). 

• Fit Peaks with built-in or user-defined functions. 

• Fit individual peaks with different fitting functions. 

• Fit Baseline as part of the peak fitting process (user-defined or built-in functions). 

• Control fit parameters (fix, share, set bounds). 

• Batch peak analysis using a predefined Theme file. 

 
For more information, see this web page: Peak Fitting. 

4.1.4 Statistics 

 OriginPro includes support for advanced statistical analyses in these areas:   

• Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation 

coefficient). 

• ANOVA (one-/two-way repeated measures, three-way). 

• Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial 

least squares). 

• Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival 

functions) 

• Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-

/two-sample proportion test). 

• Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney, 

two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support 

for simultaneous tests). 

• Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test, 

one-way ANOVA). 

• ROC curve analysis. 

 
For more information, see this web page: Statistics. 

4.1.5 Signal Processing 

 In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro: 

• Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT). 

• Filtering (IIR filter design, 2D FFT filter). 

http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/PeakAnalysis#Peak_Fitting_PRO
http://www.originlab.com/index.aspx?go=Products/Origin/Statistics
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• Correlation (2D correlation). 

• Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet 

transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D 

wavelet reconstruction). 

• Rise-time Gadget (linear search, histogram, largest triangle). 

• Decimation (moving average, finite impulse response). 

• Coherence. 

• Envelope curves (upper and/or lower, smooth during envelope detection). 

 
For more information, see this web page: Signal Processing. 

4.1.6 Gadgets 

 Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are 
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-
of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets: 

• Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and 

deleting points). 

• 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data). 

• Rise-time Gadget (analyze rise/fall time of stepped signals). 

 
For more information, see this web page: Exploratory Analysis. 

4.1.7 Image Processing 

 Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional 
tools in the following areas: 

• Image adjustments (function lookup table, leveling). 

• Image conversion (dynamic binary, threshold, RGB merge/split, image scale). 

• Spatial filters (user filter). 

• Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological 

filter, pixel logic, replace background, subtract background, subtract interpolated background). 

 
For more information, see this web page: Image Processing. 

4.1.8 Apps 

Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro 

license to run. OriginPro-only Apps will be listed in the Origin File Exchange with a red symbol beside 
them. 

Here are some of our more popular OriginPro Apps: 

http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/SignalProcessing
http://www.originlab.com/index.aspx?go=PRODUCTS/Origin#Exploratory_Analysis
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/ImageProcessing
http://www.originlab.com/fileexchange/index.aspx
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• Rank Models 

• Peak Deconvolution 

• Design of Experiments 

• Independent Component Analysis (Requires R software) 

• Logistic Regression 

• Sequential Fit 

• Piecewise Fit 

• Piecewise Smooth 

• Principal Component Analysis 

• Principal Component Analysis for Spectroscopy 

• Slope Analyzer 

• Global Peak Fit 

• Cyclic Voltammetry 

• Enzyme Kinetics 

• Polynomial Surface Fit 

• Heat Map with Dendrogram 

• Simple Time Series Analysis 

• Time-Frequency Analysis 

• Monte Carlo Simulation 

• General Linear Regression 

• Chi-Square Test 

• Sequential Fit 

• 3D Confidence Ellipsoid 

 
For general information on Apps visit www.originlab.com/apps. 

https://www.originlab.com/fileExchange/details.aspx?fid=440
https://www.originlab.com/fileExchange/details.aspx?fid=453
https://www.originlab.com/fileExchange/details.aspx?fid=462
https://www.originlab.com/fileExchange/details.aspx?fid=457
http://www.originlab.com/fileExchange/details.aspx?fid=329
https://www.originlab.com/fileExchange/details.aspx?fid=321
http://www.originlab.com/fileExchange/details.aspx?fid=325
http://originlab.com/fileExchange/details.aspx?fid=369
https://www.originlab.com/fileExchange/details.aspx?fid=328
https://www.originlab.com/fileExchange/details.aspx?fid=326
https://www.originlab.com/fileExchange/details.aspx?fid=346
https://www.originlab.com/fileExchange/details.aspx?fid=395
http://originlab.com/fileExchange/details.aspx?fid=383
https://www.originlab.com/fileExchange/details.aspx?fid=335
https://www.originlab.com/fileExchange/details.aspx?fid=282
https://www.originlab.com/fileExchange/details.aspx?fid=223
https://www.originlab.com/fileExchange/details.aspx?fid=332
https://www.originlab.com/fileExchange/details.aspx?fid=298
https://www.originlab.com/fileExchange/details.aspx?fid=295
https://www.originlab.com/fileExchange/details.aspx?fid=336
http://originlab.com/fileExchange/details.aspx?fid=339
http://www.originlab.com/fileExchange/details.aspx?fid=321
http://originlab.com/fileExchange/details.aspx?fid=280
http://www.originlab.com/apps
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5 What's New in 2020 

  

5.1 Origin 2020 New Feature Highlights 

 

Visit www.originlab.com For Origin 2020 Feature Highlights, including a Highlights 
video. 

• Mini Toolbars for Faster Graph Customization 

• Context-sensitive popup controls for fast graph edits 

• Fast editing of page, layer, plot, axis and label properties 

• "Settings" button for access to advanced controls 

• Faster Import of Text Data 

• Multi-threaded import for CSV Connector and ASCII files (Single ASCII, Multiple ASCII, 

Import Wizard, CSV) 

• Fast Scatter Plots for Large Datasets 

• Default scatter plot drawing speed has been significantly improved for large datasets 

• New templates: Density Dots and Color Dots (color-mapped to a third column) 

• Drag out a rectangle with the Data Highlighter to highlight a region of interest 

• Copy and Paste Tables as HTML to Other Applications 

• A new Copy Table (HTML, EMF) shortcut menu option is added to result tables and 

Analysis Report Sheets 

• The pasted table can be further formatted and edited in supporting applications 

• Doughnut Charts and Improved Pie Charts 

• Updated Pie charts with several new templates (e.g. "Pie of Pie") 

• All-new Doughnut Charts with several template variations 

• Sankey Diagrams 

• All-new plot type for charting flows 

https://www.originlab.com/2020
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• Excel-like Absolute Cell References for Cell Formula 

• You can now use the $ character in cell formulas when you need to make absolute cell 

references 

• Improved Dendrogram 

• The dendrogram produced by such analyses as Hierarchical Cluster Analysis is much 

improved for 2020 

• Options to color nodes individually, to break out nodes as separate graphs or to draw circular 

dendrograms 

• Other Graph Types 

• Kite Diagram 

• Pyramid Plot 

• Before-After Plot 

• Organize Workbooks in Object Manager 

• Use the Object Manager to manipulate worksheets in the book 

5.2 New Features by Category 

5.2.1 Ease of Use 

• Context-sensitive Mini Toolbars for faster graph customization 

• Click on a data plot, graph layer, axis, etc. to display popup controls for typical graph 

customizations 

• Includes support for error bars, box charts, histograms, pie charts, contour plots and heat 

maps 

• Plot Details: Compact Popup for Font and Line Format 

• Associated Font and Line format controls are grouped together behind a single popup, to 

conserve screen space 

• Plot Menu Improvements: 

• New Plot menu category for Multi-Panel/Axis plots for easier access 
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• List Mode in Template Library 

• Toggle between details and preview modes of graph templates 

• Object Manager for Workbook windows 

• List all sheets in the active window 

• Clicking on a sheet in Object Manager will activate the corresponding sheet in the workbook. 

• Right-click on the window in Object Manager to initiate common operations: Delete, Insert, 

Add, Move, Copy, Rename, etc. 

• Simplified plot selection 

• Previously, a single-click on a plot group would select the entire group, the second click 

selected the plot and a third click selected a special point 

• In Origin 2020, a single-click will select a plot, CTRL + click will select a single point and 

SHIFT + click will select all plots in the group. To revert to the previous behavior, set 

@GSM=0 

• Copy and Paste tables to other applications 

• Copy a block of cells or results table from an Origin worksheet, including column labels, as 

an HTML table or EMF image and preserve table structure and special formatting when 

pasting to other applications such as MS Word 

• If the target application supports editing, table design and contents can be modified (EMF is 

useful for Adobe Illustrator as it doesn't support pasting of HTML) 

• Indicate selected graph in Merge Graph Windows dialog box 

• Highlighting a graph in the Graphs list highlights the corresponding plot in the Preview 

window 

• Add a "Find Apps" menu entry for "Fitting", "Peaks and Baseline" and "Statistics" menus 

• App Center opens to show only Apps relevant to Fitting, etc. 

• Added Hotkeys for Worksheet 

• CTRL + SHIFT + END extends selection to the last filled cell in the sheet 

• CTRL + SHIFT + HOME extends selection to the cell in row 1, column 1 

• SHIFT + arrow key extends the selection to additional columns or rows 
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• Selecting Plot Selects Corresponding Worksheet Data 

• View: Show Plot Selection in Workbook menu entry is checked by default. Clear check 

mark to prevent worksheet data selection. The default behavior can be changed by setting 

LabTalk system variable @PS 

• Load Template dialog cue for sorting headers 

• File: New from Template now shows a clearer indicator that the columns in the dialog can 

be sorted 

• Change Parameters context menu 

• You can now right-click directly in the hierarchical result sheet to Change Parameters -- no 

need to scroll to the top of the sheet and click the lock icon 

5.2.2 New Graph Types 

 

To see new graph samples for Origin 2020, press F11 and in Search, enter 2020. 

• Pie Chart Improvements 

• Many pie chart variations (including "doughnut" and "pie of pie") 

• Set wedge total to < 100% to draw a portion of the pie 

• Sort wedges by size or by column values 

• Set pie slice thickness by column values 

• Combine exploded wedges 

• plus, label and leader line improvements 

• Sankey Diagrams 

• Used to chart flows, with arrow size proportional to flow component 

• Full control over display of links, nodes, colors (single, gradient), transparency, curvature, 

etc. 

• Alluvial Diagrams 

• Alluvial Diagrams are also used to chart flows but are more similar to Origin's Parallel Sets 

plots than to Sankey Diagrams 
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• Kite Diagrams 

• Used to compare trends and relative occurrence among multiple categories. Most commonly 

used to plot transect data in ecological studies. 

• Additional layers can be added as supporting plots (e.g. line graphs of topographic profile) 

• Density Dots and Color Dots 

• Basic 2D scatter plots for large datasets 

• Fast-rendering dot plot for viewing data distributions 

• Color can be mapped to a column of values 

• Support for Window View mode 

• Population Pyramid 

• Composed of two opposing histograms, this chart type is used to display population by age 

group 

• Before-and-After Graph 

• A simple line+symbol plot used to make paired comparisons 

5.2.3 Graph Customization 

• Faster Drawing Speed 

• Improved scatter plot drawing speed with Speed Mode off (especially with square symbols + 

color-mapping where it is 5 - 10 times faster) 

• Data Highlight Speed Improvement 

• Much faster response times when dragging out a region of points with the Data Highlighter 

tool 

• Offset Data Points in Box Charts 

• Optionally, alternate the offset in paired plots 

• Text object Properties dialog box improvements 

• SuperSubscript button and Align Columns check box (for aligning legends) 
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• Add Arrowhead Pointer to Custom Legend Symbols 

• Improvement to Skip Points and Speed Mode 

• Skip Points and Speed Mode now keep last data point, by default 

• Set @SMEP=0 to roll back to the old default of allowing skipping of last point 

• Rug Marks in Trellis Plots 

• Rug marks for individual panels 

• Plot: 3D: 3D Scatter + Z Error 

• If there is a Z column immediately following the plotted Z, the second Z column values will 

plot as error bars in the Z direction 

• Windrose Plot Additions 

• Support for uneven bin sizes 

• Show Calms Circle in center of plot 

• Paddle Spoke Style option added (Spacing tab of Plot Details) 

• Data Highlighting for Box Charts 

• In Origin 2019b, highlighting corresponding worksheet data only worked for basic graphs 

such as line, scatter, column/bar. This is now supported when selecting individual boxes in a 

box chart 

• Color Scale Enhancements 

• Control scale range from the Color Scale Control dialog 

• Formula to control tick labels in color scale object 

• Min- and max-only labels at inside or outside ends of scale 

• Improved Tooltips for Countour Plot and Heat Map 

• Display X, Y, Z values on hover. Contour plots support display of interpolated values 

5.2.4 Import & Export 

• Multi-threaded ASCII Import 
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• Fast, multi-threaded import added for Import ASCII, Import CSV, and the CSV Data 

Connector. Two system variables, @IAMT and @IAS, are added to modify multi-threading 

behaviors 

• CSV Connector Improvements 

• Import first 50 lines as preview option 

• Partial Import: Special syntax allows high degree of specificity 

• Data Block Marker: Enter one or more characters that define the start and end of a data 

block (e.g. "[Data]" or ">>>>>Start<<<<<") 

• Excel Connector Improvements 

• Specify location of Long Names, Units and Comments (From and To) in the Excel file 

when importing 

• Drag and Drop Support for Data Connector 

• When you drag and drop a file type for which there is a Data Connector, a dialog opens to 

allow you to specify whether to import by Connector (Data: Connect to File) or to use the 

Import from File (Data: Import from File) methods 

• Origin Internal SQL-like Query Support 

• A Query button has been added to the Origin Connector. Use the query function to import 

just the data that you need 

• Data Connector-like Support for Database 

• Faster data import 

• Support Exclude Imported Data when saving as OPJU/OGWU 

• New system variable (@IPDB) to control protection of imported range 

5.2.5 Worksheet 

• Support Excel-like "$" Absolute Cell References 

• Origin adopts the Excel cell-reference "$" syntax for more straightforward absolute cell 

references. This should make constructing cell formulas easier, particularly for those who 

have used MS Excel 

• Worksheet Short Name, Long Name Improvements 
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• System Variable @SSL is added to control sheet display name 

• Plot Setup, Layer Contents dialogs to use same display name, by default 

• Support Copy of Label Rows with Subrange Selection 

• You can now make a subrange selection in the worksheet, right-click and opt for Copy 

(including label rows) 

• sum() Function Supports Row-wise Calculation 

Examples: 

• Sum(A:D) // to sum row-wise from column A to D 

• Sum(A, C:D, F:H) // to sum row-wise columns A, C to D and F to H 

• Show Column Index and Data Size in Column List View 

• Appears as tooltip on hover 

• Filter Automatically Run on Data Import 

• Previously, filters needed to be reapplied manually after data import 

• Improved Performance of Large Data + Filter 

• Interface is more responsive now when working with large datasets and filtered data 

5.2.6 Analysis 

• Improvements to Normalize Tool 

• Treat multiple datasets as a single dataset for normalization. 

• Support Simple LabTalk Expressions in Insert Straight Line and other X-Functions 

• Support LabTalk expression for At Value (e.g. -log(0.05)). 

• Support info variables and column values for as input (e.g. 

page.info.user.variables.noofpoints) 

• Simple Curve Math Supports Custom Formula 
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• Simple Curve math (Analysis: Mathematics: Simple Curve Math) supports custom 

formula for input data (y1) and reference data (y2) (e.g. y1*5-y2^2) 

• Batch Processing Export of Multi-page file 

• Export MS Word and PDF as a single, multi-page file 

• Support Include Filtered (Hidden) Rows in Analysis 

• By default, when there is a data filter on a column that is input for an analysis operation, 

filtered (hidden) rows are ignored. The analysis lock context menu now has Ignore Hidden 

Rows = No so that you can include hidden rows 

• Open Axis DB from Peak Analysis Preview 

• Double-clicking on the axis in PA Preview opens the Axis DB to set axis scale range 

• Copy All Open Tables 

• Click a table heading in the Analysis Report Sheet to Copy All Open Tables. All expanded 

tables are copied. 

• Copy Table as HTML or EMF 

• Result tables pasted to graphs can be opened by double-clicking on them. Right-click on the 

open table and Copy Table (HTML, EMF), then paste (or paste special) as to the target 

application as an editable table. 

• Kernel Density: Faster Algorithm 

• Previously, large 2D Kernel Density plots could take hours to draw. A new Density Method 

Binned Approximate Estimation method when used with an Interpolate Density Points 

check box, reduces the time to just seconds 

5.2.7 Programming 

• New LabTalk Options for Gadget Output 

• gd.Output(); now has the following options: 

 

0 -- normal 
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1 -- last 

2 -- all curves 

3 -- all layers 

4 -- entire curve // Quick Peaks Gadget only 

• Read/Write to Polygon/Polyline objects via LabTalk 

• Read and set object properties (e.g. point count and coordinates of each) 

• NAG Library is Upgraded to Version Mark 26.1 

• Python Update 

• Embedded version updated to 3.7.2 

5.2.8 Apps for 2020 

The following Apps are new for Origin 2020: 

• 2D Peak Analysis 

• Import NMR Data 

• LeCroy Connector 

• Marginal Abatement Cost Curve 

• Neural Network Fitting 

• Piper Diagram 

• Soil and Rock Classification Diagrams 

• Video Data Explorer 

• Word Connector 
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6 The Origin Interface 

6.1 The Origin Workspace 

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim 
this chapter. 

 

6.1.1 Windows File Explorer Previews 

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to 
preview graphs in a project file. 
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• Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View: 

Large Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the 

last active graph before the project file was saved. 

• Open the Preview Pane (ALT + P) and scroll through all graphs in the project file. 

6.1.2 Origin Menus and Menu Commands 

• Context-sensitivity of menu bar and menus: The menu bar and menu commands are context-

sensitive; they change as you change window type (from worksheet to graph to matrix, for instance). 

Only menus pertinent to the active window will display. 

• Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that 

display to the left of the command. Additionally, you may see a shortcut key combination listed to the 

right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the 

same functionality. 

• Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut 

menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent 

menu commands will show. 

• Collapsible menus: By default, main and shortcut menus in Origin are "collapsed", meaning they display 

an abbreviated set of commands. When you use a menu item which isn't included, it is added to the 

menu. If you prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear 

the Enable Collapsible Menus box. 
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• Most frequently used analysis menu commands: Most-recently used menu commands will appear at 

the bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick 

access to tools when performing repeat operations. 

• Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu 

Organizer  to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this 

Guide. 

6.1.3 Origin Toolbars 

 Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize 
toolbars. 

• Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars 

dialog box to modify button and toolbar appearance. 

• Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar, 

hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar 

off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title 

bar. 

• Hide/Show a toolbar: Clicking the Close button on a toolbar removes the toolbar from view. To restore 

a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar. 

• Hide/Show a button: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a 

toolbar. 

• Move button location: Alt+drag a button to move it to a new location within or among toolbars. 

Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window till X shows to 

remove a button. 

 

Origin 2020 introduces context-sensitive Mini Toolbars for graph editing. These 
toolbars appear when the user clicks inside a graph page. Available controls depend on 
where the user clicks and the type of graph that is being edited. For more information, 
see the Customizing Graphs chapter. 

6.1.4 Start Menu 

Enter keywords and phrases into the Start menu to return relevant Menu entries, Apps, FAQs, Videos and 
X-Functions. Open recently-opened Files, Menus and Apps. 

Open the Start menu by pressing F1 (no dialogs open) or by clicking the red Origin icon at the bottom left 
corner of the Origin workspace. 

http://www.originlab.com/doc/User-Guide/Customizing-Origin
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
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To narrow your search, type the following letters in front of the search term(s): 
 
m = search only Menu entries 
a = search only Apps 
h = search only Help + FAQ 
v = search only Videos 
x = search only X-Functions 
p = search your recent projects 
s = search sample projects 
e = search Menus + Apps + X-Functions (only executable) 

Alternately ... 

Click the "gear" icon beside the search field to open the Settings box. Here you can restrict search results and 
tweak other search settings. 
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6.1.5 New Workbook Dialog 

The workbook is central to most Origin tasks. It receives imported data, it contains data to be manipulated, 
plotted or analyzed and it can even be customized for batch analyses or for creating reports in PDF format. 
Each task often requires a unique set of data handling and format "instructions" -- a custom configuration set 
up by you, the user. Once so configured, a workbook window can be saved as a template file and reused any 
time you need to create the same or similar data handling and format instructions. 

The primary purpose of the New Workbook dialog box is to help organize and access your workbook 
templates. Use the dialog to create workbook windows ... 

• ... from built-in System Templates. 

• ... from your own User Templates. 

• ... on the fly, using controls on the Construct Columns tab. 
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There are also check boxes to: 

• Show the New Workbook dialog on startup or when you open a new project (File: New Project). 

• To set the highlighted template as default on running Origin or when starting a new project. 

 
The New Workbook dialog opens, by default, when you run Origin. If you later opt to hide the dialog on 
startup, you can open it at any time by choosing File: New Workbook. 

6.1.6 Learning Center 

Learning Center is a "startup" dialog intended to give you quick access to graphing and analysis examples, 
plus learning resources (tutorials, videos, the OriginLab blog, etc.). 

To open the dialog, choose Help: Learning Center or press F11. 
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• View and load sample graphs, including sample data and notes on re-creating the graph. 

• Load analysis samples with data. 

• Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and 

Origin social media pages. 

• Move files from your previous User Files Folder to your new User Files Folder. 

 

To see new graphs in Origin 2020, open the Learning Center, click the Graph 
Samples tab, set the plot filter drop-down to All Plot Types and search on 2020. 

6.1.7 Project Explorer 

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ). 

http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
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Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel 
shows windows contained in the folder that is highlighted in the primary panel. 

 

Prior to 2018, the sub-panel listed sub-folders under the selected folder. If you would 
like to restore the old behavior, open the Script Window (Window: Script Window), 
type the following and press <Enter>: 

 

@PEF = 1 

To permanently change the behavior, see FAQ-708 How do I permanently change the 
value of a system variable? 

 
Using Project Explorer to manage your projects: 

• Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical 

Alignment) or side-by-side (Horizontal Alignment). 

• Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on 

what is selected or where you have right-clicked. 

• Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your 

mouse). 

• The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons, 

Extra Large Icons. 

• In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or 

layout window. Notes window content is shown in a tooltip. 

http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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• When displaying windows as Extra Large Icons, the PE sub-panel displays a thumbnail of graphs, layout 

windows, workbooks and matrix books. Notes window content is shown in a tooltip. 

 

 

You can right-click on PE folder (upper panel) and choose Copy -- or select the folder 
and do a CTRL + C and CTRL + V -- to copy and paste the folder structure and content 
to (a) another folder in the current project or (b) another project running in a second 
Origin session. To copy a single workbook window, right-click on the window (lower 
panel) and copy and then paste the window to (a) another folder in the same project, 
or (b) to a new project running in a second Origin session. 

 

1. Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag 

the file Tutorial Data.opj to your Origin workspace. 

2. By default, Project Explorer is docked to the left side of the Origin workspace in 

auto-hide mode. Mouse over the Project Explorer tab to show the PE window.  
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3. Click on the "push pin" icon on the PE title bar to pin the window in the docked 

position.  

 

4. By default the sub-panel is in Details view. In this view, window metadata such as 

Name, Size and Comments show below these column headings. Try dragging 

column headers to reorder them.  

 

5. Right-click on the column headings and show or hide any of the headings by 

checking or unchecking the box beside each.  
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6. To add a comment in the Comments field, click once, pause briefly and click a 

second time. This puts you into edit mode. Enter a comment.  

 

7. To change the Name of a window, right-click in the row and choose Rename. By 

default, the Name field displays the window Short Name; or if a window Long 

Name exists, the window Long Name (all windows must have a Short Name but 

Long Names are optional). Click the SN or LN button to the right-side of the 

editable Name field to edit the Short Name or Long Name. If the Long Name does 

not exist, you can enter one.  

 

8. In the top panel of Project Explorer, scroll to the folder 3D Surface with Point 

Label and click on it. The sub-panel shows that there are three windows in the 

folder. Note that the worksheet window eastcali3053 is bold indicating that it is the 

"active" window - the window that is being acted upon as well as the window that 

determines what operations are available. There is also a Notes window, and a 

matrix window named MBook4.  



UserGuide 

38 

 

9. In the sub-panel, double-click on MBook4 and note that it is now bold and has a 

magenta "halo", indicating that it is the active window. You will also see that the 

whole window(in the workspace) displays with a halo which can be customized in 

color with the system variable @AWC-- another indicator that this is the "active" 

window. Double-click on this MBook4 icon again and note that the icon is now 

dimmed. Note also that the actual window disappears from the workspace. This is 

because MBook4 is now hidden. Double-click the MBook4 icon again and the 

window is restored and made active.  

 

10. With MBook4 active, click Plot > 3D: Surface: 3D Colormap. This creates a 3D 

colormap surface graph (close the attention message). Note also that a new window -- 

Graph1 -- has been added to the sub-panel of Project Explorer. 

11. Right-click in an empty portion of the sub-panel and choose View: Extra Large 

Icons. Note that Graph1 now displays a graph thumbnail.  

 

12. Right-click again and choose View: Large Icons. Note that windows are now 

represented by icons but if you hover on them, you can see the window contents as 

a pop-up.  

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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To disable PE previews, open the Script Window (Window: Script Window) and type 
one or both of the following, then highlight the text and press Enter: 

 

@PESS=-1; //turn off window preview in PE, show window comments 

as tooltip 

@PESH=0; //turn off window comments tooltip 

When you set the value of a system variable using the Script Window, you are altering 
Origin's behavior for the current session only. To set the value of a system variable 
across sessions, see this FAQ. 

6.1.8 Apps Gallery and App Center 

 Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number 
of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin 

http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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software. 

 

Use the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you 
direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and 
navigate there. 

 

 
To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at 
the right-side of your Origin workspace. If you do not see the Apps Gallery, click View: Apps (or ALT + 9) and 
verify that there is a check mark beside Apps. 

• Installed and Up-to-date Apps will appear in the App Center with a green check mark beside them  

• Installed Apps for which there is a newer version will appear with an Update icon beside them  

• Those not installed will appear with a clickable Download and Install icon beside them  
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Origin 2020 adds a Find Apps menu item to Statistics, Analysis: Fitting and 
Analysis: Peaks and Baseline. Clicking Find Apps will open the App Center to show 
only Apps that relate to the current menu. You can download or update Apps directly 
from the App Center. 

For more information on Apps, please visit www.originlab.com/apps. 

6.1.9 Object Manager 

 The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the 
Object Manager for quick manipulation of the active graph or workbook window (New!). 

 
Graph Windows 

• Select an element (layer, plot group, data plot or special point) in the Object Manager to select the 

corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the 

graph layer and (b) selects the source data in the worksheet. 

 

• Hide or show plot elements by clearing or checking the corresponding box in the Object Manager. 

• At the graph level, change Object Manager list order. 

• At the layer level, change layer order. 

• At the plot level, show labels, show or hide plots, reorder plots or create plot groups. 

• Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu 

command, change plot type. 

• Remove a plot (permanently) from the graph window. 

• Access the Plot Details, Layer Contents and Plot Setup dialog boxes. 

 
Workbook Windows 

http://originlab.com/index.aspx?go=PRODUCTS&PID=3236
http://www.originlab.com/doc/User-Guide/Graphing
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Beginning with Origin 2020, the Object Manager adds support for workbooks: 

• List all sheets in the active workbook. 

• Click a sheet in Object Manager to activate the corresponding sheet in the workbook. 

• Right-click in Object Manager for access to common worksheet operations, including 

Delete, Insert, Add, Move, Copy, and Rename. 

 

 

6.1.10 Origin Child Windows 

 

 

Active windows -- the window that will be acted upon by graphing and analysis 
operations -- display a colored frame to make the active window more obvious. You can 
customize the active window indicator properties (frame color, where the frame shows, 
frame line style) with "@ System Variables" @AWC (color) and @AWI (style). 

 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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• Origin Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing, 

transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each 

sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data, 

workbook windows may also store graphs, annotations, column-based functions, scripts and 

programmable button objects, LabTalk variables and import filters. 

• Origin Matrix Books: Like the worksheet, a matrix sheet is a grid of cells, arranged in rows and 

columns. The primary difference is that in the worksheet, each column is a dataset and each dataset can 

be configured to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). 

In contrast, the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and 

column (X) index numbers. The matrix book contains between 1 and 1,024 sheets. Each sheet can contain 

multiple matrix objects (up to 65,504 on a 64-bit OS). 

• Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart 

types, chosen specifically for their applications in various technical fields. Each chart is created using a 

built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data 

plots, the graph may also contain annotations (text and drawing objects) or button objects that, when 

triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet 

cells or "floated" on worksheets (outside the grid) in a workbook window. 

• Function Graphs: The function graph is a specialized graph window that displays a curve described by a 

function. The function graph differs from other Origin graphs in that it is not produced from a dataset of 

discreet values (though you can generate data after plotting). 

• Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and 

various annotations onto a single "display panel." It is used primarily for creating presentations. 

• Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved 

separately or as part of your Origin project file. 

• Notes: The Notes window is a text-only window used for recording analysis procedures, making notes to 

students and colleagues, and cutting and pasting text from other applications. 

Note: For more information on Origin's child windows, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a 

Child Window 

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child 

Window Operations 

 
 
To save an Origin child window independently of the Origin project file: 

• Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for 

Origin Workbook, Graph and Matrix windows, respectively. 

• Right-click any window title bar and choose Save as... context menu. 

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose 
Save Workbook as... context menu. 

http://www.originlab.com/doc/Origin-Help/Create-ChildWindow
http://www.originlab.com/doc/Origin-Help/Create-ChildWindow
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
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Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and 
templates. When you save a window file, you will have the option of saving a file with 
or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file 
only in the latest version of Origin, you should choose the Unicode-compliant 
(appended "u") option as it offers some performance advantages. 

 
To open a worksheet, graph, matrix, or notes window that was saved to a file: 

• Select File: Open or click the Open button on the Standard toolbar to open window files. 

• Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window 

files. 

Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be 
unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the 
project. If you open window file in the current project, then save the project, the window will be included in 
the project. 

 
To open an Excel workbook file: 

• Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the 

Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu 

to import the Excel file. 

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs 
inside Origin. In this mode, you have only limited access to Origin features. If you choose Import Excel, the 
Excel file is imported into an Origin workbook and all Origin features are available. 

6.1.11 The Command Window and Script Window 

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical 
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped 
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing x-function command. 

The Command Window is dockable and has two panels. The left-hand panel displays the command history, 
while the right-hand panel provides the command line. 

The Script Window provides some of the same functionality as the Command Window. It lacks some of the 
Command Window's features (no intellisense, no command prompt, no command history) but it is handy for 
issuing LabTalk commands and running Python scripts. The window's Tools menu also opens the LabTalk 
Variables and Functions dialog box where you can view a list of Origin variables, functions, macros, loose 
datasets, etc. 

 
To open the Command Window: 

• Click the Command Window button on the Standard toolbar. Alternately, select Window: 

Command Window menu or press ALT+3. 

 
To open the Script Window: 
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• Select Window: Script Window menu or press SHIFT+ALT+3. 

6.1.12 The Status Bar 

 

 

The  Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including: 

• Help messages and tool descriptions. 

• Statistics on the current workbook, matrix or graph selection. 

• Whether the AutoUpdate analysis feature is turned on. 

• The name of the System Theme, if any. 

• Information pertinent to the active window. 

• Angular unit (radians, degrees, or gradians). 

• Tool tips for functions listed in the Set Values F(x) menu. 

• Notifications from OriginLab, represented by a small red flag to the right side of the Status Bar.  

 

Note: You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) 

items from the context menu. You can copy displayed statistical values by selecting Copy Statistics from 

the context menu. The copied data are TAB separated between quantity and values, with each key value 

pair separated by a CRLF delimiter. 

6.1.13 Smart Hints and the Smart Hint Log 

 

Smart Hints are triggered by user actions and are intended to give the user help with current task. These 
hints may appear briefly inside a dialog box, as in this example. 
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Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example. 

 

 
Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking 
the "Do not show this message in the future" box at the bottom of a Smart Hint. 

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab, 
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged). 

 

 
To open (and close) the Smart Hint Log window: 

1. From the Origin menu, select View: Smart Hint Log or press ALT+7. 

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the 
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you 
to confirm that you do not want to show or log this message. 

To turn off all Smart Hint display in the session, open the Script Window and type the following: 

 

@SHS = 0; 
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To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help: 
Reactivate All Hints. 

 

You can customize general properties of Smart Hints by setting system variables @SHG 
and @SHO. See the system variable list for details. 

 

When you set the value of a system variable using the Script Window, you are altering 
Origin's behavior for the current session only. To set the value of a system variable 
across sessions, see this FAQ. 

6.1.14 Code Builder 

Origin's programming language is called Origin C. Origin C's integrated development environment (IDE) is 
called Code Builder. Code Builder provides tools for writing, compiling, and debugging your Origin C 
functions.Origin C, IDE 

To open Code Builder: 

1. From the Origin menu, select View: Code Builder. Alternately, click the Code Builder button on the 

Standard toolbar or press ALT+4. 

6.1.15 Messages Log 

The Messages Log window shows messages about operations including Output Information, Results and 
Errors. It displays messages that are not sent to the Script Window or the Command Window. 

 
To open (and close) the Messages Log window: 

1. From the Origin menu, select View: Messages Log or press ALT+6. 

6.1.16 Results Log 

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log 
includes a date/time stamp, a window name, a numeric stamp which is the Julian day (see Dates below), the 
type of analysis performed, and the results. 

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close) 
the Results Log by doing one of the following: 

1. Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select 

View: Results Log or press ALT+2. 

 
Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View 
Results. 

6.1.17 Float, Dock and Auto-Hide Windows 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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 There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows 
include Project Explorer, Results Log, Command Window and Messages Log. This allows you to 
customize your Origin workspace so as to maximize utility and save screen space. 

6.2 Numbers in Origin 

• Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrix book, 

Origin uses a combination of user-specified settings to determine how to display the data in each cell. 

What displays is a visual representation of the data value. The actual data values are stored with the full 

precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the 

actual data values that are used and not the displayed values. 

• Display of Numbers that Exceed Cell Width: If a workbook or matrix book contains data that exceed 

the cell (column) width, Origin displays values as series of pound signs (######). This avoids confusion 

caused by a truncated display of cell values. Pound signs ###### will revert to numbers when you enter 

cell editing mode. 

• Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that 

there was a need for a special number that was "not a number" which would - when used in a calculation - 

generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin 

recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix 

and it can be used in calculations or scripts (for instance, to return a missing value unless some condition 

is met). Origin displays missing values in a worksheet or matrix sheet as "--". However, you shouldn't 

confuse this display (output) with what you enter as a missing value (input). 

• Decimal, Scientific and Engineering Notation: You can display workbook or matrix book data in 

Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually 

choose from these data display options but you can also pre-define thresholds for automatic display of 

scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower). 

• Dates and Times in Origin: Origin's long-time mathematical system for dates and time is based on 

Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1, 

4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1) 

a true Julian Date value (0 is at noon instead of the following midnight) and (2) a "2018" system in which 

0 is defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance, 

importing data with the Import Wizard (e.g. Custom Date Format supports "MM'/'dd'/'yyyy 

HH':'mm':'ss'.'######"). Previously, precision was limited to 0.0001 seconds. For more information, see 

Dates and Times in Origin. 

Note: For more information on numbers, see  

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in 

Origin 

 

Origin workbooks and matrix books support the following Data Types: 

Workbook Matrix Book Bytes Range of Values 

http://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
http://www.originlab.com/doc/Origin-Help/Number-in-Origin
http://www.originlab.com/doc/Origin-Help/Number-in-Origin
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double double 8 ±1.7E±308 (15 digits) 

real float 4 ±3.4E±38 (7 digits) 

short short 2 -32,768 to 32,767 

long int 4 -2,147,483,648 to 2,147,483,647 

char char 1 -128 to 127 

byte char, unsigned 1 0 to 255 

ushort short, unsigned 2 0 to 65,535 

ulong int, unsigned 4 0 to 4,294,967,295 

complex complex 16 ±1.7E±308 (15 digits), each 8 bytes 

6.3 Topics for Further Reading 

• Project Explorer 

• The Object Manager 

• Finding Data in your Origin Project 

• Basic Child Window Operations 

• Numbers in Origin 

• Dates and Times in Origin 

• FAQ: How do I turn off the collapsible menus and show full menus? 

• Customizing Toolbars 

• Setting Your Preferences 

• The Numeric Format Tab of Preferences: Options 

http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/Origin-Help/Object-Manager
http://www.originlab.com/doc/Origin-Help/Finding-Project
http://www.originlab.com/doc/Origin-Help/Operate-ChildWindow-Basic
http://www.originlab.com/doc/Origin-Help/Number-in-Origin
http://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
http://www.originlab.com/doc/Quick-Help/collapsible-menu
http://www.originlab.com/doc/Origin-Help/Customize-Toolbars
http://www.originlab.com/doc/Origin-Help/Tool-Option-DIalog
http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
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7 Origin File Types 

7.1 Roundup of Origin File Types 

 

 

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Upgrade 
users may recognize that some of the old familiar file types now have a Unicode 
counterpart, denoted by an appended 'u' (e.g. *.opj => *.opju). Origin versions 2018 
and later will read and write the older, non-Unicode file types. As the default is to save 
to the newer Unicode-type files, be sure to set the Save as type drop-down if you 
need to save to an older file type. 

 

File Type File Extension Used As 

Origin Project 
Files 

*.opj(u) A container for all data. 

Child Window 
Files 

*.ogw(u);*.ogg(u);*.ogm(u);*.txt 
The child windows for workbooks (.ogw(u)), graph 
(.ogg(u)), matrix(.ogm(u)), notes (.txt). 

Template Files *.otp(u);*.otw(u);*.otm(u) 
A stored customizable suite of data-handling and 
format options: graphs(.otp(u)), worksheets 
(.otw(u)), matrix(.otm(u)). 

Theme Files *.oth;*.ois;*.odt;*.ofp; 

A saved suite of user-defined settings with multiple 
applications in Origin. A *.oth file applies to a 
graph/worksheet/matrix sheet/report table; A *.ois 
applies to analyses and dialogs; A *.odt applies to 
dialogs; A *.ofp applies to function plots. 

Import Filter 
Files 

*.oif 
An external file which handles basic import file 
parsing and data extraction. 

Fitting Function 
Files 

*.fdf A fitting function definition file. 

LabTalk Script 
Files 

*.ogs A text file organized in sections of LabTalk script. 

Origin C Files *.c;*.cpp;*.h;.etc A file used for developing Origin C programs. 

X-Function 
Files 

*.oxf;*.xfc; An Origin tool with a flexible mechanism for 
performing a wide variety of data manipulation 
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tasks. 

Origin Package 
Files 

*.opx 
A package file created for distributing custom 
applications. 

Origin Menu 
Files 

*.xml;*omc; 

A file that contains Origin menu information. An 
*.xml can be edited outside of Origin for menu 
customization purposes. An *.omc file contains the 
configuration of customized menus. 

Initialization 
Files 

*.ini 
A file that controls the configuration of some Origin 
features on startup. 

Configuration 
Files 

*.cnf A text file that contains LabTalk script commands. 

Custom Plot 
Symbols 

origin.uds 
A binary file that holds the bitmap images of custom 
symbols. 

7.2 Topics for Further Reading 

• Opening, Closing and Backing Up the Origin Project File 

• Protecting Origin Projects 

• Origin Template Files 

• The Theme Organizer 

• System Themes 

• Import Wizard, Save Filters Page 

• Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder 

• OGS Files and Getting Started with LabTalk 

• Running LabTalk Script from OGS Files 

• Using X-Functions in LabTalk 

• Packaging Multiple Files as an OPX File 

http://www.originlab.com/doc/Origin-Help/OPJ-Open-Close-Backup
http://www.originlab.com/doc/Origin-Help/OPJ-Protect
http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
http://www.originlab.com/doc/Origin-Help/ThemeRef-System
http://www.originlab.com/doc/Origin-Help/ImpWiz-SaveFilterPage
http://www.originlab.com/doc/Origin-Help/FitFunc-Organizer-Builder
http://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-Get-Started
http://www.originlab.com/doc/LabTalk/guide/From-Files
http://www.originlab.com/doc/LabTalk/Tutorials/Tutorial-XF
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
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8 Import Data 

 

OriginLab continues to focus on expanding your data import options. In addition to the many file types that 
you could import with previous versions -- ASCII, CSV, Excel, binary files, and many third-party formats, 
including Matlab, pClamp, NI TDM and NetCDF -- the newest version includes a generalized data import 
mechanism we call Data Connectors. Data Connectors support import of previously-unavailable data sources, 
including HTML Tables and JavaScript Object Notation (JSON) data from the web. 

Thus, for Origin 2020, your data import options include: 

• Copy-paste for quick import of simply-structured data (mostly useful for adding data to worksheets). 

• Drag-and-drop file import is supported by most file types. Additionally, drag-and-drop support has been 

added for common Data Connectors. Now, when you drop a file type for which there is Connector support, 

you will be prompted to choose between using a Connector and using the older methods of import. 

Whatever you decide, you will only be prompted at the first instance. Note that some complex ASCII, 

binary or User-defined file types may require use of an Origin Import Filter (OIF), created using the 

Import Wizard. 

• Local or network-stored data files can be imported using one of Origin's X-Function based import routines. 

The associated import dialogs allow you to tweak import options and save them as a Theme file for later 

use. Themes are added to the Data: Import From File menu allowing you to import files without opening 

a dialog box. 

• The interactive Import Wizard is useful for importing complexly-structured ASCII, Binary and User-

defined files. As a bonus, you can save every step and adjustment made to data handling, to a Origin 

Import Filter file (OIF) that can be used to re-import similar files in the future. Import filters can be made 

for drag-and-drop import. 
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• Data Connectors allow you to establish a live link to data stored locally, in network files or in web pages; 

and to work with that data without having to store that imported data in the Origin project. Data brought 

in using a Data Connector is also locked against editing, providing improved security to those who are 

concerned with data integrity. Further, if your data are stored in large Origin projects and you have a need 

to pull out just a subset of that data for further analysis or graphing operations, you can now use an SQL-

like query to pull just the most-needed data from the project. 

• If you work with SQL databases, you can use Origin's SQL Editor interface to create connection strings 

and SQL queries. 

8.1 A Note to Upgrade Users 

Longtime Origin users who are upgrading from older versions should note that import functions were recently 
moved from the File menu to a new Data menu. The menu reorganization should not affect any of your 
previously-saved Themes or import filters. Your familiar import routines are now found under Data: Import 
From File. 

A new way of importing data -- including import of web-based files and tables -- was added in Origin 2019b. 
The new import routines are known as Data Connectors. By default, Data Connectors do not store imported 
data with the project file when the imported data file exceeds 500kB (this threshold is adjustable using LabTalk 
system variable @FSE). By not saving big chunks of data redundantly, you obtain significant improvements in 
speed and reductions in project file size. 

Lastly, multi-threaded import has been added for CSV Connector and ASCII files (Single ASCII, Multiple 
ASCII, Import Wizard)for Origin 2020 and should provide further gains in speed. 

 

Origin 2020 adds multi-threaded importing to CSV Connector and ASCII Import 
(Single ASCII, Multiple ASCII, Import Wizard, CSV). This should significantly 
reduce import times for large text files. 

8.2 Data Connectors 

 

Data Connectors, introduced in Origin 2019b, are a general mechanism for importing data to your Origin 
projects from local or from web-based files and pages. At present, Data Connectors support a number of 
common data formats, including: 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list


Import Data 

55 

• XML 

• CSV 

• Excel 

• HTML Table 

• JavaScript Object Notation (JSON) 

• Origin File (project, workbook, matrix) 

• Matlab (v7 .mat files) 

 
To import data with a Data Connector: 

1. With your workbook active, click the Data menu. 

• If you are connecting to a local or network file, choose Connect to File and click on a file 

type. 

• If you are connecting to web data, click Connect to Web and enter a URL. 

 

For Origin 2020, Data Connectors support drag-and-drop file import. The first time 
that you drop a supported file type onto Origin, an attention message asks whether you 
wish to use a Data Connector to import the file. If you answer Yes, a Data Connector 
will be used for all future drag-and-drop import of that particular file type. If you later 
decide to return to Origin's older, import-filter-based drag-and-drop routine, choose 
Preferences: Import Filters Manager and check the Support Drag&Drop box 

beside the file extension. 

For more information, see these topics: 

• Importing Data by Drag-and-Drop 

• FAQ-412 How do I customize Drag-and-Drop and File: Open for various import file 

types? 

8.2.1 Overview of Data Connectors 

Regardless of Connector type, the following are true about Data Connectors: 

• By default, when import data file size exceeds 500kB, the imported data and graphs made from that data 

are NOT saved with the Origin file (see LabTalk system variable @FSE). All analysis output resulting from 

imported data ARE saved with the Origin file. Not saving raw data with your project file can significantly 

reduce file size and improve performance when working with projects. 

• IMPORTANT: Since connector-imported data may not be saved with the project file, users should always 

ask themselves whether they need to preserve imported data. This is particularly true if the data source is 

web-based and stored in a place beyond your control. If you prefer to save all data imported via a Data 

Connector, with your Origin file, click the Data Connector icon and clear the check mark beside Exclude 

Imported When Saving prior to saving your file†. Note that each Data Connector-containing book will 

have its own Exclude... check mark. Alternately, if you decide the Data Connectors are not needed, you 

http://www.originlab.com/doc/Origin-Help/Imp-DragDrop
http://www.originlab.com/doc/Quick-Help/Drag-and-Drop-Import
http://www.originlab.com/doc/Quick-Help/Drag-and-Drop-Import
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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can click the Data Connector icon and choose Remove Data Connector (from this book) or Remove 

Data Connectors from All Books (in the project). 

• Data can be re-imported at any time by clicking the green Data Connector icon in the upper left corner 

of the workbook and choosing Import (Ctrl+4) or Import All. 

• Data imported via the Data Connectors is locked from editing. You can reorganize it, graph it and analyze 

it. You just can't modify it. This is a big plus for those concerned with data integrity. 

• A workbook can have only one type of connector (e.g. HTML Table) but each sheet in the book can 

connect to a different data source (i.e. a different CSV file, or a different HTML page). 

• When you add a new sheet to a Data Connector-containing book, the sheet is added with an empty 

Connector. The unconnected state is denoted by a pale-yellow Connector icon. Click on the Connector icon 

to open a shortcut menu where you can connect the sheet to a data source. 

 

• Data Connectors for other formats will be added over time. Support for new file formats will be made 

available as Add-on Apps, so you may want to periodically check the Add New... menu item to see what 

has been added. Data Connector Apps that you download will be added to the menu automatically. 
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Note: The Data Connector icon appears in four states:  

• When the data source is viable, whether data have been imported or not, the icon looks like this: 

 

• When a data file that was previously imported via Connect to File is modified, the next time you 

open the Origin file, the icon will look like this†:  

• When a new sheet is added to a Data Connector-containing book, an empty Connector is added to 

the sheet. When the Connector is empty, the icon looks like this:  

• When the data source is no longer viable (e.g. the data source has been deleted or renamed), the 

icon looks like this:  

 

†Origin does not check to see whether web-based files have been modified. Therefore, 
if you DO opt to save imported web data with the file, you should click the Data 
Connector icon and choose Import or Import All. This will open a connection to the 
source data and update your Origin project. Any dependent analysis operations and 
graphs will be also be updated. 

8.2.2 Data Source File Path 

Data Connectors require a viable connection to the source data; if a file is renamed or deleted, the Connector 
will be broken. Use the Data Source File Path and Common Data Path to help you maintain the connection 
between your Origin files and your source data. 
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• Relative to Project Path: If your data are stored in folders under the project file, you could set Data 

Source File Path to Relative to Project path. You can then move the project and data sources together, 

and their relative paths are preserved. No path corrections are then needed when re-opening the project 

file from a different location on your network. 

• Relative to Common Data Path: If data sources are under some common path, you could set Data 

Source File Path to Relative to Common Data Path. If the files are subsequently moved, you can re-

establish the Common Data Path and then Import All Books. 

8.2.3 Query to Import Data from an External Origin File 

 

Starting with Origin 2020, you can selectively import columns of data from an external 
Origin file by specifying an SQL-like Query in the Data Connector Browser prior to import. 
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To selectively query Origin files using the Origin Connector: 

1. With the worksheet active, choose Data: Connect to File or Connect to Web. 

2. Browse to your Origin file and click Open. This opens the Data Connector Browser. 

3. Click the Select Query button . 

4. Enter your Query in the Select Query dialog, then click OK. 

Data will be selectively imported into the active workbook as specified by your query. 

 
Common Keywords: 

Keyword Description 

_SName short name, e.g. _SName, Sheet_SName 

_LName long name, e.g. _LName, Book_LName 

_Comments 
comments, e.g. _Comments, 
Sheet_Comments 

Column_D1 
column user-defined parameter, where 1 
is the parameter index 
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Column_[Name] 
column user-defined parameter, where 
[Name] is a parameter name containing 
spaces 

 
Examples: 

 

Select Column from Project where _SName == "A"; 

Select Column from Project where _Comments like "S*3"; 

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3); 

Select Column from Project where Sheet_SName like "Trial*"; 

Select Column from Project where (Book_SName like "Book*" or Book_LName like 

"*fit*") 

 
For more information, see Examples of using SQL query condition in Origin Connector. 

8.3 ASCII Import 

 

Origin 2020 adds multi-threaded importing to ASCII Import (Single ASCII, 

Multiple ASCII, Import Wizard). This should significantly reduce import times for 
large text files. 

The Data: Import From File: Single ASCII... and Data: Import From File: Multiple ASCII... methods are 
generally satisfactory for importing text files having a simple structure. These methods are also accessible 

from the and buttons located in the Standard toolbar. These methods will typically handle files with 
commonly-used delimiters and a simple header structure, without adjustments. 

If a file imports with only minor complications, select the Show Options Dialog checkbox when selecting your 
files in the ASCII dialog (Data: Import From File: Single ASCII... and Data: Import From File: Multiple 
ASCII...). This will open the impASC dialog box prior to file import, allowing you to tweak the way that the 
files are handled. 

http://www.originlab.com/doc/Origin-Help/Origin-Connect-Refer
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Once you've adjusted import settings, you can save them in one of two ways: (1) with the worksheet template 
or (2) as a Theme file from within the impASC dialog box. Saving import settings with the worksheet template 
offers portability (e.g. templates are easily shared with colleagues). Saving import settings as a Theme offers 
the advantage of being able to recall any number of import options combinations when importing via the 
impASC dialog box. 

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide. 
Additionally, see topics listed under "Topics for Further Reading", below. 

Note: For a more in-depth discussion of simple ASCII import, see the help topic:  

Help: Origin: Origin Help > Importing and Exporting Data > Importing Simple ASCII Data 

Files 

 
For import of complex ASCII files -- those not satisfactorily handled by the methods previously mentioned -- 
you can use the interactive Origin Import Wizard (Data: Import From File: Import Wizard...). The Wizard 

is also accessible from the button located in the Standard toolbar. Apart from its advantages for import of 
complex files, the Wizard also offers the following: 

• Using wildcards, you can create import filters that are targeted to a group of similarly-named data files. 

This filter can then be used for drag-and-drop import operations: When you drop the appropriate files onto 

the workspace, Origin looks at the file name, matches it with the correct custom import filter and imports 

the file according to your specifications. 

• Import data from the web pages using the Clipboard. 

• Extract variables from the import file name and header. 

• Specify custom delimiters and date formats to parse your data. 

• The ability to post-process your imported data using a custom LabTalk script. 

Note: For more information, view the help topic:  

http://www.originlab.com/doc/User-Guide/Customizing-Origin
http://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
http://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
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Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard 

 

Tutorial: Importing Multiple Files into Worksheets 

1. Click on the New Workbook button on the Standard toolbar to open a new 

workbook. 

2. With the new workbook active, click on the Import Multiple ASCII button on 

the same toolbar. This opens the ASCII dialog. 

3. In the ASCII dialog, browse to the \Samples\Curve Fitting subfolder of your 

Origin Program Folder and select the files Sensor01.dat, Sensor02.dat, and 

Sensor03.dat. Click the Add File(s) button and then check the Show Options 

Dialog check box and press OK. 

4. In the impASC dialog box, under the Import Options node change Multi-File 

(except 1st) Import Mode to Start New Sheets. Expand the Rename Sheets 

and Books node and clear Rename Book with (Partial) Filename. 

5. Press the arrow button at the top right of the dialog box, then select Save 

As... from the shortcut menu. In the dialog box that opens, enter a name such as 

Import to sheets and press OK. This will save your settings as a Theme that you 

can later use with other files. 

6. Press OK to close the impASC dialog. 

 
The three files will be imported, each into a worksheet, and the sheets will be renamed 
with the file name. 

 

http://www.originlab.com/doc/Origin-Help/ImpWiz
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You can quickly load your custom import theme from the list at the bottom of the Data 
menu. You can also use the Data: Import from File: Add/Remove File Types ... 
menu to open the Import Menu Customization dialog box where you can select and 
add User Themes to the Data: Import From File menu. 

8.4 CSV Import 

 

 

In addition to multi-threading, three significant improvements were made to CSV 
Connectors for Origin 2020: 

• There is now a checkbox to Import first 50 lines as preview. 

• Support is added for Partial Import. When doing a partial file import, both Data: 

Import from File and Data: Connect to File share a flexible syntax for defining 

just those rows and columns that you wish to import. There is in-dialog assistance 

(expand the Partial Import branch) or you can visit this page in the Origin Help 

file. 

• You can now define a Data Block Marker ( e.g. [Data], >>>>Start<<<<<<, 

etc.) to mark the start and end of the data portion of your file that you wish to 

import. 

To import locally-stored Comma Delimited (CSV) data: 

1. Choose Data: Import From File: Comma Delimited (CSV).... 

or 

1. Choose Data: Connect to File: CSV. 

 
To import web-stored CSV data: 

1. Choose Data: Connect to Web: CSV. 

 
You can specify a partial import of web-stored files just as you can for locally-stored files. Check the Partial 
Import box for guidance on the syntax used to define Column and Row import. 

8.5 Excel 

 There are five basic options for working with Excel data in Origin: 

• You can copy Excel data to the Clipboard and paste or paste link that data into Origin. 

• You can import a local Excel file by clicking Data: Import From File (or click the button located in 

the Standard toolbar). 

http://www.originlab.com/doc/Origin-Help/PartialImport-ReImport
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• You can use a Data Connector to import a local Excel file by clicking Data: Connect to File: Excel or by 

dropping your Excel file onto the Origin workspace. The Excel Connector allows you to specify the location 

of Long Names, Units and Comments before importing. 

• You can use a Data Connector to import Excel data from the web by clicking Data: Connect to Web: 

Excel. 

• You can open your Excel workbook in Origin as an Excel workbook. To do this, use the File: Open Excel... 

menu command. 

When you paste or import your Excel workbook data into an Origin workbook (including import by Data 
Connector), you have full access to Origin's powerful graphing and analysis features. When you open your 
Excel workbook as an Excel workbook, you are actually running an OLE instance of Excel inside of the Origin 
workspace. In this case, you have access to Excel's menus and features, but very limited access to Origin's 
graphing and analysis features. 

For most users, choosing one of the Excel import options (first four options) will be preferable to opening the 
Excel workbook in Origin as an Excel workbook. 

 
Things to know: 

• To open an Excel file in Origin as an Excel workbook, you need to have Office 97 or later installed on your 

computer. 

• To import an Excel file in Origin, the file needs to be of file type .xls, .xlsx or .xlsm. 

• You can import Excel files without having MS Excel installed (open as Excel still requires Office 97 or 

later). 

• You can link your Origin project file to an external Excel file. That way updates to the Excel file will trigger 

updates to dependent graphs etc. when you open the Origin project file. 

• Origin does not support dynamically linking a formula in an Excel workbook to source data in another 

Excel workbook. 

• Certain file import information is saved to the workbook on import. Having once imported an Excel file to 

an Origin workbook, you can use the Re-import feature to re-import an updated Excel file -- including 

those that contains multiple sheets -- to your Origin workbook. 

Note: To learn more about working with Excel data, see the Origin Help:  

Help: Origin: Origin Help > Working with Microsoft Excel 

 

You can do partial import of your Excel data by delineating one or more row and 
column ranges. A flexible syntax is provided for including or excluding data ranges. For 
information, choose Data: Import From File: Excel (XLS, XLSX, XLSM), check 
Show Options Dialog and choose a file for import. In the impMSExcel dialog, expand 
the Partial Import branch and note the in-dialog syntax hints under Custom. 

8.6 Binary Import 

 Files with an optional header section followed by a sequential binary structure, can be imported using the 
Origin Import Wizard (Data: Import From File: Import Wizard...). 

http://www.originlab.com/doc/Origin-Help/Work-With-Excel
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If the binary file format is commonly used in your field of work, please contact your Origin representative so 
we can consider adding support for such files in future versions. 

8.7 Copy/Paste the Clipboard Data 

 One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This 
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook. 
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your 

data into Origin. Here are some things you should know: 

• Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the 

number of displayed decimal digits in Excel. 

• When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin 

(not into the column label rows), then select a row and use the (right-click) shortcut key commands Set 

as Long Name, Set as Units, Set as Comment, etc. to tag your header information. 

• Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a 

method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import 

Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added 

benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted 

data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data. 

 

8.8 Third Party Formats 

http://www.originlab.com/doc/Origin-Help/ImpWiz-ClipboardData
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Origin imports many widely-used third party data formats, including pClamp, NI TDM, and NetCDF. As with 
ASCII import, you can customize third-party file import options and save your settings with the worksheet 
template or as a dialog Theme for later use. 

As with other supported file types, you can import third party files by drag-and-drop.      

File Type Method 

To Learn More, see  

Help: Origin: Origin Help > Importing 
and Exporting Data 

 
Thermo (SPC, CGM) 
pCLAMP (ABF, DAT, AB?) 
Princeton Instruments (SPE) 
Sound (WAV) 
NetCDF (NC) 
CDF (CDF) 
HDF5 (H5, HE, HDF5) 
NI DIAdem (DAT)  
NI TDM (TDM, TDMS) 
Famos (DAT, RAW) 
ETAS INCA MDF (DAT, MDF) 
IgorPro (PXP, IBW) 
Prism (PZFX, XML) 
MATLAB (Mat) 
Minitab (MTW, MPJ) 
KaleidaGraph (QDA) 
SigmaPlot (JNB) 
MZXML(mzData, mzXML, 
mzML, imzML) 
EarthProbe (EPA) 
EDF (EDF, BDF, REC, HYP) 
Somat SIE (SIE) 
JCAMP-DX (DX, DX1, JDX, 
JCM) 
HEKA (DAT) 
SPSS (SAV) 
BRUKER OPUS 
SAS (sas7bdat) 
Tektronix (ISF) 
Data Translation (DCF, HPF) 
Binary 2D Array (IMG, B2D) 
Image  

Data: Import 
from File: 

> Importing Third Party Files 

Note: Some of these 3rd party file formats are hidden by default. To add, choose Data: Import From 

File: Add/Remove File Types.... This opens the Import Menu Customization dialog box where you can 

choose which file types to show in the Import From File menu. To insert a separator after a menu 

command, right-click on the command in the right-hand panel and choose Add Separator. To remove a 

separator, double-click on it in the right-hand panel. 

 

 

Drag-and-drop support is managed by file extension, using the Filter Manager dialog. 
From the main menu, click Preferences: Import Filters Manager.... 
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8.9 Database 

 You can import data from a database using the Data: From Database menu command or using the 
Database Access toolbar . This opens the SQL Editor where you can set up your database connection and 
your SQL query. 

 

Origin 2020 adds these improvements to database import: 

• Faster data import. 

• System variable @IPDB to control protection of imported range (0 = no 

protection, 1 = protected but allow reorder, 2 = protected). 

• Allow Connector-like option to Exclude Imported (data) When Saving as 

OPJU/OGWU. 

 

Note: For more information, see the Origin Help  

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database 

8.10 Digitizer 

 At times, you may only have a graphic representation of some data that you would like to explore further. In 
such cases, Origin's Digitizer tool may prove handy. Use the Digitizer to import an image file, then digitize the 
plots, converting your image to numeric data that you can study and re-plot using Origin's analysis and 
graphing tools. 

http://www.originlab.com/doc/Origin-Help/Import-From-Database
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• Import most common image formats. 

• Rotate the imported image, remove noise and calibrate scales by picking start and end values. 

• Pick points on curves manually or automatically. 

• Manually add curve inflection points, as needed. 

• Interactively remove points that you do not want digitized. 

• Support for Cartesian, polar and ternary coordinate systems. 

 
To open the Digitizer: 

1. Click the Digitize Image button on the Standard toolbar or choose Tools: Digitizer... from the 

main menu. 

8.11 Saving Origin Files without Imported Data 

Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As 
Analysis Template and Save Project without Data, were three options for saving Origin files without data 
while preserving settings and operations with the file. 

Users now have the option to save Origin files without imported data. This is a particularly attractive option for 
those who work with large data files, where saving of that data with the file would hinder performance or 
waste disk space. 
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• By default, data imported using a Data Connector, will not be saved with the book. Each book has its 

own Exclude Imported When Saving check mark and clearing the check mark on any page in the book 

will cause all imported data to be saved with the book. 

 

• Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported 

data by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported 

data when saving project box at the bottom of the dialog. 

 

 
The act of excluding data when saving differs from saving a template file in a couple of important 
ways: 

• When you exclude imported data, you are still saving all output resulting from analysis operations on 

imported data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don't save 

imported data or graphs of that imported data. 

• Books which you have saved without imported data retain a "live" link to the original data source. For 

Data Connector-containing books, click the Data Connector icon and click Import (active sheet) or 
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Import All (all sheets in book). For books used for standard file import, activate the empty book and click 

Data: Re-import Directly; or click the Re-Import no dialog button on the Import toolbar (see next). 

8.12 Re-Importing Data Files 

 There are two import commands in the Data menu that are specifically intended for repeat import of the 
same file (i.e. the file path and name must be the same): 

• Re-Import Directly. When you import a file into an Origin worksheet or matrix sheet, by default a 

number of parameters, including file path and name, are saved in the sheet. If you have an external data 

file that is periodically updated or you want to reload a standard file into the worksheet, you can re-import 

directly without opening an import dialog. 

• Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file 

type so that you can adjust your import options before re-importing. 

Notes: 

• Only one file can be re-imported at a time. When you use either of these two menu commands, 

only the file associated with the active worksheet or matrix sheet, will be imported. If the selected 

data are imported from multiple files, re-importing will fail. 

• If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the Import 

Single ASCII dialog will open instead of the Import Wizard. 

• Re-import does not work for Binary or User Defined data types brought in using the Import 

Wizard. 

8.13 Topics for Further Reading 

• Importing Simple ASCII Data Files 

• Customizing the ASCII Import Options 

• Import and Reimport Excel Data 

• Importing Third Party Files 

• Data Connectors 

• Importing Data by Drag-and-Drop 

• Tutorial: Updating Graphs by Re-importing Data from a Database 

• Importing Data from a Database 

• Drawing or Deleting Data Points 

• Tutorial: The Digitizer 

http://www.originlab.com/doc/Origin-Help/Import-Single-ASCII
http://www.originlab.com/doc/Origin-Help/ImpASC-Options
http://www.originlab.com/doc/Origin-Help/Work-With-Excel
http://www.originlab.com/doc/Origin-Help/Import-ThirdPartyFormats
http://www.originlab.com/doc/Origin-Help/Data-Connector
http://www.originlab.com/doc/Origin-Help/Imp-DragDrop
http://www.originlab.com/doc/Tutorials/Update-Graph-By-Reimport-Data-From-Database
http://www.originlab.com/doc/Origin-Help/Import-From-Database
http://www.originlab.com/doc/Origin-Help/Draw-Delete-DataPoint
http://www.originlab.com/doc/Tutorials/enhanced-digitizer
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9 Workbooks Worksheets Columns 

 

9.1 Workbook, Worksheet and Column Basics 

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing, 
organizing, analyzing, transforming, plotting and presenting your data. Each workbook is a collection of one or 
more worksheets. Each worksheet contains a collection of columns and each column contains rows of cells. 
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9.1.1 Naming Workbooks, Worksheets and Columns 

      

Workbooks 

• A Workbook has a Short Name and an optional Long Name and Comments. 

Origin uses the Short Name for internal operations. 

• Short Name must be unique within the project file, can contain only alpha-

numeric characters (letters and numbers), must begin with a letter and are 

limited to 13 characters. 

• A Workbook Long Name is optional, need not be unique within the project 

file, can use any characters in any order and has a limit of 5,506 characters 

(including spaces). 

• To name a workbook, right-click on the window title bar and choose 

Properties. Here you can edit Long name, Short name and Comments. Use 

the Window Title drop-down to control which name(s) show on the window 

title bar. 
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Worksheets 

• A Worksheet has a Short Name and optional Long Name and Comments. 

• The Short Name must be unique in a workbook. 

• A Worksheet Short Name has a 64 character limit, including spaces. It can 

contain special characters but must begin with an alpha-numeric character. 

These special characters are not allowed: {}|"<>()![]. 

• A Worksheet Long Name is optional, need not be unique within the project 

file, can use any characters in any order and has a limit of 5,506 characters 

(including spaces). 

• To name a worksheet, double-click on the sheet tab, or right-click on the tab 

and choose Name and Comments. More details are listed under 

Worksheets, below. 

Columns 

• A Column has a Short Name and an optional Long Name. 

• The Short Name must be unique within the worksheet. When spreadsheet 

cell notation is enabled (default setting), you cannot edit the column Short 

Name (see Column Short Name Restriction). When cell notation is disabled, 

you can edit the column Short Name. When editing Short Names note that 

they must use only alphanumeric characters (no special characters), must 

begin with a letter or number, and cannot exceed 18 characters. 

• A Column Long Name is optional, need not be unique within the project file, 

can use any characters in any order and has a limit of 30,000 characters. The 

Long Name can be edited directly by clicking in the Long Name cell or by 

right-clicking on the column header and choosing Properties from the 

shortcut menu. 

• Dialog box and Status Bar references to data range will use Long Names, 

provided that (1) Long Name exists and (2) you have selected Use Long 

Names when available (Preferences: Options: Miscellaneous). 

Otherwise, Short Names are used. 

9.1.2 Workbooks 

By default, when you start an Origin session or open a new project, You are presented with the New 
Workbook dialog box. 

http://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
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If you click the Close button, the dialog box closes and, simultaneously, a new workbook window based on the 
Default Template is added to the workspace. This workbook will be the same one that is added to the 

workspace when you click the New Workbook button on the Standard toolbar. Each time you click this 
button, a copy of this template is added to the workspace. There is much more to say about templates. To 
read further, begin by looking over the section below on Workbook Templates. 

By default, an added workbook window is assigned a Short Name of BookN, with N reflecting the order of 
window creation. You can rename the workbook with something more meaningful: 

1. Right-click on the workbook window title bar and choose Properties.... 

2. Give your workbook a Long Name (optional) and/or a Short Name and choose to display either or Both 

in the window title bar. See the above table for rules on workbook naming. 

 

The Properties dialog has a Comments box for entering text. These Comments 
display as a workbook window tooltip in Project Explorer and become searchable 
when using the Edit: Find in Project tool. 

 

In Origin 2020, the Object Manager adds support for displaying and manipulating 
workbook content: 

• List all sheets in the active workbook. 

• Click a sheet in Object Manager to activate the corresponding sheet in the workbook. 

• Right-click in Object Manager for access to common worksheet operations, including 

Delete, Insert, Add, Move, Copy, and Rename. 

 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Origin-Interface
http://www.originlab.com/doc/User-Guide/Origin-Interface
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9.1.2.1 Spreadsheet Cell Notation (SCN) 

Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of 
cell-level calculations that are familiar to users of spreadsheets (more details below). 

 

Starting with Origin 2019b, SCN remains ON by default for all new workbooks but the 
SCN icon has been removed. 

• By default, SCN is ON for all new workbooks. 

• In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon in the upper-left 

corner of the worksheet, signaling that SCN was turned on. 

• Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by 

default) to make room on the workbook window for the Data Connector icon. 

• Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short 

Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose 

Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page. 

• When SCN is turned off, you see this icon in the upper-left corner of the workbook. 

• If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the 

SCN OFF button will display in the upper-left corner. This includes projects or workbooks that were 

created prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and 

check the Spreadsheet Cell Notation check box. 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Import-Data
http://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
http://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
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9.1.3 Worksheets 

Prior to Origin 2018, an Origin workbook could contain a maximum of 255 worksheets. That number is now 
increased to 1024. When you have more than 255 sheets in a book, you will need to save your file to one of 
the Unicode-compliant formats (opju, oggu, otwu). 

To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following: 

• Insert. Inserts a single worksheet ahead of the active sheet. 

• Add. Appends a single worksheet. 

• Duplicate Without Data. Duplicates the active worksheet without duplicating the data. 

• Duplicate. Duplicates the active sheet, including the data. 

 

Each sheet in a workbook can have its own set of customizations. When you Insert or 
Add a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the 
version of ORIGIN.otwu that is saved to your User Files Folder (found in UFF if you 
have customized this file). To add a sheet that is based on another sheet in the 
workbook (including number of columns and special formatting), you would use the 
Duplicate or Duplicate Without Data shortcut command. 

When a sheet is created it has only a Short Name. If you add a Long Name to the sheet, the Long Name will 
show on the sheet tab, by default (Note that the rules for sheet Short Name are not very restrictive - see 
Naming Workbooks, Worksheets and Columns, above). 

To add a Long Name to the sheet tab: 

1. Double-click on the sheet tab and enter a Long Name. Alternately, you right-click on the sheet tab, choose 

Name and Comments and enter a Long Name in the dialog box. 

 

Starting with Origin 2020, there is a system variable @SSL that is used to control sheet name to display. To 
learn more, look for @SSL in the LabTalk System Variable List. 

 

When mousing over the worksheet tab, the worksheet Short Name, Long Name and 
Comments appear as a tooltip. 

 

There are a couple of new worksheet data selection behaviors for Origin 2020: 

• Keyboard: CTRL + SHIFT + END extends selection to the last filled cell in the 

sheet; CTRL + SHIFT + HOME extends selection to the cell in row 1, column 1; 

SHIFT + arrow key extends the selection to additional columns or rows 

• Graph: Selecting a plot in the graph now selects corresponding data in the 

worksheet. This feature can be toggled on/off with View: Show Plot Selection on 

Worksheet. Default behavior is controlled by LabTalk system variable @PS. 

9.1.3.1 Worksheet Properties 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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To open the Worksheet Properties dialog 

1. Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and 

choose Properties. 

 
You can use the Worksheet Properties dialog box to customize properties of the sheet, including... 

• Display of row labels, header labels and grid lines (View tab). 

• The number or rows and columns and other sheet dimensions such as column or row header height (Size 

tab). 

• Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab). 

• Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab). 

• Printing/exporting of grid lines, headers and footers, background color (Print/Export tab). 

• Script to run after import or upon data change (Script tab). 

• Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User 

Tree tab). 

 
Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell. 

For more information, see The Worksheet Properties dialog box. 

9.1.4 Worksheet Columns 

• To add a new column to the right end of an existing worksheet, right-click in the gray area to the right 

of the worksheet columns and choose Add New Column or Click the Add New Column button on 

the Standard toolbar. 

• To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New 

Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog 

box and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the 

Worksheet Properties dialog, then set the desired value for Column Number in the Size tab. 

• To insert a column into the worksheet, highlight a column, then right-click and choose Insert. A column 

is inserted ahead of the selected column and column Short Names are adjusted accordingly. 

 
Worksheet columns can be renamed by: 

• Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name 

and/or Long Name. 

• Type a Long Name directly into the worksheet header cell by double-clicking in the cell. 

• Import a data file and specify that the workbooks, worksheets, and columns be named upon import. 

http://www.originlab.com/doc/Origin-Help/WksProperties-Dialog
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• Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column 

names and labels. 

• Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-

right corner of the selection to auto fill and enumerate the names for other columns. This also works for 

other column label rows such as Comments. 

 
See the above table for rules on worksheet column naming. 

9.1.4.1 The Column Properties Dialog Box 

 The Column Properties dialog box is used to customize properties of the column including... 

• Long Name, Short Name, Units, Comments, etc. 

• Format (Numeric, Text, Time, Date, etc.). 

• Plot Designation. 

 
To open the '''Column Properties''' dialog box: 

1. Double-click on the column header. 

2. Right-click the selected column(s) and choose Properties.... 

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units 
and Comments -- can be edited here or entered directly into the column label row cells. 

9.1.4.2 Formatting Worksheet Data 

Data in the Origin worksheet is treated as either text or numeric data. While the display of text data in the 
worksheet is fairly straightforward, the display of numeric data is more complicated. 

Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double 
precision (Double(8)) numbers. This includes date and time, data which is formatted to display in degrees-
minutes-seconds or numbers that are formatted to display a fixed number of decimal digits. 

When dealing with numeric data, understand that what you see in the worksheet is a representation of a 
number that is stored internally. This is important for two reasons: 

• Calculations involving worksheet values are always done on the double-precision number that is stored 

internally, not the value that is displayed in the worksheet. 

• You can apply various Format and Display options to change the way that this stored number displays in 

the worksheet. 

 

Origin supports custom formatting of worksheet data, to include date-time, 
percentages, degrees-minutes-seconds and hexadecimal numbers. For more 
information, see the table under Other Custom Display Formats, below. 

  

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog
http://www.originlab.com/doc/Origin-Help/Format-Wks-Data
http://www.originlab.com/doc/Origin-Help/WksCol-SetDesignation
http://www.originlab.com/doc/Origin-Help/Number-in-Origin
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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9.1.4.2.1 Numeric Display Formats 

1. Double-click on a column heading to open the Column Properties dialog. 

2. Click the Properties tab, then set Format = Numeric. 

3. Set Display to Decimal: 1000, Scientific: 1E3, Engineering: 1K, Decimal: 1,000 or Custom (see 

below). 

  

9.1.4.2.2 Date and Time Formats 

By default, Origin uses a modified Julian Day value for date-time calculations. Frequently, however, you wish 
to display your data in a standard date-time format in the worksheet: 

1. Double-click on a column heading to open the Column Properties dialog. 

2. Click the Properties tab, then set Format = Time, Date, Month or Day of Week. 

3. Set the Display list to one of the listed options. 

4. If none of the listed options are appropriate you can choose Custom Display and construct your own 

custom date-time string using these date-time format specifiers. 

 

When you import date-time data into the worksheet, by default, Origin will treat this data as 
text. If your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text. 
You will need to open the Column Properties dialog box and chose the proper Format and 
Display options. When you see that your date-time data are right-aligned in the cell, you 
know that Origin "sees" the data as numeric, displaying in a date-time format. 

 

  

9.1.4.2.3 Other Custom Display Formats 

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows 
various formats applied to the same set of numeric values (column A(X)). 

http://www.originlab.com/doc/Origin-Help/DateTime-in-Origin
http://www.originlab.com/doc/LabTalk/ref/Date-and-Time-Format-Specifiers
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The following is a sample listing of some supported custom format options (this just happens to be the pre-
populated list that ships with Origin 2019). Note that you can enter custom formats directly into the Custom 
Display list and they will be saved to this list. 

There are many other format options. For more information, see Custom Numeric Formats. 

Format Description 
Example 

if cell value = 123.456 

*n Display n significant digits. *3 displays 123 

.n Display n decimal places. .4 displays 123.4560 

S.n 
Display n decimal places, in scientific notation of the 
form 1E3. 

S.4 displays 
1.23456E+02 

E.n Display n decimal places, in engineering format. E.2 displays 123.46 

* "pi" 
Display a number as a decimal, followed by the 
symbol π. 

* "pi" displays 
39.29727π 

#/4 "pi" 
Display a number as a fraction of π, with a 
denominator of "4". 

#/4 "pi" displays 157π/4 

#/# "pi" Display a number as a fraction of π. #/# "pi" displays 275π/7 

##+## 
Display a number as two digits, a "+" separator, then 
two digits (e.g. surveying stations). 

##+## displays 01+23 

http://wikis/docwiki/index.php?title=UserGuide：Custom_Numeric_Format
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#+##M 
Display a number as one digit, a "+" separator, then 
two digits, plus a suffix of "M". 

#+##M displays 1+23M 

#n 
Display a number as an integer of n digits, pad with 
leading zeros as needed. 

#5 displays 00123 

#% Display a number as a percentage. #% displays 12346% 

# ##/## Display a number as proper fraction. 
# ##/## displays 123 
26/57 

# #/n Display a number as proper fraction, in nths. # #/8 displays 123 4/8 

DMS 
Display a number in Degree° Minute' Second", where 
1 degree = 60 minutes, and 1 minute = 60 seconds. 

DMS displays 
123°27'22" 

D MDn EW 
(longitude) 
D MDn NS 
(latitude) 

Display a number in Degrees and Decimal Minutes. 
Parameter n specifies decimal places. Positive values 
will have "E" or "N" appended, Negative values will 
have "W" or "S" appended. If you wish to preserve 
negative values do not append "EW" or "NS". 

D MD3 EW displays 
123° 27.360 E 

D MDn EWB 
(longitude) 

D MDn NSB 
(latitude) 

Display a number in Degrees and Decimal Minutes. 
Parameter n specifies decimal places. Letter "B" 
("before") specifies that positive values should have 
"E" or "N" prefixed, negative values will have "W" or 
"S" prefixed. If you wish to preserve negative values 
do not append "EWB" or "NSB". 

D MD3 EWB displays E 
123° 27.360 

 %#x 
Display a number as a 32-bit hexadecimal (max 8 
hexdigits). The "#" symbol specifies "Ox" prefix. 

%#x displays 0x7b 

 %#0nx 
Display a number as a 32-bit hexadecimal (max 8 
hexdigits) notation, as an n-character string, pad with 
leading 0 as needed. 

%#06x returns 0x007b 

 %#0nI64X 
Display a number as a 64-bit hexadecimal notation 
(max 13 hexdigits, 15 total including #="0x"), as an n-
character string, pad with leading 0 as needed. 

%#014I64X returns 
0X00000000007B 

9.1.5 Column Label Rows 

 Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be 
brought in as header information in imported files, or it may be manually entered. Display of column label rows 
is optional and the user can selectively show them or hide them, as needed. 
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Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph 
legend text or Axis titles). The F(x)= row is used in performing math operations on columns of data (see 
below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in 
plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below). 

 

 

Beginning with Origin 2020, you can copy a selected subrange of worksheet cells and 
include associated column label row information with the copy-paste operation. To copy 
label rows with data cells, right click on your subrange selection and choose Copy 
(including label rows). 

9.1.5.1 Managing Display of Column Label Rows 

Display (showing or hiding) of column label rows is controlled by shortcut menu commands: 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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1. Right-click here and choose View from the shortcut menu. 

2. Right-click here and choose Edit Column Label Rows or other label row command. 

3. Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in 

this area, then right-click to Set Comments Style. 

9.1.5.2 Column List View 

Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed 
view of the column label row metadata. This view is potentially useful if your worksheets have many rows of 
metadata and you want to focus on some particular aspect of that metadata. With the worksheet active, 
choose View: Column List View or press CTRL + W. 

 

Further, you can apply a data filter to metadata in Column List View. When you return to the standard 
worksheet view (clear the mark beside View: Column List View), only data associated with the filtered 

metadata will show in the worksheet. 

http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
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For Origin 2020, Column List View displays column index number ahead of column short 
name (+ column designation). In addition, you can hover on the left edge of column long 
name and a tooltip reports dataset size. To disable the display of column index, set 
@DSI=1. 

 

9.1.5.3 Sparklines 

Numeric data stored in a column will graphically display in the column header in a special label row called 
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent 
variable (Y) against the row number or the associated X column as independent variable (X). When importing 
data, Origin displays sparklines by default when the number of columns is less than 50. 

 

 
To Show or Hide Sparklines: 

• Show Sparklines by clicking Column: Add or Update Sparklines. This opens the sparklines dialog. 

• Show Sparklines for selected columns by clicking the Add Sparklines button on the Column toolbar. 

• Right-click on the worksheet's Sparklines column label row and choose Add or Update Sparklines. 

• Delete sparklines by right-clicking the Sparklines column label row and pressing the Delete key. 

http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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• In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or 

more columns by clicking on the column header, then choose Column: Add or Update Sparklines. In 

the dialog box that opens, set the Plot Type to Histogram or Box. 

 

• Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window. 

Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot. 

When you close the pop-up window, your customizations are applied to sparkline. 

9.1.6 The Workbook Organizer 

 As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows. 
Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file 
path and name, date and time of data import, file header information not written to the column label rows, 
variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer panel. 

To show a workbook's Organizer panel right-click on the workbook title bar and select Show Organizer (note 
that this action toggles the panel on or off). The Organizer provides a tree-view listing of metadata stored with 
a particular workbook. 
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9.1.7 Some Workbook, Worksheet and Column Limits 

Maximum Number of... 32Bit OS 64Bit OS 

Worksheets in a workbook 
Rows in a worksheet, 1 column 
Rows in a worksheet, 5 columns 
Rows in a worksheet, 32 columns 
Columns in a worksheet, 1 row 
Columns in a worksheet, 100 rows 
Columns in a worksheet, 1000 rows 

1024† 
90,000,000 
14,000,000 
3,700,000 
65,500 
65,500 
65,500 

1024† 
90,000,000 
90,000,000 
90,000,000 
65,500 
65,500 
65,500 

† > 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not 
compatible with Origin versions prior to Origin 2018. 

9.2 Workbook Templates 

   When you start an Origin session or open a new project, You are presented with the New Workbook dialog 
box. The dialog has three tabs -- System Templates, User Templates and Construct Columns: 

• The System Templates tab lists built-in templates supplied by OriginLab. 

• The User Templates tab lists your custom templates, with filters for Analysis Templates (*.OGWU + 

saved operations), workbook Templates (*.OTWU) and Workbook Files (*.OGWU). 

• The Construct Columns tab has controls for constructing a workbook from pre-designated columns, by 

specifying a sequence of letters and numbers (in-dialog examples are given). 

http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
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• The default template is a simple, one sheet, two-column workbook created from the default ORIGIN.otwu 

workbook template, and located on the System Templates tab. 

• Whether you keep this as your default template, or designate another default template on either the 

System or User Templates tabs, the default will be the template that opens when you click the New 

Workbook button on the Standard toolbar. 

• When the New Workbook dialog is open, you can double-click on any template in the System or User 

Templates tabs, to open a window that is built from that template. 

• To designate a template on either the System or User Templates tabs as the default template, (1) click 

once on the template to select it, (2) check the Set as Default Template box and (3) click OK to close 

the dialog box. 
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For more information on use of the New Workbook dialog box, see the New Workbook dialog box. 

 

You can modify any file in the New Workbook dialog -- System Templates or User 
Templates -- and save your changes. When you modify System Templates and save, 
the modified file is written to your User Files Folder (you cannot overwrite the original 
system file) and the modified file then displays on the User Templates tab. 

  

9.2.1 Saving a Modified Template 

There are several types of files listed on the System Templates tab of the New Workbook dialog box: 

Icon Description of File 

 

Template  

• These are of the basic Origin workbook template file 

type. They contain no data and no analysis operations. 

• To save a modified Template, choose File: Save 

Template As. Specify a name, file path and optionally, a 

description† and/or a preview image‡. 

 

Workbook  

http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
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• This type of file differs from a Template in that it can be 

saved with data and operations. 

• To save a modified Workbook, choose File: Save 

Window As. Specify a file path, name and optionally, a 

comment† and and/or a preview image‡. 

 

Analysis Template  

• This type of file saves no data but it MUST store analysis 

operations. If you open an Analysis Template, you will 

see little green lock icons on output data columns or 

report sheets. 

• To save a modified Analysis Template choose File: Save 

Workbook as Analysis Template. Specify a file path, 

name and optionally, a comment† and/or preview image‡. 

†A comment or description produces a tooltip when you hover on a file in the New Workbook dialog box. 
‡A preview image allows you to see an image of your saved file in the New Workbook dialog box. 

 

When creating preview images of your customized templates, it works best to save 
your image (BMP, JPG, PNG) with dimensions of about 160 pixels wide by 130 pixels 
high. Use your image capture program to resize your image before saving and adding 
to your file as a preview image. 

 
For more information see "What is Saved with the Workbook Template?" 

 

Data are not saved with template files. There are other options for saving files without 
data. One is to "clone" the project; the other -- the default for any workbook that 
contains Data Connectors -- is to save the Origin file without imported data. For 
workbooks that do not contain Data Connectors, you can exclude imported data when 
saving, by opening the (workbook) Window Properties dialog (Format: Workbook) 
and checking the Exclude imported data when saving project box. Imported data 
and graphs of that data will be discarded when saving; but data that you have entered 
via the keyboard, plus any output resulting from analysis of imported data, are saved. 

9.3 Simple Utilities for Filling Columns with Data 

 Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a 
menu command to fill a worksheet column with either row index numbers, uniform random numbers or 
normal random numbers. This is useful for generating quick datasets to test and try out other Origin 
features. 

These simple procedures create a dataset in a pre-selected worksheet range or column(s): 

http://www.originlab.com/doc/Origin-Help/Analysis-Templates
http://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
http://www.originlab.com/doc/User-Guide/Import-Data
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Action Toolbar Button Menu Command 

Fill a range or column with row 
numbers 

 

• Column:Fill Column With:Row 

Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With Row 

Numbers 

Fill a column with uniformly 
distributed random numbers between 
0 and 1 

 

• Column:Fill Column 

With:Uniform Random 

Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With 

Uniform Random Numbers 

Fill a column with normally distributed 
random numbers 

 

• Column:Fill Column 

With:Normal Random Numbers 

or 

• Right-click and select Fill 

Range/Column(s) With Normal 

Random Numbers 

Fill a column with a patterned or 
random set of numbers 

-- 

• Right-click and select Fill 

Range/Column(s) With A set 

of Numbers... 

Fill a column with a patterned or 
random set of Date/Time Values 

-- 

• Right-click and select Fill 

Range/Column(s) With A set 

of Date/Time Values... 

Fill a column with arbitrary set of 
Text&Numeric values 

-- 

• Right-click and select Fill 

Range/Column(s) With 

Arbitrary set of Text&Numeric 
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values... 

 
The auto fill feature can be used in filling column label rows and the worksheet data cells: 

To use auto fill to extend a pattern in the data across a range of cells (numeric data only): 

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection. 

2. When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right. 

 
To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data): 

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection. 

2. When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the 

right. 

 
Datasets can also be generated quickly using LabTalk script. As an example: 

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the 

following lines of script code into that window: 

2.  

 

col(1)={0:0.01:4*pi}; 

col(2)=sin(col(1)); 

3. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be 

filled with data. 

9.4 Setting Column Values 

   The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or 
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a 
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a 
one-line mathematical expression and a Before Formula Scripts panel (usage optional) intended for data 
pre-processing and defining of variables used in your one-line expression. 

http://www.originlab.com/doc/User-Guide/Programming-in-Origin
http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified 
spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column 
Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is 
now simply "A1"). 

In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used 
in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can 
it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode, 
so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have. 
For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see 
Column Formula Examples. 

To open the Set Values dialog box for a single column: 

1. Select a worksheet column or a range of cells in a worksheet column. 

2. From the menu, choose Column: Set Column Values... or right-click on the worksheet column and 

choose Set Column Values... from the shortcut menu. 

 
To open the Set Values dialog box for multiple columns: 

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet. 

2. From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column 

and choose Set Multiple Column Values... from the shortcut menu. 

http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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9.4.1 Set Values Menu Commands 

Menu 
Commands 

• Formula: Load a saved formula into the column formula box. Formulas are 

saved using Formula: Save or Formula: Save As.... 

• wcol(1): Use the menu to include worksheet columns in either your column 

formula or your Before Formula Scripts (column reference is inserted at the 

cursor). A Column Browser is available to help in selecting the correct 

columns. Columns are listed by column index. 

• Col(A): Similar to wcol(1) menu functionality but columns are listed by 

column name (including Long Name, if it exists). 

• Function: Add LabTalk functions to your expressions (function name is 

inserted at the cursor). Note that when you hover over a function in the menu 

list, the function description will be shown in the Status Bar. When a function 

is selected, its description will be displayed in a pop-up Smart Hint. 

• Variables: Add a variable or a constant to Column Formula or Before 

Formula Scripts; Add range variables (including by selection) or file 

metadata, to Before Formula Scripts. 

• Options: Allow direct editing of column formula in worksheet Formula row; 

add a comment about the column formula; or preserve text in Set Values 

columns (do not treat as text as missing values). 
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Column Formula 

• Add a single line expression for generating data. Functions, conditional 

operators and variables can be used. 

Before Formula 
Scripts 

• LabTalk scripts to be executed before the expression in the column formula 

box is executed. 

 

When you mouse over one of the functions listed in the Function menu in Set Values 
dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a 
Smart Hint appears with a more detailed explanation and a link to the full function 
description, syntax, examples, etc. 

Additionally, you can click the Search and Insert Functions button to search for 
available functions by keyword and, once found, insert the function into your 
expression. 

 

Use the Before Formula Scripts panel to define variables, LabTalk functions, or run 
LabTalk scripts before the expression in the upper panel is evaluated. 

 

To learn more, see Set Column Values - Quick Start 

9.4.2 The "F(x)=" Worksheet Column Label Row 

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is 
directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation 
that works in the formula box in Set Values also works in F(x)=: 

1. Double-click in a cell in the F(x)= column label row. 

2. Enter an expression to enter output in the data column below. 

 

9.4.3 Set Column Values Tutorials 

 

Tutorial 1: A Quick Units Conversion using F(x)= 

1. Start with a new workbook and import the file \Samples\Graphing\WIND.DAT. 

2. We will assume that column B contains Speed values in miles per hour (MPH). Click 

http://www.originlab.com/doc/User-Guide/Origin-Interface
http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart
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on the column heading for column C, then right-click and choose Insert. Origin 

inserts a new column C and moves Power values to column D. 

3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH). 

Double-click in the F(x)= cell of column C and enter  

 

B*1.6 

and press Enter. Column C is filled with values in units of KPH.  

 
Tutorial 2 : Computing Moving Average and Moving Standard Deviation 

1. Import the file Samples\Signal Processing\fftfilter1.DAT. 

2. Add two more columns to the worksheet by clicking the twice. 

3. Click on the header of the 3rd column to select it, then right-click and select Set 

Column Values... from the context menu. 

4. In the Set Values dialog, enter the following in the upper panel:  

 

movavg(B,5,5) 

and press Apply. Column 3 is filled with an 11-point moving average of the data 

from column B (note that you can insert functions such as movavg from the 

Function menu of the Set Values dialog box).  

5. Click the >> button above the edit box to switch to the 4th column. 

6. In the edit box for the 4th column, enter the formula:  

 

movrms(B,5,5) 

and press OK. This 4th column will be filled with root-mean-square (RMS) values, 

using a window size of 11 at each point.  
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Tutorial 3: Set Values for Multiple Columns 

1. Create a new project by clicking the New Project button on the Standard 

toolbar. 

2. Click the Import Multiple ASCII button to import the files F1.dat and F2.dat 

in the <Origin Folder>\Samples\Import and Export\ path. In the impASC dialog, 

set Multi_File (except 1st) Import Mode to Start New Books and click OK. 

3. Two workbooks are created, named as F1 and F2. Click the New Workbook 

button on the Standard toolbar to create another workbook. 

4. With the 3rd workbook active, click the Add New Columns button to add a 

column. Highlight all columns and select Column: Set Multiple Columns Values 

from the main menu or right-click the columns and select Set Multiple Columns 

Values from the shortcut menu to open the Set Values dialog box. 

5. Expand the bottom panel by clicking the Show Scripts button . Enter this script 

in the Before Formula Scripts edit box, 

 

range r1=[F1]F1!wcol(j); //"j" is the column index. 

range r2=[F2]F2!wcol(j); 

6. Enter (r1+r2)/2 in the Column Formula edit box 

7. Select Options: Direct Edit Formula Cell to clear this option. 

8. Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text 

dialog, then click OK. 

9. Click the OK button in the Set Values dialog box. You will see the results in the 

worksheet, and (F1+F2)/2 will display in the F(x)= column label row instead of the 

formula. 

9.5 Setting Cell Values 

Beginning with version 2018, Origin supports cell-level expressions similar to those used by spreadsheet 
programs. Cell-level expressions which return a single value (numeric, string or date/time) can be entered into 
any worksheet data cell or into cells in a User-Defined Parameter row of the column label row area. When Edit 
Mode (Edit: Edit Mode) is toggled on, cell formulas display. When Edit Mode is toggled off, the formula result 
is displayed. Cell content can be edited regardless of Edit Mode state. 

http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
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• To use cell formulas, Spreadsheet Cell Notation must be enabled (it is by default). 

• Cell formulas begin with an equal sign (e.g. =B1 - C1). 

• Cell formulas can return a numeric, a string or a date-time value. 

• Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and 

constants. 

• Cell formulas can reference values in other sheets or books. 

• Cell formulas can be extended to other cells by dragging with your mouse. 

 
To learn more, see Using a Formula to Set Cell Values. 

 

Origin 2020 adds the Excel "$" cell-reference syntax for more intuitive absolute cell 
references. This should make constructing cell formulas easier, particularly for those 
who have used MS Excel. See Tutorial 1, next. 

9.5.1 Set Cell Values Tutorials 

 

Tutorial 1: Extending a cell formula to other cells 

1. Click the New Workbook button to open a new book. 

2. Click on the column A heading to select, then right-click and choose Fill Column 

with Row Numbers. 

3. Click on cell B1 and enter:  

 

=A1+A$1 

http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
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4. Press ENTER. This adds the value in A1 to the value in A1. 

5. With the cell still selected, hover on the selection handle in the lower-right corner 

of the cell and when it looks like a "+", double-click to extend the cell formula to 

the bottom of the column. 

6. Click the Add New Columns button to add column C. 

7. Click on the Cell in C1 but this time enter (omitting the "$"):  

 

=A1+A1 

8. Press ENTER. This adds the value in A1 to the value in A1. 

9. With the cell still selected,hover on the selection handle in the lower-right corner of 

the cell and when it looks like a "+", double-click to extend the cell formula to the 

bottom of the column. Note that this time, the resulting values are different. 

10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in 

column B "locked" the second cell A1 reference so that it didn't change but that the 

A1 reference in column C changed with the row index number as we extended the 

cell calculation to other cells. 

 

 

Tutorial 2: Quickly finding maximum values in multiple columns of data using 
special keyword "This" 

The only place where you can use cell formulas in the worksheet column label rows 
(worksheet header rows), is in a User Parameter row. 

 
 
 

1. Create a new workbook and then choose Data: Import From File: Single ASCII 

and import the file \Samples\Import and Export\S15-125-03.dat. 

2. With your mouse, hover just to the left of the F(X)= row label and when the 

pointer becomes an arrow, right-click and Add User Parameters. 

3. In the dialog box that opens, enter "MaxValue" and click OK. 

http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
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4. In column A(X), in the MaxValue cell, enter:  

 

=Max(This) 

5. Click outside the cell and cell should now display "10". 

6. Click back on this cell, then grab the selection handle in the lower right corner of 

the cell and drag to the right to extend the cell formula to MaxValue cells in 

columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the 

maximum values in their respective columns. 

 

Tutorial 3: Use a column label row value in a cell calculation 

All data in the worksheet column label rows, including User Parameter rows, is stored 
as string data. To use a "number" stored in a column label row in a cell calculation, you 
must convert the string to a numeric value. In the following example, we use the 
LabTalk value() function to convert column label row data to a numeric so that it can 
be used in a cell calculation: 

 
 
 

1. Create a new workbook and then choose Data: Import From File: Single ASCII 

and import the file \Samples\Import and Export\S15-125-03.dat. 

2. With your mouse, hover just to the left of the F(X)= row label and when the 

pointer becomes an arrow, right-click and Add User Parameters. 

3. In the dialog box that opens, enter "Correction" and click OK. 

4. In column D, enter the value "0.2" into the Correction cell. 

5. Click the Add New Columns button to add column E. 

6. In cell E1, enter:  

 

 =D1+value(D[Correction]$) 

7. Press ENTER. This converts the Correction value to a numeric and adds the 

numeric to the value in cell D1. The cell should display 101.9. 

 
NOTE: The "$" in the above expression does not function to create an absolute cell 
reference as in the first example above. In this context, the "$" syntax is used to 
express a string variable stored in a user-parameter cell, before converting that string 

http://www.originlab.com/doc/LabTalk/ref/Value-func
http://www.originlab.com/doc/LabTalk/ref/Value-func
http://www.originlab.com/doc/LabTalk/ref/Column-Label-Row-Characters
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to a numeric value. 

9.6 Processing Worksheet Data 

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the 
Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be 
active). Some utilities are available from a shortcut menu: select your data and right-click.       

Utility Menu Access 

• Sorting Data 
Worksheet: Sort Range 
Worksheet: Sort Columns 
Worksheet: Sort Worksheet 
Worksheet: Sort Columns by Label 

• Find 

• Replace 

• Go To (sheet 

row/column) 

Edit: Find in Project 
Edit: Find in Sheets 
Edit: Replace 
Edit: Go To 

• Hide Column 

• Hide Rows 

Column: Hide/Unhide Columns 

Hide/Unhide Rows (shortcut menu only) 

• Move Columns 

• Swap Columns 

Column: Move Columns or Column toolbar. 

Column: Swap Columns 

• Query Worksheet Data 
Worksheet: Worksheet Query 

• Copy Columns to (new 

locations) Worksheet: Copy Columns to 

• Append Worksheet 
Worksheet: Append Worksheet 

• Split Columns 

• Split Worksheet 

• Split Workbook 

Worksheet: Split Columns 

Worksheet: Split Worksheet 

Worksheet: Split Workbooks 

http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Data
http://www.originlab.com/doc/Origin-Help/Wks-Sort-Col-by-Labels
http://www.originlab.com/doc/Origin-Help/Finding-Project
http://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
http://www.originlab.com/doc/Origin-Help/Wks-Find-Replace-Data
http://www.originlab.com/doc/X-Function/ref/colmove
http://www.originlab.com/doc/Origin-Help/Column-Toolbar
http://www.originlab.com/doc/X-Function/ref/colswap
http://www.originlab.com/doc/Origin-Help/Wks-Query-QS
http://www.originlab.com/doc/Origin-Help/copy-columns
http://www.originlab.com/doc/Origin-Help/append-worksheet
http://www.originlab.com/doc/X-Function/ref/colsplit
http://www.originlab.com/doc/Origin-Help/split-wks-into-sheets
http://www.originlab.com/doc/Origin-Help/split-wkbk
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• Worksheet Transpose 
Worksheet: Transpose 

• Stack Multiple Columns 

into One with Grouping 

• Unstack Grouped Data 

into Multiple Columns 

Worksheet: Stack Columns 

Worksheet: Unstack Columns 

• Summarize Data with 

Pivot Table Worksheet: Pivot Table 

• Filter data by defining 

conditions on one or 

more columns 

Column: Filter menu, or Worksheet Data toolbar 

See Also: Data Masking 

 

Previously, filters needed to be reapplied 
manually after new data were imported. 
Filters will now run automatically on 
import. In addition, applying a filter to 
large datasets is significantly faster than 
it was in previous versions. 

 

• Data Reduction 

Worksheet: Remove/Combine Duplicated Rows 
Worksheet: Reduce Columns 
Worksheet: Reduce Rows 
Analysis: Data Manipulation: Reduce Duplicate X Data 
Analysis: Data Manipulation: Reduce by Group 
Analysis: Data Manipulation: Reduce to Evenly Spaced X 

• Apply Conditional 

Formatting to 

Worksheet Cells 

Worksheet: Conditional Formatting: Highlight 
Worksheet: Conditional Formatting: Heatmap 
Worksheet: Conditional Formatting: Duplicates 

• Reverse Order 
Column: Reverse Order 

 

In addition to the above worksheet data utilities, the Origin worksheet supports Conditional 
Formatting. Conditional Formatting has three modes: 

• Highlight mode opens a dialog box with controls to apply color to worksheet cells based 

on one or more conditions (e.g. "equal to", "not equal to", "text that contains", etc). 

• Duplicates mode opens a dialog box with controls to apply to worksheet cells that 

contain duplicate values. 

http://www.originlab.com/doc/Origin-Help/transpose-wks
http://www.originlab.com/doc/Origin-Help/Wks-Stacking-Cols
http://www.originlab.com/doc/Origin-Help/Wks-Unstacking-Cols
http://www.originlab.com/doc/Origin-Help/Wks-Pivot-Table
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Wks-Data-Toolbar
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/Origin-Help/reduce-duplicate-rows
http://www.originlab.com/doc/Origin-Help/Reduce-Columns
http://www.originlab.com/doc/Origin-Help/reduce-rows
http://www.originlab.com/doc/X-Function/ref/reducedup
http://www.originlab.com/doc/X-Function/ref/reducexy
http://www.originlab.com/doc/X-Function/ref/reduce_ex
http://www.originlab.com/doc/Origin-Help/conditional-format
http://www.originlab.com/doc/Origin-Help/conditional-format
http://www.originlab.com/doc/Origin-Help/conditional-format
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• Heat Map mode opens a dialog box with controls to apply a color map to cells based on 

worksheet values. The worksheet Heat Map is zoomable and scrollable, making it easy 

to get a "big picture" overview of data variation in three dimensions. 

 

9.7 Workbooks for Analysis and Reporting 

   

Apart from text and numeric data, the workbook can contain various other types of information -- graphs, 
notes and matrices; links to cell values in other books, project variables, documents or web pages; plus, 
import file metadata, variables and scripts -- making the workbook a flexible medium for collecting research 
data or for creating custom reports. 

 

Another option for generating reports is to create HTML reports using Origin's Notes 
window. A Notes window can link to graphs, worksheet cells, etc., either directly or 
using a placeholder sheet. For more information, see HTML Reports from Notes 
Windows. 

Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- say, the 
application of a data filter and a fitting operation on the filtered data, combined with a customized plot of the 
results, into something that we call an Analysis Template. The Analysis Template makes it possible to 
automatically generate a custom report of results, simply by supplying new input data. 

  

http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/Origin-Help/Analysis-Templates
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One attractive option for generating reports -- there are others, see the "New" button at the bottom of this 
section -- is to export data to a custom MS Word template, and optionally, a PDF file. This is done by running 
an output-generating analysis in Origin, then associating key results with bookmarks in a Word template, and, 
finally, saving the workbook as an Analysis Template. To generate your report, you open the Batch 
Processing tool, point to both your Analysis Template and your Word template, run the batch process and 
generate your reports. 

• For information on generating custom reports using an MS Word Template, see the tutorial 

Batch Processing with Word Template for Reporting. 

• For information on batch analysis and generating custom reports, see the Batch Analysis 

section of the "How to Handle Repetitive Tasks" chapter of this Guide. 

http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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9.8 Topics for Further Reading 

• The User Files Folder 

• Origin Template Files 

• What is Saved with the Workbook Template? 

• The New Workbook Dialog 

• Arranging the Worksheet 

• Displaying Supporting Data in the Worksheet Header Rows 

• Controlling How Numeric Data Display 

• Dates and Times in the Worksheet 

• Generating Simple Worksheet Datasets 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
http://www.originlab.com/doc/Origin-Help/Arrange-Wks
http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
http://www.originlab.com/doc/Origin-Help/Wks-Col
http://www.originlab.com/doc/Origin-Help/WksCol-DateTime
http://www.originlab.com/doc/Origin-Help/Wks-GenerateDataset
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• Column Short Name Restriction 

• Using Formulae to Set or Transform Worksheet Column Values 

• Using a Formula to Set Cell Values 

• Simple Manipulation of Worksheet Datasets 

• Inserting Graphs, Images and other Objects into Worksheet Cells 

• Inserting Links into Worksheet Cells 

• Inserting Variables into Worksheets 

• Conditional Formatting of Worksheet Cells 

• Analysis Report Sheets and Columns 

http://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
http://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
http://www.originlab.com/doc/Origin-Help/Wks-Manipulate-Datasets
http://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsLink-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
http://www.originlab.com/doc/Origin-Help/conditional-format
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
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10 Matrix Book Matrix Sheet Matrix Objects 

 

10.1 Matrix Books, Matrix Sheets and Matrix Objects 

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X 
and Y values.  The following table summarizes some important matrix book limits: 

Maximum Number of... 32Bit OS 64Bit OS 

Matrix sheets in a matrix book 

Matrix objects in a matrix sheet 
Cells in a matrix (Note) 

1024† 

65,527 
90,000,000 

1024† 

65,527 
90,000,000 

† > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with 

Origin versions prior to Origin 2018 SR0. 

Note: The product of any combination of rows and columns must not be greater than 90,000,000. 

10.1.1 Naming Matrix Books, Matrix Sheets and Matrix Objects 
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Matrix Book 

• The matrix book has a Short Name whether you display it or not. Origin uses 

the Short Name for internal operations. 

• Short Names must be unique within the project file, cannot contain spaces, 

must begin with a letter, consist only of alphanumeric characters (A to Z and 0 

to 9), and limited to 13 characters. You can use lowercase characters and the 

text will appear as such, but upper and lower case are not unique characters. 

(You cannot name one matrix MBOOK1 and another mbook1.) 

• Long Names are optional, need not be unique within the project file, can 

contain spaces, can begin with a letter, a number or a special character, and 

the length cannot exceed 520 characters, including spaces. 

Matrix Sheets 

• The sheet Short Name (a Layer object) must be unique within the matrix book 

and is limited to 32 characters. 

• Can contain spaces, numbers and special characters. 

• Can begin with a letter, number or special character. 

• These special characters are not allowed: `!%"|()[]{}<>. 
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Matrix Objects 

• Origin assigns a Short Name -- the matrix object index number -- to each 

matrix object, as it is created. This name/index number cannot be changed. 

• You can add an optional Long Name to the object by clicking on the yellow 

object icon - for a data matrix or for an image matrix - in the upper 

right corner of the matrix sheet and choosing Rename from the menu. 

10.1.2 Different Views of the Matrix 

   In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or 
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The 

matrix contains a single dataset of Z values. 

• Matrix columns are mapped to linearly-spaced X values. 

• Matrix rows are mapped to linearly-spaced Y values. 

 
Note that the matrix window has two column and row heading view modes: 

• By default, matrix row and column headings display as row and column index numbers (View: Show 

Column/Row from the menu or press Ctrl+Shift+C). 

• You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the 

Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values, 

calculated by linear interpolation of the axes From and To values by the number of columns and rows. 

 
In addition to the two row and column heading view modes, there are two matrix display modes: 

• In Data Mode (View:Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as 

raw numbers. 

• In Image Mode (View:Image Mode from the menu or press Ctrl+Shift+I), the matrix object displays as 

either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of real 

numbers or complex numbers displays as a gray-scale image while RGB values will display as a color 

image. 

http://www.originlab.com/doc/Quick-Help/Data-and-Image
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An image in a matrix can be cropped within the existing window or it can be cropped and copied to create a 
new matrix window: 

1. Make sure that there is a check mark beside Region of Interest Tools on the Tools menu. If this menu 

item is not checked, select it. 

2. Click the Rectangle Tool button on the Tools toolbar. 

3. Drag out a rectangular area on the image. 

4. Right-click on the rectangle and select Crop from the shortcut menu. 
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Note: If the matrix object is an image, the object icon will display as whether you are viewing the 

matrix object as an image (View:Image Mode) or as numbers (View:Data Mode). Likewise, when the 

matrix object contains numbers, the object icon will display as regardless of view mode. 

10.1.3 Matrix Books 

 Like the workbook window, the matrix book window is created from a customizable template (.otmu file). The 
matrix template stores such things as number of sheets in the book, the names of the matrix sheets, matrix 
dimensions, data type, math functions, data import handling instructions as well as various style and format 
options. 

When you create a new matrix book, the book is named MBookN, with N reflecting the order of window 
creation. Appended to the book name, you will see something like ":1/3" where the first integer denotes the 
active matrix object and the second denotes the number of matrix objects in the active matrix sheet. Following 
the above example, if you click the yellow object icon to the right side of the matrix, the menu shows three 
matrix objects with the first being the active one - the one with a check mark placed beside it (note that in our 
illustration, the objects are empty). 
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You can right-click on a worksheet tab and Add Matrix as Sheet and insert a matrix 
book into a workbook. This is useful when building Analysis Templates that involve 
matrix-based operations such as 3D surface fitting or 3D plotting operations. 

  

 

 

10.1.4 Matrix Sheets 

 

Prior to Origin 2018, an Origin matrix book could a maximum of 255 sheets. That 
number is now increased to 1024. When you have more than 255 sheets in a book, you 
will need to save the file using one of the new Unicode-compliant formats (opju, ogmu, 
etc). 

A matrix book can have up to 1024 matrix sheets. The default matrix book template - ORIGIN.otmu - has a 
single matrix sheet containing 32 rows and 32 columns. Each matrix sheet can differ in dimensions(number of 
rows and columns and X & Y range). 

To specify the dimensions of the matrix sheet: 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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1. Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix 

Dimensions and Labels dialog box. 

2. Specify a number of columns (X dimension) and rows (Y dimension). 

3. Specify a From and To value for X (columns) and Y (rows). 

  

Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix 

column and the last X is mapped to the last matrix column. The X coordinates of other columns are 

interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or 

analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y 

coordinate values (not column or row index) and the Z value contained in the cell intersected by the row 

and column. 

10.1.5 Matrix Objects 

A matrix sheet can contain up to 65,504 matrix objects (64-bit, 32-bit max = 43,339), though the actual limit 
is likely to be far less (determined by system resources). Objects in a sheet share the same X/Y dimensions 
and column (X) and row (Y) headers, but every object can have its own Z header. Other matrix object 
properties include internal data type and numeric display options. 

Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog 
box: 

1. Make sure that the matrix object is active (check mark shows beside it in the object menu). 

2. Choose Matrix:Set Properties... from the main menu. 

 

You can set properties for multiple matrix objects without closing the Matrix 
Properties dialog boxes by clicking the Previous or Next buttons at the top of the 
dialog box. 

10.2 Virtual Matrix 

  Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular 
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour 
plots. The data can include a column or label row with the X or Y values. Unlike a regular matrix which only 
supports a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y 
coordinate values (provided those values are in ascending or descending order). 

http://www.originlab.com/doc/Origin-Help/MatOb-Header
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Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in 

the X and Y dimensions. This is not considered a "virtual matrix." 

10.3 Matrix Templates 

  Matrix windows are created from a matrix template file (*.otmu). The template file saves such things as the 
number of sheets in the matrix book, the number of rows and columns in each sheet, internal memory 
allocated for each sheet, mathematical formula used to fill the matrix with numbers and certain ASCII import 
and export options. 

Note: Data are NOT saved with the matrix template file. 

 
To save the active matrix window as a template: 

1. With the matrix window active, choose File: Save Template As from the main menu. This opens the 

template_saveas X-Function dialog box. 

2. Select a category from the Category drop-down list or enter a new category. 

3. Select or type a file name in the Template Name box (the .otmu extension is automatically added). 

4. Enter a description into the Template Description text box (optional). 

5. Type the file path for the template or click the browse button to locate your folder. Typically, you would 

save your template to your User Files folder. 

 
The following table lists some of the kinds of things that are saved with the matrix template file. It also tells 
you where to find these controls.   

Dialog Box What is Saved? Menu Access 

-- 
• The Organizer 

• The Script Panel 

Right-click on window title bar 
and choose:  

http://www.originlab.com/doc/User-Guide/Graphing
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• The Matrix Image Thumbnails 
• Show Organizer 

• Show Script Panel 

• Show Image 

Thumbnails 

Matrix Properties 

• Matrix Long Name, Units, Comments. 

• Column width settings. 

• Column number Display (decimal, 

scientific, engineering). 

• Column Digits and data storage 

requirements. 

Matrix:Set Properties 

Matrix 
Dimensions and 

Labels 

• Numbers of rows and columns in the 

matrix, xy coordinates, XYZ axis labels. 
Matrix:Set 
Dimensions/Labels... 

Set Values 

• Formula used to create or transform 

matrix values. Matrix: Set Values ... 

ASCII Import 
Options 

• ASCII import options pertinent to the 

matrix window are saved with the 

template. 

Data: Import From File: 
Single ASCII 
Data: Import From File: 
Multiple ASCII 

10.4 Simple Manipulation of Matrix Data 

 

Utility Menu Access 

• Flip or Rotate Matrix: Rotate90 
Matrix: Flip: Vertical 
Matrix: Flip: Horizontal 

• Expand (by interpolation) 
Matrix: Expand 

• Shrink (by averaging) 
Matrix: Shrink 
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• Transpose 
Matrix: Transpose 

• Convert to Worksheet 
Matrix: Convert to Worksheet 

10.5 Setting Matrix Values 

  The Set Values dialog box is used to generate or transform data in a matrix object. 

To open the Set Values dialog box, make sure that the matrix object is active, then: 

1. From the menu, choose Matrix: Set Values. 

or 

1. Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix 

icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu. 

 

Menu 
Commands 

• Formula: Load a saved formula into the matrix formula box. Formula are 

saved using Formula: Save or Formula: Save As.... 

• Mat(1): Use the menu to include matrix objects in either your matrix formula 
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or your Before Formula Scripts (matrix object reference is inserted at the 

cursor). A Matrix Browser is available to help in selecting the correct objects. 

Objects are listed by object index. 

• Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by 

object Long Name, if one exists. 

• Function: Add LabTalk functions to your expressions (function name is 

inserted at the cursor). 

• Variables: Add a variable or a constant to Matrix Formula or Before 

Formula Scripts; Add range variables (including by selection) or file 

metadata, to Before Formula Scripts. 

Matrix Formula 

• Add a single line expression for generating data. Functions, conditional 

operators and variables can be used. 

Before Formula 

Scripts 

• Enter one or more lines of LabTalk script to be executed before the expression 

in the Matrix formula box is executed. 

 

Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to 
define variables or LabTalk functions that you wish to use in your matrix formula. 

Click the Search and Insert Functions button to search for built-in LabTalk 
functions. 

10.6 Converting Worksheets to Matrixes 

There are four methods for converting worksheet data to matrix data.   

Method Conversion Type Notes 

Direct 

• X across columns 

• Y across columns 

• No X and Y 

Ideal for spreadsheet data that 
conforms to the following:  

• X data values in the 1st 

column, Y data values in the 

1st row and Z values in 

columns 2 to N and rows 2 

to M. 

• Y data values in the 1st 

column, X data values in the 

1st row and Z values in 

columns 2 to N and rows 2 
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to M. 

Expand 

• Row 

• Column 

Some ASCII files have an upper limit 
for characters allowed on a single line. 
Use this method when your file breaks 
a single line of data across multiple 
lines.  

• Expand by Row: specifies 

the number of ASCII file 

rows comprising one matrix 

row. 

• Expand by Column: 

specifies the number of 

ASCII file columns 

comprising one matrix 

column. 

XYZ 
Gridding 

• Regular 

• Sparse 

• Random (Renka Cline) 

• Random (Shepard) 

• Random (Thin Plate Spline) 

• Random (Kriging Correlation) 

• Random (Weighted Average) 

Conversion Type depends upon XY 
spacing:  

• Choose Regular applied for 

data that are regularly 

spaced in XY. 

• Choose Sparse when you 

have missing values. 

• Choose Renka-Cline, 

Shepard, TPS, Kriging or 

Weighted Average 

methods for data that are 

irregularly spaced in XY. 

XYZ Log 
Gridding 

Methods same as XYZ Gridding 
Calculates logarithmic values for X 
and Y, then performs XYZ Gridding. 

10.7 Converting Matrixes to Worksheets 

  

There are two methods for converting matrix data to worksheet data: 
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• Direct: This copies the Z values in the matrix to a worksheet with no reordering. If the matrix 

consists of M rows by N columns of Z values, this method produces a worksheet which has M rows 

and N columns. By default, the X and Y coordinates of the matrix Z values are not copied to the 

worksheet. You can opt to copy X coordinates to the 1st worksheet row or a parameter row and the Y 

coordinates to the 1st worksheet column.  

 

• XYZ Columns: This method produces a worksheet with three columns: an X, a Y and a Z column. 

The X and Y columns contain the X and Y coordinate values of the matrix Z values. The matrix Z 

values are contained in the worksheet Z column.  
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10.8 Profiling Matrix Data 

Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section. 

1. Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu. 

This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X 
and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is 
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the 
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a 
button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the 
Image/Contour Profiles dialog. 
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10.9 Topics for Further Reading 

• Matrix Books, Matrix Sheets and Matrix Objects 

• Matrix Book and Matrix Sheet Operations 

• What is Saved with the Matrix Template? 

• Matrix Dimensions and XY Coordinates 

• Matrix Object Data Properties 

• Setting Matrix Values 

• Matrix Conversion and Gridding 

• Creating 3D and Contour Graphs from a Virtual Matrix 

• Viewing and Profiling Matrix Data 

http://www.originlab.com/doc/Origin-Help/MatBk-Mats-MatOb
http://www.originlab.com/doc/Origin-Help/MatBk-Mats-Operation
http://www.originlab.com/doc/Origin-Help/MatBk-Template-What-is-saved
http://www.originlab.com/doc/Origin-Help/Mats-Dim-XYCoord
http://www.originlab.com/doc/Origin-Help/MatOb-DataProperty
http://www.originlab.com/doc/Origin-Help/Set-Mat-Value
http://www.originlab.com/doc/Origin-Help/Matrix-Conversion-Gridding
http://www.originlab.com/doc/Origin-Help/Plot-3D-Contour-VirtMat
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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11 Graphing 

  

11.1 Creating a Graph 

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over 
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for 
its applications in various technical fields. 

All graph types are accessible from the Plot menu. Note that while most graph types also have a 
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to 
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating 
graphs. 

Creating most graphs involves just two steps. 

1. Select your data. 

2. Select the plot type. 

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple 
data arrangements. See the Origin Graph Types section for specific requirements. 

11.1.1 Creating Graphs from Worksheet Data 

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are 
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and 
creating a simple graph. 

 

Tutorial: One click to create graph with selected data 

1. Open a new workbook and select Data: Import from File: Single ASCII... from 

the main menu. 

2. Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open. 

3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across 

the four column headings. 

4. Click Plot > Basic 2D: Line & Symbol: Line & Symbol. A graph window is 

created with four line and symbol plots. Note that the plots differ by line color and 

by symbol type. 

5. Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y). 

6. This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a 

very different plot is created using the same datasets. 

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs 
discusses customizing graphs and saving templates in more depth. 

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a 
3D surface plot, then overlaying it with a 3D scatter plot. 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
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Tutorial: 3D Surface Plot from XYZ Data 

1. Create a new, empty workbook window and import the file \Samples\Matrix 

Conversion and Gridding\XYZ Random Gaussian.dat. 

2. Highlight column C and right click. Select Set As: Z from the fly-out menu. 

3. Select Plot > 3D: 3D Colormap Surface to create a 3D Colormap Surface plot. 

4. Select the Graph: Layer Contents... menu item or right click the layer icon on the 

left-top of the graph to open the Layer Contents dialog. In this dialog, click on drop-

down next to the button and select 3D Scatter/Trajectory/Vector from the fly-

out menu. 

5. Select column C from the left panel and click on the Add Plot button to add the 

3D scatter plot to the graph. Click OK to close the dialog. 

6. Double-click on the plot to open the Plot Details dialog. In the left panel, expand the 

Layer1 node and then expand the 2nd node which represents the scatter plot. Click 

and select the branch named Original. Be sure to leave the node-level check box 

selected, otherwise this plot will be hidden. 

7. In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to 

Color Mapping: Col(C). 

8. In the Drop Lines tab, clear the Parallel to Z Axis check box. 

9. Select Layer1 from the left panel of the Plot Details dialog. In the Lighting tab, 

under Mode, select Directional. Click OK to close the dialog. 

10. Click on the scatter plot in the graph to select this plot, then in the Style toolbar, click 

on the button and select the Rainbow palette. 

Your graph should look like this: 
:
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You can hold down the R key on your keyboard and use the mouse to freely rotate the 
3D surface. With the pointer tool active, click on the layer for additional controls to 
move, stretch and rotate the surface. 

11.1.1.1 Worksheet Column Plot Designations 

 The labels (X), (Y), (Z), etc. in column headings are referred to as the Column Plot Designation. Columns 
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data 
requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in 
concert with settings saved in the graph template, to allow you to quickly create a graph. 

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose 
Column: Set as:<option>; or right-click and choose an option from the Set As: context menu. 

In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns. 
The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D 
graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column. 

Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot 

Designation, in documentation for the Column Properties Dialog Box. 

11.1.1.2 Selecting Worksheet Data 

 Various ways to select data for plotting: 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
http://www.originlab.com/doc/Origin-Help/ColProperties-Dialog-Properties-Tab
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• Single column: Click on the column heading, e.g. B(Y) 

• Multiple columns: To select a small number of contiguous columns, click on the first column heading and 

drag the pointer to the last column heading. To select a large number of contiguous columns, click on the 

first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then 

press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the 

CTRL key while clicking on the desired column heading. 

• A range in a column: Click on the first cell of the range and drag to the last cell of the range. 

• Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range. 

When plotting, each range will be treated as a separate data plot in a plot group. 

• Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell. 

If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be 

treated as a separate data plot in a plot group. 

• Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select 

multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row 

headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot 

group. 

• Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner 

of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-

pointing arrow, click to select the entire worksheet. 

• Specific columns: To select columns by data in column label rows (header rows); or to select columns 

using a pattern, choose Edit: Select. 

11.1.2 Creating a Graph from Matrix Data 

 As discussed in the Matrix Book, Matrix Sheets and Matrix Objects chapter, a matrix is a dataset of Z values 
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix 
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier 
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case 
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars 
still require matrix data. 

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a 
worksheet and for one reason or another, you need to convert it into a matrix form, see Converting 
Worksheets to Matrixes. 

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select 
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since 
you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset 
of the data plot to display once the graph is created. See Editing Plot Range in the Manipulating Data Plots 
section of this chapter. 

11.1.2.1 The Virtual Matrix 

The Virtual Matrix concept was covered in the Matrix Book, Matrix Sheet and Matrix Object chapter of this 
Guide. To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates 
in the first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and 
can even contain text or date/time data.  

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's 
Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y 
coordinates. The intersecting data points are then treated as Z values. 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
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Tutorial: Contour Plot from Virtual Matrix 

1. With a new workbook active, use the Data: Import from File: Import Wizard... 

menu to open the Import Wizard dialog. 

2. Press the browse button in the dialog and select the file Waterfall.dat from the 

Samples\Graphing subfolder. 

3. This file has an import filter already associated with it. Press the Finish button to 

import the file. 

4. With the workbook active, press CTRL+A to select the entire sheet. 

5. Now select the Plot > Contour: Contour - Color Fill menu item. The plotvm 

dialog will open. 

6. In the dialog, set the Y Values in drop-down to Column Label, and then set the 

Column Label drop-down to Excitation Wavelength(nm). 

7. Set the X Values in drop-down to 1st column in selection, then press OK to 

close this dialog. 

8. The contour plot will be created. 

9. Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the 

Speed Mode drop-down to Off and press OK. This will turn off speed mode so that 

all data points are plotted (see the discussion of Speed Mode, below). 

10. Click on the contour plot to select this data plot, then from the Style toolbar, click 

the Palette button and then select the Pumpkin Patch palette. Your graph 

should look similar to the image below: 

 

http://www.originlab.com/doc/User-Guide/Graphing
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Once you customize your contour levels and colors, you can save your settings as a 
Theme, or simply copy-paste your customizations from one graph to another. To save a 
Theme, right-click on the graph and choose Save Format as Theme; or use the 
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog 
box. 

11.1.3 2D and 3D Function Plots 

    

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four 
options to choose from: 

Type Function Form 

2D Function Plot y = f(x) 

2D Parametric Function 
Plot 

x = f1(t) 
y = f2(t) 

3D Function Plot z = f(x, y) 

3D Parametric Function 
Plot 

x = f1(u, v) 
y = f2(u, v) 
z = f3(u, v) 

 
These plot types are also accessible from the function plot buttons on the Standard toolbar. 

 

 

  

 

Tutorial: 3D Function and 3D Parametric Function in Same Layer 

1. From the menu, choose File: New: Function Plot: 3D Parametric Function 

Plot... 

2. In the dialog that opens, click on the arrow button at the top right side of the 

dialog, and from the fly-out menu select the built-in example Partial Torus 

(System) and press OK to close the dialog. The function plot will be created. 

http://www.originlab.com/doc/User-Guide/Customizing-Origin
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
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3. With the function plot window active, invoke the menu File: New: Function Plot: 

3D Function Plot.... 

4. In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and 

y scale. 

5. In the Z(x,y) edit box, enter 0. 

6. Set the drop-down at the bottom left corner of the dialog to Add to Active Graph 

and press OK to close dialog. 

7. The Z=0 plane will be added to the graph, and the plane will properly intersect the 

parametric surface plot. You can hold down the R key and use the mouse to freely 

rotate the plot. 

 

• Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of 

the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions. 

• For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is 

created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of 

Function or if on the Function tab in Plot Details, click the Workbook button. 

• Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting 

or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate 

Surface.... You can even add noise to the plot. Corresponding data is created as well. 

11.2 Plotting without Using Column Plot Designations 

 While Column Plot Designations remain an important concept, they are no longer required by many Origin 
graphing and analysis operations. For instance, the Plot Setup dialog box allows you to freely specify which 
column is used as X, Y, etc. when plotting, thereby overriding the Column Plot Designations. 

http://originlab.com/3dfunctions
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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In order to make full use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of 
objects contained in the Origin graph window.      

11.2.1 Pages, Layers, Plots and the Active Plot 

 Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the 
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default, 
the dimensions of the graph page are defined by the printable area of your default printer driver; without 
adjusting settings, a printed graph should fill the printed page. 

 

• The graph page must contain at least one, and may contain as many as 1024, graph layers. 

• Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that 

the graph in the image above contains three graph layers, represented by the three non-printing layer 

icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted, 

indicating that this is the active layer. 

• Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is 

the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is 

active. The active plot will have a check mark beside it. 
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The hierarchical structure of the graph page can be seen in these places: 

• The Plot Details Dialog Box (Format: Page ...) 

• The Object Manager (View: Object Manager) 

• The Plot Setup Dialog Box (Graph: Plot Setup...) 

 

 

11.2.2 The Plot Setup Dialog Box 

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data 
plots in an existing graph. 

• Creating graphs without regard to Column Plot Designations 

• Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrix books, loose 

datasets, etc. 

• Creating graphs combining multiple plot types. 

• Adding, removing, replacing data plots. 

• Grouping or ungrouping data plots. 

• Reordering data plots in a layer or moving data plots to another layer. 
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To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and 
choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button). 

To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left 
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup.... 

  

 

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box 

1. Click the New Workbook button on the Standard toolbar. 

2. Click Data: Import From File: Single ASCII, browse to the Origin installation folder 

and import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns 

are actually paired - X data and Y data -- but by default all columns are assigned a "Y" 

Column Plot Designation on import. 

3. Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup 

dialog box. 

4. Click the two "double-arrow" buttons to show all three dialog box panels. 

5. In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for 

Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the 

bottom panel. 

6. Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By), 

then click Add. 

7. Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy), 

then click Add. Three plots are added to Layer 1. 
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8. Press CTRL and click on each plot in the bottom panel to select all three, then right-click 

and choose Group. 

9. Click OK to create a grouped line plot. 

 

 

Tutorial: Creating a Graph with Data from Multiple Worksheets 

1. Click the New Workbook button on the Standard toolbar. 

2. Click Data: Import From File: Multiple ASCII, browse to the Origin installation folder 

and select Sensor01.dat, Sensor02.dat and Sensor03.dat under \Samples\Curve Fitting\ 

to import. After Import, 3 workbooks are created. 

3. Without selecting any data, click Plot > Basic 2D: Line+Symbol. This opens the Plot 

Setup dialog box. 

4. Expand the top panel if it is hidden. From the Available Data list, choose Worksheets 

in Folder. 

5. Select Sensor01, Sensor02 and Sensor03 sheets in the top panel. 

6. In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box for 

Column B (Sensor Output), then click the Add button. 

7. Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3 

worksheets. 
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• The Plot Setup middle panel only allows choosing one X column at a time. 

• If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want 

columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only 

plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns 

and select all columns with same Long Name and plot them together. The Y columns will be plotted 

against corresponding X columns. 

• To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y 

columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button. 

• All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a 

group, right-click the Group node in bottom panel and Ungroup first. 

• Drag and drop data plots in the bottom panel to move them to different layers. 

• If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click 

the OK button to create your graph. 
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11.3 Manipulating Data Plots 

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding 
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed 
plot customizations, including those involving such things as changing plot symbols, colors, and legend 
customizations, see the Customizing Graphs chapter. 

 

The following methods of manipulating data plots in the graph window are fairly easy to 
use. Thus, you may want to choose File: Open Template and pick your template to 
create a blank graph window. Then, using the methods below you can add and group 
data plots in the graph. 

11.3.1 Changing Plot Type 

 Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing 
plot with a few other select plot types. Some examples: 

• Scatter, line, line+symbol, column/bar are interchangeable. 

• 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable. 

 
To change the plot type of an existing plot: 

• Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu. 

• Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type drop-

down list. 

• Click on the data plot, then click one of the supported graph toolbar buttons. 

 
Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are 
switched. 

 

A word of caution: This is an old Origin feature, and for a quick change of plot types in 
a single-layer graph it works well. Changing plot types in a multi-panel, multi-layer 
graph can lead to unwanted outcomes. When working with more complex graphs, it is 
better to create a graph directly using the specified Plot menu command or toolbar 
button . 

11.3.2 Exchanging Data Plots 

 You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands. 
Right-click on a data plot, then select one of these options: 

• Change X. This menu item allows you to change the assignment of X data to another data column in the 

same worksheet. 

• Change Y. This menu item allows you to change the assignment of Y data to another data column in the 

same worksheet. 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Graphing
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• Change Worksheet. This menu item allows you to replace both X and Y with data from another 

worksheet. The selected worksheet should have the same Short Names, the same Column Plot 

Designations and the same row index range as the current worksheet. 

 

If you have a grouped data plot, then clicking once on any of the plots in the group will 
select the entire group. Click a second time to select a particular member of the group. 
The context menu options to change worksheet, X, or Y are available only when a 
single data plot is selected. 

 

Tutorial: Changing X and Y assignment of a data plot 

1. Start with a new workbook and import the file automobile.dat from the 

Samples\Statistics sub-folder of the Origin installation folder. 

2. Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu 

item. The Gas Mileage column is plotted against the default X column Year. 

3. Right-click on the data plot and select Change X: Engine Displacement. The 

Gas Mileage column is now plotted against Engine Displacement. 

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the graph 

should be rescaled. If data are not significantly different, you may want to manually rescale the graph (Hot 

key: CTRL+R). 

 

If you perform analysis on the data plot (e.g. linear regression with Recalculate set to 
Auto), the fit results will automatically update when you change X/Y or the worksheet. 

11.3.3 Adding, Removing and Hiding Data Plots 

 Use the following methods to add or remove data plots from a graph. 

11.3.3.1 Adding Data by Drag and Drop 

 You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column 
Plot Designations to create the plot. 

1. Select the worksheet data (one or more columns or a range of one or more columns). 

2. Move the mouse over the left or right edge of the selected range. 

3. When the pointer looks like this , hold down the left mouse button and drag the data to the graph 

window. Release the mouse. 

4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse. 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns


Graphing 

137 

 

Usually the current plot type is used when plotting by drag-and-drop. To change the 
global plot type to use when drag and drop, choose Preferences: Options... from the 

main menu. Go to the Graph tab and change the Drag and drop plot type. 

11.3.3.2 Adding and Removing Data with the Layer Contents Dialog Box 

  Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left 
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right 
panel lists datasets that are plotted in the active layer. 

 

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When 
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before 
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the 
layer. 

  

11.3.3.3 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box 

 Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph. 

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data. 

2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated 

(as X, Y, yError or Label). 

3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button. 

4. To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove. 

5. To hide a plot, uncheck the Show check box for the plot. 
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6. To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in 

middle panel and click the Replace button. 

 

11.3.3.4 Adding Data by Direct ASCII Import 

 You can import ASCII files directly into the active graph window using the the Import ASCII toolbar button. 
Note that this method works only with files having a simple structure and it supports only the simplest of 
graph types - Line, Scatter, Line + Symbol, Column and Bar charts. 

1. Click the Import ASCII button. This opens the Import ASCII dialog box. 

2. Choose a file. 

3. Click Open. 

The file is imported and plotted in the active graph window. 

11.3.3.5 Adding Data by Copying and Pasting a Plot 

You can copy a plot from an existing graph window and paste it into the same or another window. 

1. Click on the plot to select it and press CTRL+C. 

2. Click on the target graph and press CTRL+V. 

Simultaneously, a ClipbN worksheet is created. You can open this worksheet by double-clicking on the plot, 

then clicking the Workbook button at the bottom of Plot Details; or right-click on the plot in the graph window 
or in the Object Manager and choose Create worksheet ClipbN. 

 

You can also "copy" a plot and paste the data to a worksheet. Click on the plot to select 
and press CTRL + C, then click on a cell and press CTRL+V to fill the column with plot 
data. 

11.3.3.6 Removing or Hiding Plots with the Object Manager 

 The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots. 
See the section on The Object Manager in this Guide. 

http://www.originlab.com/doc/User-Guide/Origin-Interface
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To hide or remove plots, right-click on a plot and choose from the shortcut menu: 

 

• Show or hide plots of the same Long Name. 

• Show all plots. 

• Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be 

added back using one of the above methods). 

• If the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can 

right-click on the group icon and remove the entire plot group. 

• When you right-click on a plot, you can use Hide Plots with Same Name and Hide All Plots shortcut 

menu items to quickly hide selected plots in the window without removing them entirely (restore plots by 

enabling their display in the Object Manager or in Plot Details). 

11.3.3.7 Removing or Hiding Data with Plot Details 

In the left panel of the Plot Details dialog box (Format: Plot...), right-click on a plot and choose Remove or 
Hide from the context menu. Remove will delete the data plot from the graph so if you just want to 
temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix. 

http://www.originlab.com/doc/User-Guide/Graphing
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11.3.3.8 Deleting Plots using the Delete Key 

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected 
plot is part of a group, the entire group is deleted. 

Note that this is more sweeping than the Remove shortcut menu command in that it will remove an entire 

plot group from the graph window. This action does not delete worksheet or matrix data. 

To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu. 

11.3.3.9 Editing Plot Range 

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data: 

• Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To 

values. 

• In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column 

by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click 

the ... button that appears to the right side of that column. 

• In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and 

click the ... button that appears to the right side of that column. 

 

Choose Graph: Rescale to Show All to rescale the graph after editing the plot range. 

11.3.4 Grouping Data Plots 

 When you make multiple range or column selections, then create a graph, Origin groups the resulting data 
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D 
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs. 

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a 
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, 
triangle...; etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list 
of styles. For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot 
might be denoted by a red line (the second color in the color list), the third plot by a green line (the third color 
in the color list), and so on. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
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Tutorial: Creating a simple grouped data plot 

1. Open a fresh worksheet and click the Import Single ASCII button on the 

Standard toolbar. 

2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open 

GROUP.DAT. 

3. Select B(Y), C(Y), and D(Y) columns 

4. Click the Line & Symbol button on the 2D Graphs toolbar. Note that line and 

symbol color and symbol type are automatically differentiated for each plot. 

 

Tutorial: Grouping (or ungrouping) plots manually 

• Via the Layer Contents dialog box 

1. To open the Layer Contents dialog box, double-click on the layer n icon in 

upper-left corner of the graph window. 

2. To create a group, select the desired data sets from the Layer Contents list (use 

CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data 

sets). 

3. Click Group. Note that each plot in Layer Contents is now preceded by a gn (for 

"group1", "group2", etc.). 

4. To ungroup, click on one of the grouped data plots in the Layer Contents list and 

click Ungroup. 

  

• Via the Plot Setup dialog box 

1. To open the Plot Setup dialog box, ALT + double-click on the layer n icon in 

upper-left corner of the graph window. 

2. To create a group, select the desired plots from the Plot List (use the CTRL or 

SHIFT keys to select multiple data sets). 

3. Right-click and select Group. Note that a Group icon now precedes the selected 

plots in the Plot List. 

4. To ungroup, right-click on the Group icon and choose Ungroup from the shortcut 

menu. 

11.3.5 Speed Mode 

  With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most 
used when working with large data sets, though note that there have been improvements in this area and 
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Origin now has Density Dots and Color Dots graph templates specifically for creating scatter plots of large 
datasets. 

Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in 
red and a Speed Mode is On watermark appears in the layer. The watermark is not included when printing, 
copying, or exporting the graph. 

 

To adjust Speed Mode settings: 

1. With your graph active, select Format: Layer... from the Origin menu. 

2. Select the Display/Speed tab. 

3. For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check 

box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type 

the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n, 

Origin displays a subset of the data plot containing n points, drawn by extracting values at regular 

intervals from the data set. 

4. For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data, 

Maximum Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the 

X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of 

the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at 

regular intervals from the matrix columns (X) and rows (Y). 

For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-
Functiondialog. The dialog lets you specify which windows the settings should apply to ( Target ) and also, 
offers several levels of data plot thinning from Off to High, plus Custom. 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/X-Function/ref/speedmode
http://www.originlab.com/doc/X-Function/ref/speedmode
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Click the Enable/Disable Speed Mode button on the Graph toolbar, to toggle 
Speed Mode on/off for all layers in the graph window. 

To turn off the Speed Mode is On watermark: 

1. Select Preferences: Options to open the Options dialog box. 

2. Select the Graph tab and clear the Speed Mode Show Watermark check box and refresh the graph, if 

needed. Note that this only disables the watermark; it does not disable Speed Mode. 

11.3.5.1 Notes on Speed Mode: 

 

There are a couple of changes to Origin 2020 that involve Speed Mode. Skip Points 
and Speed Mode now plot the last data point, by default (controlled by system 
variable @SMEP). Secondly, drawing speeds are now faster with Speed Mode off, 
especially when using square scatter symbols + color-mapping (in which case it is 5 to 
10 times faster). 

• The Speed Mode controls on the Display/Speed tab of the layer's Plot Details only apply to what you see 

on screen. They do not apply to graphs that are printed or exported, by default. 

• If you wish to skip points in printouts, use controls in the Print dialog. See the discussion of the Skip 

Points feature as it applies to some graph windows in the Origin Help file. 

• If you wish to apply Speed Mode settings to graphic export, please see this discussion of Performance 

Group controls on the Miscellaneous tab of the Plot Details dialog box or use controls under the Export 

Settings node in the Graph Export dialog. 

• Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for 

a particular graph type, you will have to resave the graph template to make those changes permanent. 

• Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a 

portion of your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately 

represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and 

compare Speed Mode settings to ensure that trends in your data are accurately depicted. 

11.4 Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and 
Printing 

There are a number of ways to present your finished graph. 

• Copy a graph page and paste it in other applications such as Word, Powerpoint, etc. 

• Export the graph page as an image file (raster or vector). 

• Send Graphs to PowerPoint. 

• Printout. 

• Slideshow within Origin. 

• Create Movies. 

http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Misc-Tab
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
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Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading" 
there. 

11.5 Origin Graph Types 

 Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graph 
are plotted from Worksheet data (XYY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or 
from Matrix data. 

 

Origin Graph Samples of most 2D and 3D graph types are included with your Origin 
software. To view graphs, supporting data and guidelines for making the graphs, 
choose Help: Origin Central; or click on the Origin workspace to activate Origin and 
press F11 on your keyboard. 

 
The tables below list all Origin graph types, grouped by Plot menu category: 

 

• The Plot menu icon for each graph type precedes the graph name. 

• The Notes column provides basic information on data requirements. For more specific data 

requirements, click on the graph name beside the Plot menu icon. 

11.5.1 Plot Menu Graphs by Category 

 

Origin 2020 adds a number of new plot types including Sankey Diagrams, Alluvial 
Plots, Kite Diagrams and Doughnut Charts. Additionally, there is an updated and 
more powerful Pie Chart; variations include "Pie of Pie" (portion of a pie is charted as 
a second pie), "Bar of Pie" (portion charted as bar) and "Doughnut of Pie" (portion 
charted as doughnut) and a variable radius Pie ("Pie with Different Radius"). Origin 
2020 also includes an updated and more flexible Dendrogram for plots of multivariate 
data. 

 

You can modify the size of the Plot menu icons using the LabTalk system variable 
@PPS. To find out how to change the value of a system variable, see Customizing 
Origin Using System Variables. 

11.5.1.1 Basic 2D 

 

Graph Types Notes 

http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
http://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
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Scatter 

Scatter Central 

Column Scatter 

Y Error 

XY Error 

Error Band 

Scatter + Rug 

Bubble 

Color Mapped 

Bubble + Color 
Mapped 

• Start with a Worksheet. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

 

"Rug Marks" have been 
turned on in three graph 
templates listed in these 
tables. However, they can 
be added to any number 
of 2D graphs if so desired. 
Double-click on the graph 
axis to open the Axis 
Dialog and look for a 
Rug tab. 

 

Line 

Horizontal Step 

Vertical Step 

Spline 

• Start with a Worksheet. 

• Select one or more Y columns or at least a 

portion of one Y column. 

• Multiple Y columns are grouped in layer. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

Line + Symbol 

Line Series 

Before and After 
Graph 

2 Point Segment 

• Start with a Worksheet. 

• Select one or more Y columns or at least a 

portion of one Y column. 

• Multiple Y columns are grouped in the graph 

layer (except Line Series). 

• For Line Series graph, select 2 or 3 Y 

columns. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

http://www.originlab.com/doc/Origin-Help/2DScatter-Graph
http://www.originlab.com/doc/Origin-Help/2DScatterCentral-Graph
http://www.originlab.com/doc/Origin-Help/column-scatter
http://www.originlab.com/doc/Origin-Help/Y-ErrBar-Graph
http://www.originlab.com/doc/Origin-Help/XY-ErrBar-Graph
http://www.originlab.com/doc/Origin-Help/Error-Band-Graph
http://www.originlab.com/doc/Origin-Help/Scatter-Rug-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Graph
http://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/Origin-Help/Line-Graph
http://www.originlab.com/doc/Origin-Help/HorizontalStep-Graph
http://www.originlab.com/doc/Origin-Help/VerticalStep-Graph
http://www.originlab.com/doc/Origin-Help/Spline-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/Line-Series-Graph
http://www.originlab.com/doc/Origin-Help/Before-After-Graph
http://www.originlab.com/doc/Origin-Help/Before-After-Graph
http://www.originlab.com/doc/Origin-Help/2Point-Seg-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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3 Point Segment 

Spline Connected 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

 

You can hide line 
segments in a Line + 
Symbol graph. Hold down 
the CTRL key and double-
click on the data point 
where you want to break 
your line. With your 
"special point" highlighted 
in the left panel of Plot 
Details, click on the Line 
tab and set Connect to 
No Line. 

 

Column 

Column + Label 

Bar 

Stacked Column 

Stacked Bar 

100% Stacked Column 

100% Stacked Bar 

Floating Column 

Floating Bar 

Vertical Drop Line 

• Start with a Worksheet. 

• For Bar, Column or Column + Label, select 

one or more Y columns (multiple Y columns 

are grouped in layer). 

• For Floating Bar/Column, select two Y 

columns. 

• For Stack graphs, select two or more Y 

columns. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

3D Color Pie Chart 

2D Color Pie Chart 

Doughnut Plot 

• Start with a Worksheet. 

• Select exactly one Y column or a range from 

one Y column. 

• If there is an associated X column, the X data 

are used in the graph legend; otherwise row 

number is used. 

• For specific data requirements, follow links in 

http://www.originlab.com/doc/Origin-Help/3Point-Seg-Graph
http://www.originlab.com/doc/Origin-Help/Spline-Connected-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
http://www.originlab.com/doc/Origin-Help/Column-Graph
http://www.originlab.com/doc/Origin-Help/Column-label-Graph
http://www.originlab.com/doc/Origin-Help/Bar-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Column-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Bar-Graph
http://www.originlab.com/doc/Origin-Help/100-Stack-Column-Graph
http://www.originlab.com/doc/Origin-Help/100-Stack-Bar-Graph
http://www.originlab.com/doc/Origin-Help/Floating-Column-Graph
http://www.originlab.com/doc/Origin-Help/Floating-Bar-Graph
http://www.originlab.com/doc/Origin-Help/Vertical-Drop-Line
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/3D-Color-PieChart
http://www.originlab.com/doc/Origin-Help/2D-Pie-Chart
http://www.originlab.com/doc/Origin-Help/Doughnut-Plot
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Pie of Pie 

Bar of Pie 

Doughnut of Pie 

Doughnut with Total 

Pie with Different 
Radius 

Doughnut with 

Different Radius 

Kite Diagram 

the Graph Types column. 

Density Dots 

Color Dots 

• Start with a Worksheet. 

• Select one Y (Density Dots) or two Y (Color 

Dots) columns. 

• For more information, follow links in the 

Graph Types column. 

Area 

Stacked Area 

100% Stacked Area 

Fill Area 

Fill 2 Colors 

Colormapped Line 
Series 

Stacked Lines by Y 
Offsets 

Row-wise 

• Start with a Worksheet. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

11.5.1.2 Multi-Panel/Axis 

http://www.originlab.com/doc/Origin-Help/Pie-of-Pie
http://www.originlab.com/doc/Origin-Help/Bar-Of-Pie
http://www.originlab.com/doc/Origin-Help/Doughnut-Of-Pie
http://www.originlab.com/doc/Origin-Help/Doughnut-with-Total
http://www.originlab.com/doc/Origin-Help/Pie-with-DiffRadius
http://www.originlab.com/doc/Origin-Help/Pie-with-DiffRadius
http://www.originlab.com/doc/Origin-Help/Doughnut-with-DiffRadius
http://www.originlab.com/doc/Origin-Help/Doughnut-with-DiffRadius
http://www.originlab.com/doc/Origin-Help/Kite-Diagram
http://www.originlab.com/doc/Origin-Help/Density_Dots
http://www.originlab.com/doc/Origin-Help/Color-Dots
http://www.originlab.com/doc/Origin-Help/Area-Graph
http://www.originlab.com/doc/Origin-Help/StackArea-Graph
http://www.originlab.com/doc/Origin-Help/100-StackArea-Graph
http://www.originlab.com/doc/Origin-Help/FillArea-Graph
http://www.originlab.com/doc/Origin-Help/Fill-2-Colors-Graph
http://www.originlab.com/doc/Origin-Help/Colormap-Line-Series
http://www.originlab.com/doc/Origin-Help/Colormap-Line-Series
http://www.originlab.com/doc/Origin-Help/StackLineYOffset-Graph
http://www.originlab.com/doc/Origin-Help/StackLineYOffset-Graph
http://www.originlab.com/doc/Origin-Help/Row-Wise-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Graph Types Notes 

Double-Y Column 
Graph 

Double-Y 

2Ys, Column-
Line&Symbol 

• Start with a Worksheet. 

• Select two Y columns. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

3Ys Y-YY 

3Ys Y-Y-Y 

4Ys Y-YYY 

4Ys YY-YY 

Multiple Y Axes... 

• Start with a Worksheet. 

• Select one Y column for each Y axis. 

• Multiple Y Axes opens interactive dialog. 

Choose plot type, number of axes, plots per 

layer, axis color to match plot, etc. 

• For specific data requirements, follow links in 

the Graph Types column. 

Vertical 2 Panel 

Horizontal 2 Panel 

4 Panel 

9 Panel 

Stack... 

Multiple Panels by 
Label... 

• Start with a Worksheet. 

• Select one Y column (or range) per panel. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

Zoom 

• Start with a Worksheet. 

• Select at least one Y column or a range from 

at least one Y column. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

http://www.originlab.com/doc/Origin-Help/DoubleY-Column-Graph
http://www.originlab.com/doc/Origin-Help/DoubleY-Column-Graph
http://www.originlab.com/doc/Origin-Help/Double-Y-Graph
http://www.originlab.com/doc/Origin-Help/2Ys-Column-LineSym-Graph
http://www.originlab.com/doc/Origin-Help/2Ys-Column-LineSym-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/3Y-Y-YY-Graph
http://www.originlab.com/doc/Origin-Help/3Y-Y-Y-Y-Graph
http://www.originlab.com/doc/Origin-Help/4Y-Y-YYY-Graph
http://www.originlab.com/doc/Origin-Help/4Y-YY-YY-Graph
http://www.originlab.com/doc/Origin-Help/MultiY-Graph
http://www.originlab.com/doc/Origin-Help/Vertical-2-Panel-Graph
http://www.originlab.com/doc/Origin-Help/Horizontal-2-Panel-Graph
http://www.originlab.com/doc/Origin-Help/4Panel-Graph
http://www.originlab.com/doc/Origin-Help/9Panel-Graph
http://www.originlab.com/doc/Origin-Help/Stack-Graph
http://www.originlab.com/doc/Origin-Help/MultiPanel-Graph
http://www.originlab.com/doc/Origin-Help/MultiPanel-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Zoom-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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• For specific data requirements, follow the link 

in the Graph Types column. 

11.5.1.3 Statistical 

 

Graph Types Notes 

Box Chart 

Interval Plot 

Bar Chart 

Box Overlap 

Box Normal 

Half Box 

Bar Overlap 

Bar Normal 

Scatter Interval 

Marginal Box Charts 

• Start with a Worksheet. 

• Select at least one Y column or a range from 

at least one Y column. 

• For specific data requirements, follow the link 

in the Graph Types column. 

 

Origin 2020 box chart 
improvements: 

• Data highlighting 

support. Click on a 

box to highlight 

source data. 

• Offset data points 

and, optionally, 

alternate the offset. 

 

Histogram 

Histogram + Rug 

Histogram + 

Probabilities 

Multi-Panel 
Histograms 

Distribution 

• Start with a Worksheet. 

• Select at least one Y column or a range from 

at least one Y column. 

• For specific data requirements, follow links in 

the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/interval-plot
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/BoxChart-Graph
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/Bar-chart
http://www.originlab.com/doc/Origin-Help/interval-plot
http://www.originlab.com/doc/Origin-Help/Marginal-Boxes-Charts
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/HistogramRug-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Histograms-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Histograms-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
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Distribution + Rug 

Histogram with Labels 

Stacked Histograms 

Population Pyramid 

Marginal Histograms 

Scatter Matrix 

• Start with a Worksheet. 

• Select two Y columns or a range from two Y 

columns. 

• For specific data requirements, follow the link 

in the Graph Types column. 

Violin Plot 

Violin with Box 

Violin with Point 

Violin with Quartile 

Violin with Stick 

Split Plot 

Half Violin 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). 

• Split violin requires exactly 2 data columns, 

plus a third grouping column. 

• For data requirements and other information 

on plot variations, see Violin Plot. 

Probability Plot] 

Q-Q Plot 

• Start with a Worksheet. 

• Select one Y column or a range from one Y 

column. 

• For specific data requirements, follow the link 

in the Graph Types column. 

Pareto Chart - Binned 

• Start with a Worksheet. 

• Select one Y columns or a range from one Y 

http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Histogram-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Histograms-Graph
http://www.originlab.com/doc/Origin-Help/Population-Pyramid-Graph
http://www.originlab.com/doc/Origin-Help/Marginal-Histograms-Graph
http://www.originlab.com/doc/Origin-Help/Scatter-Matrix
http://www.originlab.com/doc/Origin-Help/Violin-Plot
http://www.originlab.com/doc/Origin-Help/Probability-Plot
http://www.originlab.com/doc/Origin-Help/QQ-Plot
http://www.originlab.com/doc/Origin-Help/ParetoChart-BinData
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Data 

Pareto Chart - Raw 

Data 

column (Raw), or a Y column of Binned 

results. 

• For specific data requirements, follow the link 

in the Graph Types column. 

QC (X-bar R) Chart 

• Start with a Worksheet. 

• Select at least one Y column or a range from 

at least one Y column. 

• For specific data requirements, follow the link 

in the Graph Types column. 

Bridge Chart 

Stacked Bridge Chart 

Stacked Total Bridge 
Chart 

Horiz-Bridge Chart 

Double Y Box 

• Start with a Worksheet. 

• Select one or more Y columns (or a range of 

one or more Y columns). If there is an X 

column to the left of the Y column(s), this X 

column is treated as categorical data; 

otherwise, the worksheet's row indices will be 

used. 

• Origin Bridge Charts are variants of one basic 

chart type. For more information, see Bridge 

Charts. 

11.5.1.4 Contour 

 

 

In Origin 2020, when you mouse over Heat Maps and Contour plots, XYZ coordinate 
values display as tooltips. This includes interpolating Z values in Contour plots. 

Graph Types Notes 

Contour - Color Fill 

Contour B/W Lines + 
Labels 

Gray Scale Map 

• Contour Color Fill, B/W Lines + Labels, Gray 

Scale Map, Contour Profiles: XYZ, Virtual 

Matrix, Matrix. 

• Contour - Categorical Z: XYZ, Virtual 

Matrix. 

• For specific data requirements, follow links in 

http://www.originlab.com/doc/Origin-Help/ParetoChart-BinData
http://www.originlab.com/doc/Origin-Help/ParetoChart-RawData
http://www.originlab.com/doc/Origin-Help/ParetoChart-RawData
http://www.originlab.com/doc/Origin-Help/QC-XBarR-Graph
http://www.originlab.com/doc/Origin-Help/DoubleY-Box-Chart
http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/Bridge-Chart
http://www.originlab.com/doc/Origin-Help/Bridge-Chart
http://www.originlab.com/doc/Origin-Help/ColorFill-Contour-Graph
http://www.originlab.com/doc/Origin-Help/BWLinesLabels-Contour-Graph
http://www.originlab.com/doc/Origin-Help/BWLinesLabels-Contour-Graph
http://www.originlab.com/doc/Origin-Help/Contour-GrayScaleMap
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Contour - Categorical 

Z 

the Graph Types column. 

Heatmap 

Heatmap with Labels 

Split Heatmap 

• Heatmap and Heatmap with Labels start with 

a Worksheet (XY, XYZ), Virtual Matrix or 

Matrix. 

• Split Heatmap starts from a Worksheet. 

• For specific data requirements, follow links in 

the Graph Types column. 

Contour Profiles 

Image Profiles 

• Start with a Worksheet, Virtual Matrix or 

Matrix (Image Profiles, Matrix only). 

• For specific data requirements, follow links in 

the Graph Types column. 

Polar Contour 

theta(X), r(Y) 

Polar Contour r(X), 
theta(Y) 

• Start with a Worksheet or Matrix. 

• For data requirements and other information 

on polar contour graphs from worksheet data, 

see Polar Contour from XYZ Data. 

• For data requirements and other information 

on polar contour graphs from matrix data, see 

Polar Contour from Matrix Data. 

Ternary Contour 

• Start with a Worksheet. 

• Columns should be designated as XYZZ. 

• For specific data requirements, follow the link 

in the Graph Types column. 

2D Kernel Density 

• Start with a Worksheet. 

• Select at least one Y column or a range from 

at least one Y column. 

• For specific data requirements, follow the link 

in the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Contour-Categorical
http://www.originlab.com/doc/Origin-Help/Contour-Categorical
http://www.originlab.com/doc/Origin-Help/Heat_map
http://www.originlab.com/doc/Origin-Help/Heatmap-Labels
http://www.originlab.com/doc/Origin-Help/Split-Heatmap
http://www.originlab.com/doc/Origin-Help/Contour-Profile
http://www.originlab.com/doc/Origin-Help/Image-Profile
http://www.originlab.com/doc/Origin-Help/XYZ-Polar-Contour
http://www.originlab.com/doc/Origin-Help/Matrix-Polar-Contour
http://www.originlab.com/doc/Origin-Help/Ternary-Contour
http://www.originlab.com/doc/Origin-Help/2D-Kernel-Density
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Previously, large 2D 
Kernel Density plots could 
take hours to draw. A new 
Density Method Binned 
Approximate 
Estimation method when 
used with an Interpolate 
Density Points check 
box, reduces the time to 
just seconds. 

 

 

You can use a Color List for colormapping. For more information, see Editing Fills on 
the Plot Details Color Map/Contours tab. 

11.5.1.5 Specialized 

 

Graph Types Notes 

Vector XYAM 

Vector XYXY 

• Start with a Worksheet. 

• For XYAM Vector, select three Y columns (or a 

range of the three Y columns). 

• For XYXY Vector, select two X columns and 2 

Y columns (or a range of two X and two Y 

columns). 

• For specific data requirements, follow links in 

the Graph Types column. 

Ternary 

Ternary, Line+Symbol 

Ternary, Line 

Piper 

• Start with a Worksheet. 

• For specific data requirements, follow links in 

the Graph Types column. 

 

You can move axis titles 
to ternary plot vertices by 
setting Rotate (deg.) = 
0 (double-click on the axis 
to open the Axis dialog), 
then dragging the axis 
title into position. 

 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorMapContour-Tab
http://www.originlab.com/doc/Origin-Help/XYAM-Graph
http://www.originlab.com/doc/Origin-Help/XYXY-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Ternary-Graph
http://www.originlab.com/doc/Origin-Help/Piper-Diagram
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Radar 

Line Fill 

Line 

Symbol 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). The X column displays 

as the title of the radial axis around the chart. 

If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• Radar Charts and Spider Charts are created 

from the same basic Origin plot type. 

• For more information, see Spider Charts. 

Polar theta(X) r(Y) 

Polar r(X) theta(Y) 

Bar theta, r 

Bar r, theta 

Line + Symbol theta, r 

Line + Symbol r, theta 

Symbol theta, r 

Symbol r, theta 

Wind Rose - Binned 

Data 

Wind Rose - Raw Data 

• Start with a Worksheet. 

• Select one or more Y columns or a range from 

one or more Y columns. If there is an 

associated X column, X column supplies X 

values; otherwise, Y sampling interval or row 

number is used. 

• For data requirements and other information 

on polar graphs, see Polar Graph. 

 

Several things have been 
added to Windrose plots 
for Origin 2020: 

• Support for uneven 

bin sizes 

• Automatic labeling of 

"Calms" circle in 

center of plot 

• Paddle Spoke Style 

option added 

(Spacing tab of Plot 

Details) 

 

Smith Chart 

• Start with a Worksheet. 

• Select at least one Y column of values (or a 

range from at least one column). If there is 

an associated X column, X column supplies X 

values; otherwise, Y sampling interval or row 

number is used. 

http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/RadarChart-Graph
http://www.originlab.com/doc/Origin-Help/WindRose-Binned-Graph
http://www.originlab.com/doc/Origin-Help/WindRose-Binned-Graph
http://www.originlab.com/doc/Origin-Help/WindRose-Raw-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Polar-Graph
http://www.originlab.com/doc/Origin-Help/SmithChart-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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• For more information, follow the link in the 

Graph Types column. 

High-Low-Close 

Japanese Candlestick 

OHLC Bar Chart 

OHLC-Volume 

Line 

• Start with a Worksheet. 

• For specific data requirements, follow links in 

the Graph Types column. 

11.5.1.6 Categorical 

 

Graph Types Notes 

Grouped Scatter - 
Indexed Data 

• Start with a Worksheet. 

• Select at least one Y column as input data. 

• One or more column(s) of categorical data 

provide grouping information. 

• For more information, see the link in the 

Graph Types column. 

Color Mapped 

Bubble + Color 

Mapped 

• Start with a Worksheet. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• For specific data requirements, follow links in 

the Graph Types column. 

Grouped Columns - 
Indexed Data 

• Start with a Worksheet. 

• If there is an associated X column, X column 

supplies X values; otherwise, Y sampling 

interval or row number is used. 

• An additional column supplies the Group 

http://www.originlab.com/doc/Origin-Help/High-Low-Close-Graph
http://www.originlab.com/doc/Origin-Help/Japanese-Candlestick
http://www.originlab.com/doc/Origin-Help/OHLC-Bar-Chart
http://www.originlab.com/doc/Origin-Help/OHLC-Volume
http://www.originlab.com/doc/Origin-Help/Stock_Line
http://www.originlab.com/doc/Origin-Help/GroupedScatter-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedScatter-IndexedData
http://www.originlab.com/doc/Origin-Help/Color-Mapped-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/Bubble-Color-Map-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/Origin-Help/grouped-column-index-data
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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information. 

Grouped Box Charts - 
Indexed Data 

Grouped Box Charts - 

Raw Data 

Grouped Column 
Scatter - Indexed Data 

Grouped Interval Plot 
- Indexed Data 

Grouped Mean Bar - 

Indexed Data 

Grouped Violin - 
Indexed Data 

Grouped Half Violin - 

Indexed Data 

Grouped Half Box - 
Indexed Data 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column), plus a second column 

with grouping information. If there is an 

associated X column, X column supplies X 

values; otherwise, Y sampling interval or row 

number is used. 

• Plots of Indexed Data are all style variations 

of the Grouped Box. 

• For more information, follow the links in the 

Graph Types column. 

Trellis Plot 

• Start with a Worksheet. 

• Select at least one Y column as input data. 

Optionally, you can have an additional 

associated Y error column for each Y column. 

Other column(s) generally contain grouping 

information. 

• For more information, see the link in the 

Graph Types column. 

 

You can now add rug 
marks to the panels of a 
trellis plot. Double-click 
on the bottom axis to 
open the Y Axis dialog 
box, then click on the 
Rug tab. 

 

http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-IndexedData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
http://www.originlab.com/doc/Origin-Help/GroupedBoxCharts-RawData
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/trellis
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Double Y Trellis Plot 

• Start with a Worksheet. 

• Select two Y columns as input data. 

Optionally, you can have an additional 

associated Y error column for each Y column. 

Other column(s) generally contain grouping 

information. 

• For more information, see the link in the 

Graph Types column. 

Cluster Plot 

• Start with a Worksheet. 

• You need at least two Y columns, one of which 

should contain grouping information. 

• Grouping columns can be used to create 

separate panels in the horizontal and/or 

vertical directions and/or to modify plotted 

points (color, scatter point size, scatter point 

shape, etc.). 

Parallel Plot 

Parallel Sets 

Parallel Index 

• Start with a Worksheet. 

• Select at least one (ideally, two or more) 

column(s) or a range from one or more 

columns. Column designation does not 

matter. Each column will be treated as data 

on a single variable. 

• Variables may be numeric (Parallel Plot or 

Parallel Index) or they may be categorical 

(Parallel Sets). 

• Parallel Sets plots have a "curvature" option 

that is sometimes seen in plots termed 

"Alluvial Plots". 

• For more information, follow links in the 

Graph Types column. 

Sankey Diagrams 

Alluvial Diagrams 

• Start with a Worksheet. 

• For Sankey Diagrams, select exactly two 

columns of categorical data + 1 column of 

numeric data. Column designation is ignored 

• For Alluvial Diagrams, select two or more 

columns of categorical data. Column 

http://www.originlab.com/doc/Origin-Help/Trellis-Double-Y
http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/Parallel-Plot
http://www.originlab.com/doc/Origin-Help/Parallel-Sets
http://www.originlab.com/doc/Origin-Help/Parallel-Index
http://www.originlab.com/doc/Origin-Help/Sankey-Diagram
http://www.originlab.com/doc/Origin-Help/Alluvial-Diagram
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designation is ignored. 

• For more information, follow links in the 

Graph Types column. 

11.5.1.7 3D 

 

Graph Types Notes 

3D Scatter 

3D Scatter + Error Bar 

3D Line 

3D Trajectory 

• Data requirements vary by plot type. See 

links in the Graph Types column. 

 

The 3D Scatter + Error 
bar graph will take data 
columns designated as 
XYZZ and plot the second 
Z column as error bars in 
the Z direction. 

 

3D Vector XYZ XYZ 

3D Vector XYZ dXdYdZ 

• Start with a Worksheet. 

• Select 6 worksheet columns, designated as 

XYZ XYZ. 

• For more information, see links in the Graph 

Types column. 

3D Bar Graph 

3D Stacked Bars 
Graph 

3D 100% Stacked Bar 
Graph 

• Start with a Worksheet (XYZ) or a Virtual 

Matrix or Matrix of Z values. 

• For specific data requirements, follow links in 

the Graph Types column. 

Color Fill Surface 

X Constant with Base 

Surface 

Y Constant with Base 

• Start with a Worksheet or Matrix. 

• For specific data requirements, follow links in 

the Graph Types column. 

http://www.originlab.com/doc/Origin-Help/Mat-3DScatter
http://www.originlab.com/doc/Origin-Help/3D-ErrBars
http://www.originlab.com/doc/Origin-Help/3DLine
http://www.originlab.com/doc/Origin-Help/Trajectory-Graph
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-XYZ
http://www.originlab.com/doc/Origin-Help/3DVector-XYZ-dXdYdZ
http://www.originlab.com/doc/Origin-Help/3D-Bars
http://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/3D-100PC-Stacked-Bars
http://www.originlab.com/doc/Origin-Help/Color-Fill-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/X-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
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Surface 

Color Map Surface 

Color Map Surface 
with Projection 

Wire Frame 

Wire Surface 

3D Ternary Colormap 

Surface 

3D Ternary Symbol 

• Start with a Worksheet. 

• Select two Z columns (XYZZ) or a range of 

data from two Z columns (Z columns may be 

multiples of 2). 

• For more information, follow links in the 

Graph Types column. 

3D Tetrahedral 

• Start with a Worksheet. 

• Select two Z columns (XYZZ) or a range of 

data from two Z columns (Z columns may be 

multiples of 2). 

• For more information, follow links in the 

Graph Types column. 

Waterfall 

Waterfall: Y Color 
Mapping 

Waterfall: Z Color 

Mapping 

3D Waterfall 

3D Waterfall: Y Color 

Mapping 

3D Waterfall: Z Color 
Mapping 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). Ideally, select at least 

two Y columns (or a range of at least two Y 

columns). If there is an associated X column, 

X column supplies X values; otherwise, Y 

sampling interval or row number is used. 

• For more information, see the links in the 

Graph Types column. 

 

You can add labels at 
specified indices for 
Waterfall graphs (all 
types). To add labels, 
activate the graph and 
from the menu, choose 
Format: Plot. In Plot 

http://www.originlab.com/doc/Origin-Help/Y-Const-Base-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Color-Map-Surface-Projection
http://www.originlab.com/doc/Origin-Help/Wire-Frame
http://www.originlab.com/doc/Origin-Help/Wire-Surface
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-colormap
http://www.originlab.com/doc/Origin-Help/3d-ternary-symbol
http://www.originlab.com/doc/Origin-Help/3d-Tetrahedral
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Graph
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Y-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/2DWaterfall-Z-ColMap
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-Graph
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-YColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/3D-Waterfall-ZColor-Mapping
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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Details, click on the Label 
tab and check Enable, 
Show at Specified 
Indices Only and provide 
a space-separated list of 
index numbers; or choose 
a dataset with index 
numbers from the drop-
down. 

 

XYY 3D Bars 

XYY 3D Stacked Bars 

XYY 3D 100% Stacked 

Bars 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). Ideally, select at least 

two Y columns (or a range of at least two Y 

columns). If there is an associated X column, 

X column supplies X values; otherwise, Y 

sampling interval or row number is used. 

• For more information, see the links in the 

Graph Types column. 

3D Ribbons 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). Ideally, select at least 

two Y columns (or a range of at least two Y 

columns). If there is an associated X column, 

X column supplies X values; otherwise, Y 

sampling interval or row number is used. 

• For more information, see the link in the 

Graph Types column. 

3D Wall Graph 

3D Stacked Wall 

Graph 

3D 100% Stacked 
Wall Graph 

• Start with a Worksheet. 

• Select at least one Y column (or a range from 

at least one Y column). Ideally, select at least 

two Y columns (or a range of at least two Y 

columns). If there is an associated X column, 

X column supplies X values; otherwise, Y 

sampling interval or row number is used. 

• For more information, see the link in the 

Graph Types column. 

 
For an overview of Origin's 3D graph types and their source data requirements, see these topics: 

http://www.originlab.com/doc/Origin-Help/3DBar-Graph
http://www.originlab.com/doc/Origin-Help/3DStackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/3D100PC_StackBar-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Ribbon-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
http://www.originlab.com/doc/Origin-Help/Wall-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/100-Stacked-Wall-Graph
http://www.originlab.com/doc/Origin-Help/WksCol-SampleInterval
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• Creating 3D Graphs 

• 3D and Contour Graphing 

• Creating Contour Graphs 

• Creating 3D and Contour Graphs from Virtual Matrix 

11.5.1.8 Function Plot 

Graph Types Notes 

New 2D Plot 

New 2D Parametric 

Plot 

• Function plots are not created from physical 

data. 

• Once a function plot is created, you can 

obtain the derived dataset. 

• For more information on function plots, follow 

links in the Graph Types column. 

New 3D Plot 

New 3D Parametric 
Plot 

• Function plots are not created from physical 

data. 

• When a 3D Function is plotted, a matrix of Z 

values is simultaneously generated. 

• For more information on function plots, follow 

links in the Graph Types column. 

11.5.1.9 My Templates 

 

Dialog Box Notes 

My Templates 

• This Category lists and gives direct access to 

the custom templates in your User Files 

Folder. 

11.5.1.10 Other Graphing Tools 

 

App Notes 

http://www.originlab.com/doc/Origin-Help/Create-3D-Graph
http://www.originlab.com/doc/Origin-Help/3D-Contour-Graphing
http://www.originlab.com/doc/Origin-Help/Create-Contour-Graph
http://www.originlab.com/doc/Origin-Help/Plot-3D-Contour-VirtMat
http://www.originlab.com/doc/Origin-Help/PD-Dialog-2DFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-2DParaFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-2DParaFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-3DFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-3DParaFunc-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-3DParaFunc-Tab
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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Graph Maker App 

• The Graph Maker app is pre-installed in your 

Origin software. 

• Launch the App from the Plot menu or from 

the Graph Maker app icon in the Apps Gallery 

to the right side of your Origin workspace. 

• Use the Graph Maker app with Preview pane, 

to interactively plot grouped data. 

• Choose from line, scatter, line+symbol, 

column, box and histogram chart types. 

• Supports fitting for scatter plots. 

• Drag-and-drop worksheet columns to set up 

the graph. 

• Graph settings are saved and can be re-

loaded. 

Template Library 

• Use this dialog to organize your custom 

graphing templates. 

11.6 Topics for Further Reading 

• The Page-Layer-Plot Hierarchy 

• Page Viewing Modes 

• Graph Axes 

• Creating Graphs from Graph Templates 

• Creating Multi Layered Graphs 

• Adding Data Plots to the Graph Layer 

• The Layer Contents Dialog Box 

• The Object Manager 

• Graph Layers 

• Linking Layers 

• 3D and Contour Graphing 

• Plotting Mathematical Functions 

• Appendix 2 - Complete Listing of Origin Graph Types 

https://www.originlab.com/FileExchange/Details.aspx?fid=445
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/Page-Layer-Plot-Hierarchy
http://www.originlab.com/doc/Origin-Help/Compare-PageView-Modes
http://www.originlab.com/doc/Origin-Help/GraphAxes
http://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
http://www.originlab.com/doc/Origin-Help/MultiLayer-Graph
http://www.originlab.com/doc/Origin-Help/DataPlot-Manage
http://www.originlab.com/doc/Origin-Help/LayerN-Dialog
http://www.originlab.com/doc/Origin-Help/Object-Manager
http://www.originlab.com/doc/Origin-Help/Legend-ColorScale
http://www.originlab.com/doc/Origin-Help/Link-Layers
http://www.originlab.com/doc/Origin-Help/3D-Contour-Graphing
http://www.originlab.com/doc/Origin-Help/FuncPlot
http://www.originlab.com/doc/Origin-Help/GraphTypes
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12 Customizing Graphs 

  

 

12.1 Introduction 

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph 
template. If the graph you are making is fairly standard for its type, the options that were stored in the graph 
template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation 
was covered in the last chapter, Graphing. 

Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors. 
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and 
techniques, as well as to point you toward resources that will help you manage more complex graph 
customization tasks. 

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are 
commonly used for quick modifications of graph elements. 

12.2 Mini Toolbars 

http://www.originlab.com/doc/User-Guide/Graphing
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Origin 2020 adds context-sensitive popup tools for quick editing of commonly-
modified graph properties. 

Most 2D and Contour plots now support a set of "quick editing" tools for interactively modifying common graph 
properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, 
(2) what the selected plot type or object is and (3) whether you have selected an individual plot or a plot 
group -- you will have a different set of tools available to edit your selection. 

 

• There are five levels -- i.e. five groupings of graph properties -- that can be edited with mini toolbars: 

page, layer, plot, text or drawn objects and graph axes. 

• When editing grouped plots, a single click will select a single plot. The mini toolbar displays two tabs -- 

one for the customizing the group, the other for customizing the single plot. 

 

• Most mini toolbars have a "properties" button that opens a related Origin dialog box where you will 

find the full range of available controls. 

12.3 Toolbars 

Toolbar buttons useful for graph-customization tasks: 
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Description 
Toolbar 

(default configuration) 

Format toolbar buttons: 
 

• Creating and 

customizing text 

objects. 

 

Style toolbar buttons: 
 

• Editing colors, line 

thickness, fill 

patterns. 

 

Tools toolbar buttons: 
 

• Add text objects, 

lines, arrows, 

rectangles/circles/

polygons. 

 

Graph toolbar buttons: 
 

• Add graph layers 

incl. inset graphs, 

merging or 

extracting 

graphs; 

exchanging axes; 

anti-aliasing and 

Speed Mode. 

 

Add Object to Graph 
toolbar buttons: 
 

 

http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
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• Add legends/color 

scales/bubble 

scales; date & 

time and project 

path stamps; XY 

scale; table 

objects. 

Object Edit toolbar 
buttons: 
 

• Arranging and 

aligning objects 

and layers on the 

page. 

 

12.4 Menus, Dialogs and Buttons Used in Graph Customization 

Many graph customizations are initiated via commands on the Format or Graph menus. The following table 
lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs. 

Task Dialog Name Method 

Customize the 
graph Page, Layer, 
or Data Plot 

Plot Details dialog 

• Double-click on Page, Layer or Data Plot 

• Format: Page... menu 

• Format: Layer... menu 

• Format: Plot... menu 

See, Customizing Page, Layer and Data Plots 

Customize Axes Axis Dialog  

• Double-click on axes or tick labels 

• Format: Axes... menu 

• Format: Axis Tick Labels... menu 

• Format: Axis Titles... menu 

See, Customizing Graph Axes 

Add a Default 
Legend (most 
2D graphs) 

N/A • Click the Reconstruct Legend (CTRL+L)  

button on the Add Object to Graph toolbar 

http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
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• Right-click on the legend object and choose 

Legend: Reconstruct Legend 

• Choose Graph: Reconstruct Legend from the 

main menu 

See, Graph Legends 

Customize the 
Legend  

(Text Object -) 
Legend dialog 

• Ctrl + double-click on the legend object text 

See, The (Text Object Properties) Text tab 

Update Legend 
dialog 

• Right-click legend and choose Legend: 

Update Legend or choose Graph: Legend: 

Update Legend... 

See, The legendupdate Dialog Box 

Legends/Titles 
tab at Page level of 
Plot Details dialog 

• Double-click in the white area just inside graph 

window frame (but outside of the data plot), 

then click on the Legends/Titles tab 

• Choose Format: Page and click on the 

Legends/Titles tab 

See, The (Plot Details) Legends/Titles tab 

Add a Color Scale 
(color-mapped 
plots) 

N/A 

• Click the Add Color Scale  button on the 

Add Object to Graph toolbar 

See, Color Scales 

 

Color Scale enhancements 
for Origin 2020: 

• Control scale range 

from Color Scale 

Control dialog 

• Support formula for 

tick labels in color 

scale object 

• Min- and max-only 

labels at inside or 

http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/Origin-Help/TextOb-Prop-Text-tab
http://www.originlab.com/doc/Origin-Help/legendupdate-dlg
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
http://www.originlab.com/doc/Origin-Help/ColorScale
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outside ends of scale 

 

Add a Bubble Scale 
(symbol-size 
mapped plots) 

N/A 

• Click the Add Bubble Scale  button on the 

Add Object to Graph toolbar 

See Bubble Scale 

Merge multiple 
graph windows into 
one graph window 

Merge Graphs 
dialog 

• Graph: Merge Graph Windows... menu 

See, Merge and Arrange Graphs (tutorial) and The 
Merge Graph Dialog Box. 

Layer level 
customizations: 
resize, move, swap, 
align, or add layers 

Layer 
Management 
dialog 

• Graph: Layer Management... menu 

See, Layer Management-Quick Start 

Save settings as 
graph template 

Save Template As 

dialog 

• File: Save Template As... menu 

• Right-click graph window title and choose Save 

Template As... 

See, Graph Template Basics 

Manage graph 
templates, add plots 
to a template 

Template Library 
(custom graph 
templates) 

• Plot > My Templates: menu (worksheet is 

active) 

See, The Graph Template Library 

 

A Switch List Mode 
button is added to 
Template Library in Origin 
2020 so that you can 
toggle between preview 
and list view. 

 

System 
Templates 
(built-in graph 
templates) 

• File: New: From Template menu then click 

the Graph radio button and set Path = Origin 

Program Folder 

See, System Templates 

http://www.originlab.com/doc/Origin-Help/BubbleScale
http://www.originlab.com/doc/Tutorials/GSB-Merge-Arrange-graphs
http://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
http://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
http://www.originlab.com/doc/Origin-Help/Layer-Management-Quick-Start
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/System-Templates
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Save settings as 
graph Theme 

Save Format as 

Theme dialog 

• Right-click and choose Save Format as 

Theme... context menu (graph is active) 

See, Saving Formats to a Theme 

Manage Graph 
Themes: edit, 
combine, apply 
Theme, set as 
System Theme 

Theme Organizer 
dialog 

• Preferences: Theme Organizer.. > Graph 

tab. 

• F7 hotkey. 

See, Theme Organizer 

12.5 Customizing Page, Layer and Data Plots 

 A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are 
editable properties at the page, layer and data plot levels. 

Quick formatting of some graph properties can be done using toolbar buttons, as mentioned above. However, 
the vast majority of properties are customized via Origin's Plot Details dialog box. To open Plot Details, (1) 
double-click on your plot or (2) click the Format menu, then choose Page..., Layer... or Plot.... 

The figure below shows an example of the Plot Details dialog box: 

• The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree. 

• The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in 

the left panel. 

• To customize an object, select it in left panel and modify the corresponding properties that appear on 

the various tabs in the right panel.  

http://www.originlab.com/doc/Origin-Help/ThemeRef-SaveFormat
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer


UserGuide 

170 

 

Selected Left 
Panel Object 

Right Panel, Controls for... 

Page 
Settings that pertain to the whole page -- Print/Dimensions, layer drawing orders, page 
display color, legends/titles, etc. 

Layer 
Settings that are specific to the graph layer -- Layer background colors, layer size and 
speed mode settings, layer display settings, stack settings for applicable plot types. Some 
plot types will include extra tabs/controls specific to the plot type. 

Plot 
Plot specific properties. The tabs and controls vary by plot type (e.g. Scatter plots have a 
Symbol tab with controls pertaining to scatter symbols, Line plots a Line tab with controls 
pertaining to line plots). 

Data Point 
Properties that apply to user-specified "special points". Available for some plot types. The 
tabs and controls are generally similar to those available at the Plot level. 

http://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
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You can UNDO customizations made in the Plot Details dialog box. Click OK to close 
Plot Details and choose Edit: Undo Modify Page or press CTRL + Z. 

 
:

  

 

Prevent text and label objects from scaling when resizing layer, by going to the Size 
tab of Plot Details (Layer level) and setting Fixed Factor to 1. 

 

There is a Layers tab at the Page Level in Plot Details. You can use these controls to apply 
customizations made to a graph layer and contained plots, to other layers and plots in the 
graph page. This feature is particularly useful for modifying stack or panel graphs. 
Previously, for instance, if you wanted to customize a 9-panel graph you had to customize 
each panel individually. Now, you can apply multiple customizations to all plots, 
simultaneously. For more information, see The (Plot Details) Layer Tab. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
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12.5.1 Customizing Grouped Plots 

 

 

For Origin 2020, there is a change in selection behavior that affects grouped plots. 
Now, a single-click on a plot selects the plot. A second click (or CTRL+click) selects a 

single point. SHIFT+click selects the entire group. Note that when using the new mini 
toolbars, a single click on a plot group displays tools for editing the plot group or the 
single, selected plot. To revert to the old plot selection behavior, set @GSM=0. 

 

When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer. 
Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or 
more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.). 

By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the 
"Candy" color list and each successive plot is assigned the next color in the list) and some will be configured 
not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any 
case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so 
that you can easily use them later to create graphs with the same look. 

  

http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorList-Tab
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The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this 
Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol 

Interior. Properties of Line Color, Symbol Type and Symbol Edge Color are set to increment By One and 
Between Subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol 
Interior are set to increment by None (they do not vary). 

As previously mentioned, this arrangement is completely customizable and you can save customizations with 
the graph template: 

• To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab 

Controls. 

• To find out more about saving graphs as templates, see Graph Template Basics. 

12.5.1.1 Using Object Manager with Grouped Plots 

• To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in 

Object Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph 

window, while dimming others. 

 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Group-Tab
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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• To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object 

Manager) and choose Move Up or Move Down. 

 

• To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To 

group plots in the layer, right-click on a plot and choose Set as Group Begin. 

 

• To move a plot from one group to another, drag the plot to the other group. 

• To move a series of plots out of the group, right-click the last plot that you want to keep in the group and 

choose Set as Group End. 

• To remove a plot from the layer (and the graph), right-click on the plot and choose Remove. 

• To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object 

Manager and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer .... 

12.5.2 Customizing Multi-layer Graphs 

The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin 
graphs (e.g. a graph with both left and right Y axes is constructed by overlaying one layer on another, and 
sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-contained 
unit it is, at times, desirable to create dependencies between layers: 

• One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships 

or relationships between axis scale values. You can read more about linking graph layers, below. 

http://www.originlab.com/doc/Quick-Help/Graph-Layer-Defination
http://www.originlab.com/doc/Quick-Help/Graph-Layer-Defination
http://www.originlab.com/doc/User-Guide/Customizing-Graphs


Customizing Graphs 

175 

• Another type of dependency is based on what we call "common display" and this is most useful in a 

situation where we have multiple similar panels in a graph and we want to do something like change the 

background color of each graph, or perhaps the change plot colors used in each layer. 

 
At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within 
a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot 
and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis 
plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely 
different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously 
add a background color to both layers. We could have accomplished the same thing without using the Common 
Display controls but this would have required twice the work -- set the background color of layer 1, then set 
the background color of layer 2. 

 

This was a simple illustration but we can use the Common Display controls for application of more complex mix 
of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display 
elements turned on by default. When working with multi-panel graphs, you may want to choose Format: 
Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display 
for more information. 

 

The Common Display Apply to control supports including or excluding certain layers 
from common display customizations. For instance, you might have a 4 panel graph, 
each with an inset layer and using this control, you could apply a common background 
color to the inset layers without applying the same background color to the 4 primary 
layers (panels). See Common Display for more information. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
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12.5.3 Customizing Individual Data Points 

 For some plot types such as scatter, column or pie, you can modify the display properties of a single data 
point. 

To edit a single point: 

1. Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit 

properties of the data point; or click available buttons on the Style or Format toolbars. 

2. For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL + 

double-click on unselected data point. Either will open the Plot Details dialog box with the focus set to edit 

the data point (identified in the left-panel of Plot Details by its row index number). Then use controls on 

the tabs in the right panel to modify the appearance of the data point. Changes you make to the special 

point will not affect the appearance of other points in the same plot. 

 

 
Note:, when the Custom Construction box is checked, you can use these controls to customize the plot 
symbol of the selected point. 

 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Sym-Tab
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To remove customizations made to a single data point: 

• Right-click the single point in the left panel of the Plot Details dialog and choose Delete. 

• In the graph window, click on the single point to select it, then press DELETE on the keyboard. 

The point itself is not deleted; only the custom styling is removed and the point reverts to the style of the 
containing data plot. 

12.6 Customizing Graph Axes 

  Many common edits to axis properties can be done quickly from Mini Toolbar buttons. For more complex 
edits of axis properties, use controls in the Axis Dialog. 

12.6.1 Customizing Axes with Mini Toolbars 

For quick and simple adjustments to axes properties, you can use Origin's graph-editing Mini Toolbars. As with 
all Mini Toolbars, available tools will vary by plot type and selected object. 

This image shows buttons available for editing of a selected graph axis in a contour plot. 

 

Note that for graph axes, clicking the settings button (the "gear") produces a popup menu with simplified 
dialogs for Grid Lines, Reference Lines, Special Ticks and Axis Breaks. For full access to axis controls, 
click on Axes Dialog. 

12.6.2 Customizing Axes with the Axis Dialog Box 

All graph axis customizations can be made in the Axis Dialog box. Double-click on the graph axis or tick 
labels to open the Axis Dialog - Layer N dialog box. 

 

Rug Plots are a one-dimensional density plot. You can add "rug marks" to the graph 
axes of many 2D graphs by double-click on the graph axis, clicking the on the Rug tab 
and checking the Show box. 
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This image shows the tab-based axis dialog used by most 2D and 3D graphs. 

 

In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the 
axis or axes to be customized, then select the desired tab and choose your options. 

Tab Controls for 

Scale 
Scale range of values, scale type, rescale mode and margin, reverse scale, major and 
minor ticks. 
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Tick Labels 

Display and Format options for major and minor tick labels, including custom labeling using 
LabTalk substitution or mathematical expression. For information on custom formatting of 
numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon) 
formats, see Origin Custom Formats. 

Title 
Axis title (often set using variable notation) and font options. Note that you can directly edit 
by double-clicking the text object in the graph. 

Grids Control display and properties of grid lines at major and minor ticks. 

Line and 
Ticks 

Global axis line and tick display options for all axes. 

Special 
Ticks 

Placement of special tick labels. 

Reference 
Lines 

Display of reference lines (key statistics) and "recession bars" (shaded areas with 
transparency), that can be overlaid on the data plot(s). 

Breaks Enable line breaks and configure each break. 

 

Click the Apply To... button to apply the axis format settings of the currently selected 
axis to another axis. 

Note: For more information on axis customization and for axis controls for specialized graph types (e.g. 

polar, ternary, radar chart.etc), refer to:  

Help: Origin: Origin Help > Graphing > Graph Axes 

12.7 Graph Legends 

12.7.1 How the Default Legend is Created 

   A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the 
default legend combines (A) plot style information stored with the graph template, with (B) dataset 
information stored in the worksheet column label rows, and places the resulting legend object on the 
graph page. 

http://www.originlab.com/doc/LabTalk/ref/Origin-Formats
http://www.originlab.com/doc/Origin-Help/GraphAxes
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Note that the default legend object is not created with literal text and plot symbols but instead is created from 
LabTalk script. 

• This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that 

the legend can be updated when data or plot metadata change. 

• Because construction of the legend object relies on scripting rather than literal information, you can save 

customizations to a graph template and recreate the graph with its accompanying legend object using new 

data, as often as is needed. 

 
The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You 
can see this notation when you double-click inside of the legend object (as if to edit it). 

 

You control which dataset metadata are used in constructing the default legend text by setting the the 
Translation mode of %(1), %(2) list in the Legends/Titles tab of the Plot Details dialog box (Format: 
Page...). Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the 
graph template for repeat use. 

 

Origin 2019 added support for wrapping of legend text. To make use of this, open the 
Plot Details Legends/Titles tab, set Translation mode of %(1), %(2) to Custom, 
then enter your custom legend notation with the characters %(CRLF) at the point 
where you want text to wrap. 

 

Origin 2020 adds two new legend customization options: 

• An Align Columns checkbox in object Properties for easier alignment of legend 

symbols and text. 

• An arrow customization option for adding emphasis to legend entries. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
http://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
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12.7.2 Tips for Quick Legend Edits 

• Select the legend object, then right-click and choose Legend to open a shortcut menu with some useful 

commands including Text Color Follows Plot, Reverse Order, and Show Legend for Visible Plots 

Only (the same menu commands are available from Graph: Legend). 

• The same shortcut menu also has an Arrange in Vertical/Horizontal command for changing the legend 

aspect; or you can modify it interactively by selecting the legend object, then pressing CTRL while 

dragging a selection handle (e.g. drag horizontally to create a legend that is all on one line). 

• Double-click on the legend text to enter in-place edit mode (where you can manually overwrite the legend 

text). 

• CTRL + double-click the legend text to open the Legend dialog box. Here you can modify all aspects of 

the legend. 

• Double-click a legend symbol to open the Plot Details dialog box. 

• If you do not want a legend object added to your graph each time you create the graph, delete the legend 

object and re-save the graph template. 

12.7.3 Adding and Updating the Default Legend 

The table below lists tasks associated with adding or updating the graph legend, and where to find editing 
controls for each legend type. Before proceeding, we should point out that there are two legend refresh 
modes: 

• Updating a legend will preserve any customizations that you might have made to the existing legend, 

including size and position adjustments and legend symbol and text customizations. 

• Reconstructing a legend will overwrite any customizations. When you add or reconstruct the legend, you 

are creating a copy of the legend that is stored in the graph template. 

 
In addition, the graph template stores a Legend Update Mode setting that determines how the legend is 
refreshed when adding or removing data plots from the graph. See Controlling Legend Update, below. 

  

Task Method (graph is active) 

Add or 
reconstruct 
legend 

• Graph: Legend: Reconstruct Legend menu. 

• Reconstruct Legend button  (Add Object to Graph toolbar). 

• CTRL+L. 

 

Legend customizations not saved with the template, 
will be lost when you reconstruct. 

 

http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
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Update legend 

Open the legendupdate dialog box:  

• Graph: Legend: Update Legend menu. 

• Right-click on legend and select Legend: Update Legend. 

 
Note: "Updating" a legend does not overwrite legend customizations. 

Customizing 
special legends 

Right-clicking on these special legends opens a dialog box with customization options 
specific to each legend type:  

• Categorical legends. 

• Box chart legends. 

• Point-by-point legends. 

Add color scale  

Only available for color-mapped plots (e.g Contour Plots).  

• Click the Add Color Scale button  (Add Object to Graph toolbar). 

• Right-click in the layer and select New Color Scale. 

• Insert: Color Scale menu. 

• When you have multiple color-mapped plots in a single graph window, you 

can click on each plot to select it, then add a corresponding color scale. 

Control color 
scale 

Available when a color scale object has been added to a graph. To open the Color 
Scale Control dialog:  

• Double-click on the color scale object. 

• Right-click on the color scale object and choose Properties. 

Add bubble scale 

Available for bubble plot, or when symbol size is controlled by a dataset.  

• Select Insert: Bubble Scale. 

• Right-click in the layer and select New Bubble Scale. 

• Click the Add Bubble Scale button in the Add Object to Graph 

toolbar. 

• Right-click the legend to select Add Bubble Scale from the context menu. 

http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/pts-pts-legend
http://www.originlab.com/doc/Origin-Help/box-legend
http://www.originlab.com/doc/Origin-Help/PlotColor-DatasetControl
http://www.originlab.com/doc/Origin-Help/PlotAttribute-DatasetControl
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Control bubble 
scale 

Available when bubble scale object has been added to a graph. To open the 
Bubble Scale Control dialog: 

• Double click on the bubble scale object. 

• Right-click on the bubble scale object and choose Properties. 

 

The legendupdate dialog box and the Legend/Titles tab at page level of Plot 
Details both have an Auto Legend Translation Mode drop-down that determines 

which worksheet metadata (e.g. column Long Name, Comments, etc.) is used to 
generate the legend text. For a list of Custom options, see Legend Substitution 
Notation. 

 

Origin 2018 added an interface tool to manually Add Legend Symbols to the graph 
legend. Right-click on the legend object and choose Properties. Click the Add Legend 
Symbol button in the lower-right corner of the dialog box. 

 

Note: For more information on creating and customizing graph legends, see:  

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales 

12.7.4 Controlling Legend Update 

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The 
Legend/Titles tab at the graph page level in the Plot Details provides a Legend Update Mode drop-down 
to control this behavior. 

The default setting Update when Adding only affects the legend display of data plots that are added or 
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be 
maintained. 

 

Tutorial: Customize legend and add data plots 

1. Start with a new project in Origin. 

2. Open Windows Explorer and navigate to the subfolder <Origin EXE 

folder>\Samples\Import and Export\ 

3. Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and 

then drag-and-drop the files onto an empty Origin workbook. The three files will be 

imported into three separate workbooks. 

4. Click on one of the workbooks, select the column B, and create a line plot. 

http://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
http://www.originlab.com/doc/LabTalk/ref/Legend-Substitution-Notation
http://www.originlab.com/doc/Origin-Help/Legend-ColorScale
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab
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5. Right-click on the legend and select Legend: Update Legend... to open the 

legendupdate dialog. 

6. Change the Auto Legend Translation Mode drop-down to Custom, and in the 

edit box that appears below, enter the string: 

@WS, @LD3 

and then press OK to close the dialog box. The legend updates, displaying the 

sheet name and the third user parameter. 

7. Click on the second workbook, select column B, move the mouse over the right-

edge of the column until it changes to , and then drag-and-drop this data 

onto the graph to create a 2nd data plot. 

8. Repeat the procedure with column B from the third workbook. The graph will now 

display three data plots, and the legend will automatically update to display the 

identifier for all three plots. 

9. Click on each individual curve and use the Style toolbar to set a different line color 

for each. The legend will automatically update and display the new line color. 

 

12.7.5 Special Legend Types 

As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can 
be customized and updated similarly to the Data Plot legend used by most 2D graph types. 

Legend Type Menu to Create Used in situations where ... 
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Legend for 
Categorical Values 

Graph:Legend:Categorical 
Values 

At least one plot attribute (e.g. color, 
symbol shape.etc) is controlled by data 
indexing. 
 
See the Legend for Categorical Values 
help page. 

Point by Point 
Legend 

Graph:Legend:Point by Point 

The plot symbol style is controlled by data 
indexing, an increment list, or color 
mapping. 
 
See the Point by Point Legend help page. 

Legend for Box 
Chart Components 

Graph:Legend:Box Chart 
Components 

The graph is a box chart, or a grouped 
box chart. 
 
See the Legend for Box Chart 
Components help page. 

12.8 Annotating Your Graph 

 When we speak of "annotating" a graph, we are talking about adding text or drawing objects to the graph. 
Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to 
draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph 
creation, etc. 

Annotating a graph can be as simple as adding a static text object and formatting it with Format toolbar 
buttons. Or you might add a more complex object that is dynamically linked to a variable value or to some 
LabTalk script that is executed whenever some user-specified event occurs. 

The following table lists some common graph annotation tasks and available tools for accomplishing those 
tasks. 

 

Origin 2018 added Unicode (UTF-8) support. 

Task Method 

Label Data Points and 
Plots 

• Choose Format: Plot ..., then click the Label tab and select Enable 

(not available for all plot types). 

• To label individual data points using a customizable label, see 

"Annotate a Data Point", below in this table. 

Add Text Objects 

• Click the Text Tool button, then click on the graph to place the 

object. 

• Right-click on the graph and choose Add Text from the shortcut 

http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/pts-pts-legend
http://www.originlab.com/doc/Origin-Help/box-legend
http://www.originlab.com/doc/Origin-Help/box-legend
http://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
http://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
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menu. 

• Double-click on text to do rich text editing. 

Add Layer Title 

• Right-click on graph and choose Add/Modify Layer Title from the 

shortcut menu to add/modify layer title in active layer. 

Add Vertical/Horizontal 
Line 

• With a 2D graph active, use the Insert: Straight Line... menu item. 

 

This tool now supports using a simple LabTalk 
expression in the At Value field (e.g. 
"mean(plotdata(1,Y))" which translates to "mean 
of 1st plot's Y dataset") for positioning the line 
object. For more information see the discussion of 
At Axis Value. 

 

Annotate a Data Point 

• Click the Annotation tool on the Tools toolbar. See The 

Annotation Tool. 

Add Drawing Objects 

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:  

• Arrow, Curved Arrow. 

• Line, Polyline, Freehand Draw. 

• Rectangle, Circle, Polygon, Region. 

Insert Equation, Word 
Object, Excel Object, 
Other OLE Object  

• Insert Equation group on the Tools toolbar. 

 

You can download a free App from the OriginLab 
File Exchange, for adding LaTeX objects to 
worksheets and graphs. 

 

Insert Image 
• Right click on the graph and choose Insert Images From Files. 

Add Table 

• Click the New Link Table button on the Add Object to Graph 

toolbar and then click on the graph. 

• From the main menu, choose Insert: Table. 

http://www.originlab.com/doc/Origin-Help/AxesRef-RefLines
http://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
http://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
https://www.originlab.com/fileExchange/details.aspx?fid=221
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• To edit the table, double-click the table object. 

Insert Date & Time 
Stamp 

• Date & Time button on the Add Object to Graph toolbar. 

Insert Project Path 
• Project Path button on the Add Object to Graph toolbar. 

Add Bracket with 
Asterisk 

• To indicate statistical groupings, click the Add Asterisk Bracket 

button on the Add Object to Graph toolbar. Manually adjust the 

size and placement of brackets by dragging handles on the object. 

Add XY Scale 

This is useful when using a nonlinear xy scale.  

• New XY Scale button and click on a graph layer. 

• Select Insert: XY Scaler. 

12.8.1 Tips for Editing Your Graph Annotations 

• Pressing CTRL when drawing with the Rectangle or Circle tools, will draw a square or circle (as 

opposed to a rectangle or ellipse). 

• Right-click an object and choose Properties... to edit the properties of the text or drawing object and set 

the default. 

• Use the Format and Style toolbar buttons to quickly modify some plot elements including plot colors and 

axis title font face or size. 

• For text objects, including the axis titles, you can edit text objects directly in "In-place Edit" mode. 

Double-click on a text object to edit. Use the Format toolbar buttons to add superscript, subscript, and 

Greek characters. 

• Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes. The correct way to 

change font size is to click the text object once so that the green selection handles appear, then select 

font size from the Format toolbar. If you set while in In-place Edit mode, Origin will not indicate the 

proper font size when you hover on the text object. 

• When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special 

characters into your text object. 

• You can insert the contents of a worksheet cell into a text object by copying and pasting the cell contents. 

While in In-place Edit mode in the text object, right-click and choose Paste or Paste Link from the 
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shortcut menu. Pasted data is static; Paste Linked data is dynamic and will change if data in the linked cell 

changes. 

• Also, when in In-place Edit mode, you can right click and choose Insert Info. Variable... to insert 

information related to plotted data, into the text object. Since the pasted information is linked to a 

LabTalk variable value, the inserted data updates if the variable value changes. 

• You can insert variable values into a text object using the LabTalk %, and $ substitution notation by 

setting the Link to (%,$), Substitution Level to 1 in the text object's Properties dialog box, 

Programming tab. Right-click on the text object and choose Properties from the shortcut menu. 

• You can use controls on the Programming tab to associate LabTalk script with a text or drawing object (for 

instance, see Linking Text Labels to Data and Variables). Enter your script in the text box and specify a 

Script, Run After condition for running the script. Use the Apply to drop-down to set the scope for the 

script. 

• You can copy a range (of cells) from a workbook and paste it into a graph as a table object. The table 

object is editable. 

12.8.2 Grouping, Aligning and Arranging with the Object Edit Toolbar 

 

 
You can group text labels and drawn objects so that they move or resize as a unit: 

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer tool. 

2. To group the selected objects, click the Group button on the Object Edit toolbar. 

3. To ungroup objects, click the Ungroup button on the Object Edit toolbar. 

 
You can align text labels and drawn objects using the tools on the Object Edit toolbar: 

1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using 

the Pointer tool), then click one of the align objects buttons on the toolbar. Note that objects will be 

aligned with respect to the first-selected object. 

 
You can bring overlapping objects to the front or send them to the back: 

1. Select the objects that you want to move to the front or the back. 

2. Click the Front button or the Back button on the Object Edit toolbar. 

Note: For more information on graph annotations, see your Origin User Guide:  

http://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
http://www.originlab.com/doc/Origin-Help/Create-Tables
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Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects 

 

You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to 
align and set a uniform size for multiple graph layers or to swap layer order. 

12.8.3 Object Attachment and Scaling in Graphs 

 

There are two settings that you should know something about, particularly if you subsequently modify axis 
scales or resize the graph layer after adding annotations: One is the object's Attach to method, the other is 
the layer's Scale Elements behavior. 

12.8.3.1 Object Attachment 

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph 
layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object. 

In addition to being part of the graph layer that was active at the time of object creation, note also that 
objects are attached to the graph in one of three ways, depending upon the type of object and where it is 
created on the page. 

 
To view the "Attach to" setting for any object: 

1. Right-click on a text or drawing object and choose Properties.... 

2. Click on the Programming tab and note the object's Attach to setting.  

 

Though objects remain a part of the layer that was active at the time of their creation, you can manage some 
object behaviors by changing the object attachment method. An object is attached in one of three ways: 

• Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are 

they affected by a change in axis scales. These objects are still associated with a particular graph layer 

and they will be hidden or deleted if the layer is hidden or deleted. 

http://www.originlab.com/doc/Origin-Help/AddText-DrawObject
http://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
http://www.originlab.com/doc/Origin-Help/Attachment-Scaling-Object
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• Layer Frame. Objects that are attached to the layer frame, are resized and moved with respect to the 

layer frame. However, they are not tied to axis scales and are not affected by changes in the layer's axis 

scale values. Objects are hidden or deleted if the associated layer is hidden or deleted. 

• Layer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer, 

the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale 

and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or 

deleted if the associated layer is hidden or deleted. 

To briefly illustrate why object attachment is important, let's look at the following graph. After the graph was 
created, arrows and text objects that point to their respective data plots, were added to the graph. Both 
arrows and text objects are attached to the graph Layer Frame. 

 

Now, consider what happens to these objects when we modify the graph's X axis scale (recall that objects 
attached to the Layer Frame "are unaffected by changes in the layer's axis scale values"). Note that by 
changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not 
move with them. 
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The remedy for this is to change the text and drawing objects' Attach to method to be Layer and Scales 
because "if you rescale the axes, the object moves in relation to the visible scale." Sometimes we may want an 
object to move with scale changes; at other times we may not. You can force either behavior if you keep in 
mind the Attach to setting. 

12.8.3.2 Object Scaling 

Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a 
single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with 
Layer Frame -- that is, when the graph layer is resized, associated objects such as text objects, axis lines and 
ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into 
a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer 
frame. 

 

However, this is another default behavior that you may want to change (e.g. you have set your font size to 10 
pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab 
(Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for 
instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size 
tab, choose the Fixed Factor radio button and set the scaling factor to 1. 

 

If you have resized the graph layer, either by merging multiple graphs into a single 
graph or by manually resizing the layer, you will find that the font sizes do not display 

at their "correct" size (i.e. if you select a text object, the Font Size list on the Format 
toolbar shows the original font size). Further, if select a text object, the Status bar will 
report two font size numbers -- "size" and "actual". You can reset font size so that they 
are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For 
more information, see FAQ-441 How do I export graphs with exact size and resolution 
as specified by publishers? 

12.9 Arranging Graphs and Layers 

  

Task Method 

http://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
http://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
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Merge 
multiple 
graph 
window
s into a 
single 
graph 
window. 

• Graph: Merge Graph Windows... menu command 

or 

• Merge Graph Windows button on the Graph toolbar. 

 

Origin has two dialog boxes -- Fitting Layers to Page and Fit 
Page to Layers -- that are useful for arranging multiple graph 
panels on the page and for adjusting graph margins. 

 

Extract 
data 
plots in 
one 
layer to 
multiple 
layers. 

• Extract to Layers button on the Graph toolbar. 

 

Hint: to preserve your original graph, click the Duplicate button before extracting to 
layers. 

Extract 
multiple 
layers in 
a single 
graph to 
multiple 
graph 
window
s 

• Graph: Extract to Graphs 

or 

• Click the Extract to Graphs button on the Graph toolbar. 

All layers are extracted to individual graph windows, even if a layer is linked to another 
layer. 

By default, the layextract dialog box has Extracted Layers set to 1:0, which specifies that 
all layers be extracted. To extract only certain layers, clear Auto and use the layextract X-
Function's comma/colon notation to control which layers are extracted. The notation 1:0 
means starting with layer 1, extract all layers to graphs (0 denotes all). Specifying 1,3:4, 
for example, tells Origin to extract only the first, third and the fourth layer. Note that you 
can enable Keep Source Graph to preserve the original graph. 

Add, 
arrange, 
resize, 
position, 
swap, 
align, or 
link 
layers 

• Graph: Layer Management... menu. 

• Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to select 

multiple layers and Align Left, Right, Top, Bottom, etc. 

 

You can use the Layer Management tool's Swap control (Graph: 

Layer Management,Size/Position tab) to physically swap layer 
positions without reassigning layer numbers. Before doing so, set 
each linked layer's Units to % of Page (Size/Speed tab of Plot 
Details). 

 

http://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
http://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
http://www.originlab.com/doc/X-Function/ref/layextract
http://www.originlab.com/doc/X-Function/ref/layextract
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Size-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Size-Tab
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Link 
graph 
layers  

• Linked Axes Scales tab, layer level of Plot Details dialog box. 

• Link tab of the Layer Management dialog box. 

When linking layers, the child layer must have a higher layer number than the parent layer. 

Linked layers can be moved and resized together. 

You can link layers' axis scale values to be Straight (1:1) or you can specify a Custom 
mathematical relationship. 

Reorder 
layers  

There are several ways to reorder graph layers (reassign Layer number for each Layer). 
Learn more about reassigning layer numbers in the mini tutorial below this table. 

• Method 1: Open the Layer Management dialog and click the row header (shown in 

image below) and drag it up or down to change the Layer order. 

 

For more information, see the Layer Management tool. 

• Method 2: Enter the following LabTalk script in the Command Window 

(Window:Command Window), then press Enter to execute. 

page.reorder(n,m) 

The command changes the nth Layer to the mth Layer. 

• Method 3: Use the Front and Back buttons on the Object Edit toolbar (these buttons 

work on the active layer as indicated by the graph layer icon ). Alternately, right-

click on the graph layer icon and change layer order using shortcut menu commands 

(e.g. Bring to Front). 

 
Note: Reordering layers may break layer linking relationships. 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-LinkAxesScale-Tab
http://www.originlab.com/doc/Origin-Help/GraphRef-LayerManage
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LinkAxesScale-Tab
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A Note on Inset Graphs: In certain situations (see Tutorial, below), 
the order in which the layers are drawn on the screen becomes an 
issue. In this image, we have added an inset graph using the Add 
Inset Graph with Data button (Graph toolbar). The problem is that 
the data plot of the parent layer (red symbols) shows through the 
inset layer (small, black symbols). To fix this, we do two things: 

• Set the inset layer background Color = White -- by default, it is 

None (Format: Layer, then Background tab). 

• Set the layer Drawing order to Draw layer by layer (Format: 

Page then Layers tab). 

 

By default, an inset layer is added "on top of" the parent layer but if 
needed, you can click on the inset layer to select it, right-click and 
choose Bring to Front. 

 

Exchan
ge X-Y 
Axes 

• Graph: Exchange X-Y Axes menu command 

• Exchange Axes button on the Graph toolbar. 

Move a 
plot(s) 
to 
another 
layer 

• Method 1: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the 

bottom panel, select a plot and drag it from a layer to another layer. 

• Method 2: Run laymplot -d; (e.g. open the Script Window, type the command and 

press <Enter>) to open the Move Plot dialog to specify plot(s) to move and a target 

layer. 

 

You can move a plot by Copying(CTRL+C or Copy Range context 
menu) and Pasting(CTRL+V or Paste context menu) operations, 
between different layers or different graphs. Please note, the pasted 
plot won't be associated with the source data of copied plot, but 
exists as a loose dataset. 

 

http://www.originlab.com/doc/Origin-Help/PD-Dialog-Background-Tab
http://www.originlab.com/doc/Origin-Help/PD-Dialog-Layers-Tab
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In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and 
then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on 
top of the layer with lower number. This is important when plots in one layer overlay plots 
in another layer. When necessary, you can change layer order to change plot drawing 
order. 

This mini tutorial shows you how layer reassignment works. Use the preview window to 
see how layer number reassignment affects your graph. 

1. Click Help: Origin Central or press F11. 

2. Click on the Graph Sample tab, set the Samples in drop-down list to Area 

Plots and double-click on this graph:  

 

3. Activate the graph Area Plot With Horizontal Color Gradient, then click the 

Extract to Layers button on the Graph toolbar. Set both number of rows 

and columns to 1, click OK, then, click OK again for the page spacing. The green 

layer is on the top of the yellow layer in the figure. The purpose of this last step 

was simply to create a two layer graph in which the data in one layer partially 

hides the data in the other layer. What we will do now is to reorder the layers and 

set the yellow layer on the top, giving you a better view of the two plots.  
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4. Choose Graph: Layer Management... menu, then drag the row header "1" of the 

Layer1 in the Layer Selection downward under the Layer2 (indicated by a blue line), 

and click OK. 

5. You can see the yellow layer is on the top now.  
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Alternate Method: You can use the Front or Back toolbar buttons (located in 
the Object Edit toolbar, or at the top of Layer Selection box in the Layer Management 
dialog) to bring a layer forward or push it backwards. As happens when you rearrange 
layer order with the Layer Management dialog, this method swaps layer numbers. 

  

 

You can easily add an inset layer with data by clicking the Add Inset Graph With 

Data button on the Graph toolbar or Insert: New Layer(Axes): Inset With 
Data (Linked Dimension) . 

 

You can copy a layer from one graph window to another graph window. Click to select 
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and 
choose Copy. Click on the target graph window, then right-click to Paste. 

Note: For more information on merging graphs, see your Origin User Guide:  

Help: Origin: Tutorials > Graphing > Layers > Adding and Arranging Layers 

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box 

12.10 Templates and Themes 

http://www.originlab.com/doc/
http://www.originlab.com/doc/Origin-Help/GraphRef-MergeGraph
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Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it 
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a 
couple of ways -- either with templates or with Themes. These concepts are introduced below. 

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates 

Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes 

12.10.1 Templates 

 Customizations to your graph can be saved to template files for repeat use. For example, you can customize a 
graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save 
all of these attributes as a graph template (.otpu) file. You can further specify that the graph template be 
"cloneable" allowing you to link these graph customizations to dataset Long Name, Short Name or worksheet 
column index number and quickly re-create fairly complex graphs using new data. 

 
A few things to note: 

• In a fresh Origin installation, each one of Origin's 100+ built-in graph types uses a specific "system" 

template when creating a particular graph type. When you click on a Plot menu graph or graphing toolbar 

button (e.g. Area ), one of these templates is used to plot the selected data. 

• System templates are installed to the Origin Program Folder. They are completely customizable but you 

cannot overwrite the template files in your Program Folder (see next). 

• When you customize and save a system template, it is saved by default to your User Files Folder (UFF). If 

you save the customized template to the same system template name, the customized template replaces 

the system template as the template associated with the Plot menu command or toolbar button used to 

create that plot type. Additionally, the customized template is added to the user's Template Library. 

• To view customized graph templates, click Plot (workbook or matrix should be active) and click Category 

= MyTemplates. To view System Templates (built-in, not customized), click File: New: From 

Template. Set Type = Graph and Path = Origin Program Folder. 

• You can save a graph template anywhere (and with any name) that you like -- it does not need to be 

saved to your UFF. However, by saving customized templates to your UFF, they will be collected in one, 

easily-remembered place and they will be readily available when you upgrade your Origin software. 

http://www.originlab.com/doc/Origin-Help/Plot-Graph-Template
http://www.originlab.com/doc/Origin-Help/Graph-Format-Theme
http://www.originlab.com/doc/User-Guide/Installation-Startup
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A Switch List Mode button is added to Template Library in Origin 2020 so that you 
can toggle between preview and list view. 

 

  

• For an overview of graph templates, see Graph Template Basics. 

• For information on the Template Library, see The Graph Template Library. 

• For information on "cloneable" templates, see Cloneable Templates. 

12.10.2 Themes and Copy/Paste Format 

  An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin: 
graph Themes, worksheet Themes, dialog Themes and function plot Themes. 

Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be 
very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex 
(e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or 
complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an 

http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to 
recreate a suite of settings, or to apply those settings one-by-one to individual graph windows. 

All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows 
that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy 
a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from 
one object as a named Theme and apply that named Theme to other like objects at a later time. 

1. Right-click on an object in a graph window (e.g. a plot) and choose Copy Format. Depending on what 

you click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the 

option as to what exact format to copy.  

o To apply the copied formats to a single object, right-click on your target graph and choose Paste 

Format To. Again, this shortcut menu might has some sub-items that limit what to paste. In this 

way, the formatting option(s) from your source object should be applied to your target object. 

o To apply the copied formats to multiple windows in the project, keep the source graph window 

active and select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply 

Formats dialog box. Here you have the option of editing or selectively applying formats to one or 

more graph windows in the Origin Project. 

2. If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose 

the Save Format As a Theme... shortcut menu item, then use Preferences: Theme Organizer to 

apply the Theme when needed. 

12.10.2.1 Theme Organizer 

  Use the Theme Organizer (Preferences: Theme Organizer) to organize and apply Themes to graphs. 
With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file. 

To combine multiple Themes in the Theme Organizer dialog box: 

1. Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the 

shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to 

add/delete properties from an existing Theme. 
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• The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and 

plotted mathematical function Themes. 

• If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new 

graph, this System Theme will be applied regardless of the settings that were saved with the graph 

template†. 

• Use the System Increment Lists tab to manage increment lists and selectively apply them to project 

graphs. 

• You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported 

image file. 

 

† If you don't want a System Theme to be applied automatically to the graph, save the 
graph as a template (File: Save Template As) and clear the Apply System Theme 
to Override check box. 

12.11 Topics for Further Reading 

• Plot Details: Customizing Graph Page Elements 

• Plot Details: Customizing Graph Layer Elements 

http://www.originlab.com/doc/Origin-Help/ThemeRef-System
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
http://www.originlab.com/doc/Origin-Help/Customize-Page-Element
http://www.originlab.com/doc/Origin-Help/Customize-Layer-Element
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• Plot Details: Customizing Plot Elements 

• The Preferences: Options: Axis tab Settings 

• The Preferences: Options: Graph tab Settings 

• Graph Axes 

• Controlling the Graph Axis Display Range 

• Adding Text and Drawing Objects 

• Hiding Labels, Data and Layers 

• Graph Template Basics 

• Graph Template Library 

• System Templates 

• System Themes 

http://www.originlab.com/doc/Origin-Help/Customize-Plot-Element
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
http://www.originlab.com/doc/Origin-Help/GraphAxes
http://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
http://www.originlab.com/doc/Origin-Help/AddText-DrawObject
http://www.originlab.com/doc/Origin-Help/Labels-Data-Layer-Hide
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Graph-Template-Gallery
http://www.originlab.com/doc/Origin-Help/System-Templates
http://www.originlab.com/doc/Origin-Help/ThemeRef-System


 

203 

13 Graphical Exploration of Data 

  

  

 

Origin includes a number of tools for graphically exploring your data including those for zooming and panning 
data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected 
data points. 
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With Origin 2016, OriginLab began releasing add-on tools called Apps. Many 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
since that time. If you find you need some exploratory or analysis tool that is not a 
standard part of Origin, you might check to see if the tool exists as an App. If it does 
not, request it!. 

13.1 Zooming, Panning and Rescaling 

    

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of 
your 2D graph. We have split these tools and commands into two groups: 

• Page-level zoom and pan operations that do not change axis scales. 

• Axis rescale operations which zoom and pan the graph by changing axis From and To values. 

 

Page level zoom and pan do not alter the graph; they only determine which portion of 
the graph page is visible within the graph window. You can read the current zoom level 
in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not 
affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g. 

and ) do alter the graph and, thus, will affect the printout and export of the 
graph. 

 

13.1.1 Page-level Zoom and Pan 

Action Button Shortcut Key Menu Notes 

Zoom-Panning: Zoom 
and pan the graph page.  

A + 
+/- keys 
(zoom) 

or 
arrow keys 

(pan) 

 

Click the toolbar button; or 
with the Pointer tool 

active, place the cursor on 
the graph page and press "A", 
then ...  

• Use +/- keys or 

mouse wheel to 

zoom in or out. 

• Use the arrow keys 

to pan horizontally or 

http://www.originlab.com/fileexchange/index.aspx
https://www.originlab.com/www/company/qform.aspx?s=1&sbj=applications@
http://www.originlab.com/doc/Origin-Help/AxesRef-Scale
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vertically. 

Stepped Zoom-Pan†: 
Zoom graph in or out, by 
increment. 

 

 

CTRL + I 
CTRL + M 

View:Zoom 
In and 

View:Zoom 
Out 

• Stepped zoom. 

• CTRL+I activates 

zoom in; click on the 

graph to establish 

the focal point. 

• CTRL+M zooms out; 

clicking on graph not 

needed. 

Whole Page: Show the 
whole graph page. 

 

CTRL + W 
View: 
Whole 
Page 

• Reset the view of the 

page after using the 

Zoom-Panning tools, 

above. 

Zoom All: All objects in 
the window are shown. 

-- -- 
View: Zoom 

All 

• Can be used to 

locate "lost" objects 

lying outside the 

graph page. 

†Notes:These are older tools and methods that have been deprecated. Toolbar buttons are not shown by 
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph 
button group). 

13.1.2 Axis Rescaling 

Action Button Shortcut Key Menu Notes 

Rescale: Rescale and 
pan the graph in both X 
and Y dimensions. 

 

-- -- 

• Scroll mouse wheel 

to rescale X. 

• SHIFT + scroll to 

rescale Y. 

• Drag with the left 

mouse button to pan 

(will rescale both X 

and Y). 

• Select the Pointer 

tool to exit Rescale 
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mode. 

Rescale the graph in the 
X dimension. 

-- 

Z + scroll 
wheel 

or 
Z + 
+/- 
keys 

-- 

• Rescale the graph in 

the X dimension 

without limits. 

Pan the graph in the X 
dimension. 

-- 

X + scroll 
wheel 

or 
X + 
+/- 
keys 

-- 

• Rescales X. 

• Does not rescale Y. 

Rescale X: Rescale the 
graph in the X 
dimension. 

 

-- -- 

• Rescales (Resets) X 

to full X range + 

some padding factor. 

Rescale the graph in the 
Y dimension. 

-- 

SHIFT + Z + 
scroll wheel 

or 
SHIFT 
+ Z + 

+/- 
keys 

-- 

• Rescale the graph in 

the Y dimension 

without limits. 

Pan the graph in the Y 
dimension. 

-- 

SHIFT + X 
+ scroll 
wheel 

or 
SHIFT 
+ X + 
+/- 
keys 

-- 

• Rescales Y. 

• Does not rescale X. 

Rescale Y: Rescale the 
graph in the Y 
dimension. 

 

-- -- 

• Rescales (Resets) Y 

to full Y range + 

some padding factor. 

Rescale XY: Rescale 
the graph in both X and 
Y dimensions. 

 

-- -- 
• Rescales (Resets) X 

and Y to full range + 
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some padding factor. 

Rescale Z: Rescale the 
graph in the Z 
dimension. 

 

-- -- 

• Rescales (Resets) Z 

to full range + some 

padding factor. 

Scale In/Scale Out: 
Rescale the graph in X 
and Y dimensions. 

and 

 

-- -- 

• Select Scale In 

button, then drag 

out rectangle(s) to 

define axis scale 

range desired. 

• Reset by clicking on 

the Scale Out 

button (no need to 

drag) several times. 

• Rescales both X and 

Y. 

• Press ESC (or select 

another tool) to quit 

magnifying mode. 

Rescale: Rescale the 
graph in the all 
dimensions. 

 

CTRL + R 
Graph: 

Rescale to 
Show All 

• Rescales (Resets) all 

axes to display all 

data in the layer (+ 

some padding 

factor). 

 

You can use the Scale In button to copy an enlarged portion of your 2D graph to a 
new window. This will also work on any graph that has multiple linked layers as long as 
the layers are overlapped and share a common axis (% of Linked Layer has 
Left/Top set to 0 and Width/Height set to 100, plus Straight (1 to 1) linking to the 

parent layer). With a graph active, press Ctrl then click the Scale In button  (Tools 
toolbar) and drag out a rectangle on your 2D graph. Note that this Enlarged graph is 
dynamic. Move or resize the rectangle on your original graph and the Enlarged graph 
is updated. 

 

If you do not see a toolbar button, it may be turned off. To add or remove buttons from 
a toolbar, see The Customize Toolbar Dialog Box. 

http://www.originlab.com/doc/Origin-Help/Link-Layers
http://www.originlab.com/doc/Origin-Help/CustomToolbar-Dialog
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To prevent an axis from rescaling when using one of the axis rescaling tools, set 
Rescale = Fixed. If both X and Y axes are set to Fixed and you pick one of these axis 
rescaling tools, you are reminded that X and Y axes are in "Manual Rescale mode" and 
are prompted to proceed. Answering Yes will allow you to override and manually 
rescale in one or both dimensions. If you need to block such manual overrides of Fixed 
axis scales, set @nrm = 1. 

13.2 Rotation of 3D openGL Graphs 

You can interactively rotate your 3D graphs for to obtain a better view of your plots. When you click on an 
empty portion of a 3D graph, a floating toolbar displays. You can use the floating buttons to rotate the graph; 
or you can use your keyboard and mouse. 

Hot Key Menu/Action Context 

Rotate 3D graphs with the 3D floating buttons 

X + Arrow key 
Rotate the 3D graph around 
the X axis. 

With graph layer active and with Rotate 

button selected in the 3D floating button 

group. 

 

Y + Arrow key 
Rotate the 3D graph around 
the Y axis. 

Z + Arrow key 
Rotate the 3D graph around 
the Z axis. 

Q + Arrow key Rotate the 3D graph in screen. 

W + Arrow key 
Rotate the 3D graph around 
any axes. 

Rotate 3D graphs using R key 

R + Mouse 
Drag to rotate the 3D graph in 
an arbitrary direction. 

Press "R" before pressing other keys. 
 
Hovering on a 3D graph while pressing "R" 

changes the Pointer tool to a . Press 
Ctrl and/or Shift as needed, and rotate by (a) 
dragging with your mouse or (b) pressing the 
arrow keys on your keyboard. 

R + Ctrl + 
Mouse/Arrow key 

Rotate the 3D graph around 
the X axis. 

R + Shift + 
Mouse/Arrow key 

Rotate the 3D graph around 
the Y axis. 

R + Ctrl + Shift + Rotate the 3D graph around 

http://www.originlab.com/doc/Origin-Help/Axis-DisplayRange-Control
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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Mouse/Arrow key the Z axis. 

13.3 Reading Coordinate Values and Distances 

 Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools 
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available 
from the Gadgets menu. 

13.3.1 Data Point Tooltip 

Most 2D plot types support a floating, customizable tooltip that reads data point values when you hover on a 

data point. 

 

 
Tooltip Shortcut Menu 

For tooltip customiztion and other options, right-click directly on the data point tooltip. 
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• Go to Sheet pops up the worksheet and highlights the row that contains the source data for the data 

point. 

• Show Data Plot Tooltip toggles display of a non-customizable data plot tooltip in place of the 

customizable data point tooltip (see, below). 

• Pick Data Points puts the cursor into data reading mode and opens a Pick Points dialog. Double-click 

on points in the graph and when finished, click Done. This generates summary data (source, X-Y 

coordinates, etc.) for your picked points. 

• Copy, copies data point tooltip information to the Clipboard. 

• Preferences opens the Data Point Tooltip dialog allowing you to customize tooltip content and 

formatting (alternately, you can double-click on the tooltip to open this dialog). 

 
The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data 
Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip. 

 

By default, the Data Point Tooltip displays with a moderate degree of transparency. You 
can affect tooltip transparency by changing the value of LabTalk System Variable 

@TDT. For information on changing the value of a LabTalk System Variable, see this 
FAQ. 

13.3.2 Data Plot Tooltip 

There is a second tooltip that can be displayed in place of the Data Point Tooltip and this we refer to as the 
Data Plot Tootip. This non-customizable tooltip displays the source book, worksheet and coordinate datasets, 

on hover. 

 

The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data 
Point Tooltip and choose to Show Data Plot Tooltip. Conversely, right-click on the Data Plot Tooltip and 
choose Show Data Point Tooltip. 

13.3.3 Managing Tooltip Display 

http://www.originlab.com/doc/Origin-Help/Picking-Points
http://www.originlab.com/doc/Origin-Help/Data-Info-Tool
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
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You can turn off display of data tooltips by activating the graph window, clicking on the View menu and 
clearing the check mark beside Data Tooltips. 

There is a second way to control tooltip display that is more complicated but allows a greater degree of 
control. This entails changing the value of LabTalk system variables @PT and @PTI. 

 

@PT=0; //Disable both data plot and data point tooltips 

@PT=1; //Enable data plot tooltips for 2D graph (default) 

@PT=2; //Enable data plot tooltips for 3D OpenGL graph 

@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph  

@PTI=0; //Disable only data point tooltips 

@PTI=1; //Enable data point tooltips (default) 

13.3.4 The Annotation Tool 

Use the Annotation tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar 
plots. Choose from several standard data point labels or create your own custom label using LabTalk script. 

To annotate a data point: 

1. Click the Annotation button on the Tools toolbar and move the cursor to the desired data point. The 

cursor and the Status Bar will display the current label form. 

 

2. Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate 

value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value; 

index number (row number); or Custom (see Tutorial, next). 

3. When you've selected your label form, double-click to add a label to the data point; or single-click on the 

point and press Enter. 

 

Tutorial: Customizing the Annotation String 

The annotation string can be customized by combining literal characters with the X and 
Y coordinate values: 

 
 
 

http://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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1. Start with a graph of your data 

2. Open the Script Window (Window:Script Window) and type the following 

command, then press Enter:  

 

system.annotation.customlabel$="X value: $(x,.2), Y 

value: $(y,*5) 

3. Click the Annotation button , hover on your graph, then press the Tab key 

several times to cycle through the annotation choices until the custom string 

format specified above is displayed in the Status Bar. The cursor will display the 

word "Custom". 

4. Start double-clicking on data points (or single-click and press Enter) to add the 

custom annotation string. The X values will be displayed with two decimal places 

and the Y values will be displayed with 5 significant digits, as specified by your 

script. 

 
Adjustments using the Pointer Tool: 

• To move a label to another data point, click the Pointer tool , press the ALT key and drag the label. 

• To re-position overlapping labels, drag the label. A leader line is automatically added. 

• To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point. 

Note: Please view more information on string formatting in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical 

Listing of Objects > String 

13.3.5 The Screen Reader Tool 

The Screen Reader uses the Data Display window to report the XY(Z) coordinates of the cursor on the 
graph page. Note that the Screen Reader is not reading data point coordinates; rather it is reading page 
coordinates relative to the graph axes. 

The Data Display window opens automatically when you select the Screen Reader tool from the Tools toolbar 
(by default, the Data Display window is docked at the bottom of your Origin workspace). 

http://www.originlab.com/doc/LabTalk/ref/String-obj
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You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-
clicking inside the window. 

To use the Screen Reader: 

1. Click the Screen Reader button on the Tools toolbar. This opens the Data Display tool. 

2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only). 

Coordinate values show in the Data Display window. 

3. To increase cross-hair size, press the space bar. 

4. Click the Pointer button on the Tools toolbar to exit screen reading mode. 

13.3.6 The Data Reader Tool 

The Data Reader is used to read information associated with a data point in your plot. This could be 
coordinate values or it could be more complex information including metadata or even images that relate to 
the data point. The Data Reader works in concert with the customizable Data Info window. 

 

The Data Reader tool is grouped with two related tools -- the Data Cursor and 

the Data Highlighter . Only one of these toolbar buttons will show at any given 
time. To select a hidden tool, click on the small arrow to the right of the button and 
select a tool from the pop-up menu. 

 

To use the Data Reader tool: 

1. Click the Data Reader button on the Tools toolbar. This opens the Data Info window. 

http://www.originlab.com/doc/Origin-Help/Data-Info-Tool
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2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the 

Data Info window (and Data Display window). 

3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or 

click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN 

arrow keys to move to a data point on another plot or use your mouse to click on the point. 

4. To change the vertical and horizontal cross-hair size, click on a point and press the spacebar. 

5. Click the Pointer button on the Tools toolbar or Esc key to exit the Data Reader tool. 

13.3.7 The Data Cursor Tool 

  The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one 
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the 
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data 
Reader. 

 

Tutorial: Using the Cursor Tool to Measure Relative Distance 

1. Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot. 

2. Click and select the Data Cursor button from the Tools toolbar.  

 

3. Double-click on one of the peaks or click once on a data point and press 

ENTER, to add a cursor object.  



Graphical Exploration of Data 

215 

 

4. Repeat to place a second cursor object on another peak. 

5. Double click in the Data Info. window to open the Data Info. Report Settings 

dialog. If this window is not visible, select the View: Show Data Info menu item 

to open the Data Info. window. 

6. Switch to the Columns tab and then right-click in the gray area to the right of the 

columns and choose Add Column. 

7. In the new column that is added, click on the source row of new column, and select 

Relative (Cursor2 - Cursor1) from the drop-down, and then press OK to close 

the dialog. 

8. Now you can drag and move the cursor objects and the third column in the Data 

Info window will display the X and Y distances between the two cursors. 
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13.3.8 The Data Highlighter Tool 

The Data Highlighter is grouped on the Tools toolbar with the Data Reader and Data Cursor tools. Use the 
Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding 
data row in the worksheet. Unselected points are dimmed in the graph and the worksheet. 

 

 
While in Data Highlighter mode ... 

• CTRL+click to select multiple points in the graph. 

• Drag out a rectangle on the graph to select multiple points. 

• Use SPACE to toggle between rectangle and freehand selection modes. 
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• Use left/right arrow keys to highlight individual points in sequence by row index. 

• In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and 

highlight corresponding points in the graph. 

• Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet. 

 

Origin 2020 features faster rendering of scatter plots. One benefit is that the Data 
Highlighter is much more responsive when selecting a large number of scatter points by 
dragging out a rectangle with your mouse. 

13.3.9 The Data Info Window 

     The Data Info window opens when you choose either the Data Reader , the Annotation or the 

Data Cursor tools . When you click on a plotted data point with one of these tools, the Data Info window 
displays information about this particular data point. 

 

In its default configuration, the Data Info window reports only a column short name, plot designation (e.g. 
"X") and the XY coordinate values of a data point. However, the window is capable of displaying any of the 
worksheet-contained information that is associated with a data point including metadata and images. 

 

To customize the Data Info window: 

1. Double-click on the Data Info window; or right-click and choose Preferences.... 

2. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info 

window: 
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• The Data Info window can report any information in the source data worksheet. You are not limited to 

displaying plotted data. 

• The window can display anything that can be inserted into the worksheet cell, including inserted graphs 

and images. 

• The window can be customized with a Window Title and Report Title. 

• Window configurations can be saved as Themes, including Save to <Graph>, Save to <Layer> and 

Save to <DataPlot>. This allows, for instance, all graph windows in your project or all graph layers in 

your multi-panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the 

current Data Info window. 

 

 

If you save your Data Info Theme settings in the graph, then save the graph window 
as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels 
only with the data that are plotted in the graph. Therefore, if your Data Info Theme 
uses data in other columns in your worksheet, the Data Info display will be incomplete 
if, for instance, you reopen the window file in a new project. 
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For more information on customizing the Data Info window, see: 

• The Data Info Window. 

• Tutorial: The Data Reader Tool (discussion on customizing the Data Info window). 

13.3.10 Gadgets 

    Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the 
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration: 

• Vertical Cursor 

• Statistics 

• Cluster (OriginPro) 

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked 
panel plots or multi-plot graphs, where plots share a common X scale. 

To open the Vertical Cursor: 

1. With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the 

Vertical Cursor dialog box. 

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label 
font size, hide labels, etc. 

http://www.originlab.com/doc/Origin-Help/Data-Info-Tool
http://www.originlab.com/doc/Tutorials/DataReader
http://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
http://www.originlab.com/doc/Origin-Help/Gadget-Statistics
http://www.originlab.com/doc/Origin-Help/Gadget-Cluster
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When labeling plots with the Vertical Cursor, you can opt to combine separate data labels 
into a single label by clicking the gadget's Show All Info in One Label button. 

 

The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest 
(ROI) on the graph.  

• Display basic statistics for data inside the ROI. 

• Display mean and nth Standard Deviation lines inside the ROI. 

• Update results dynamically as ROI is moved or resized. 
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The Cluster gadget (available in OriginPro) provides the following features: 

• Display basic statistics for data inside a region of interest (ROI). 

• Switch between rectangular or elliptical ROI. 

• View statistics for points inside and outside of the ROI. 

• Edit, copy, mask, delete or group data points. 

• Update results dynamically as ROI is moved/re-sized. 

• Output results to a worksheet. 

 

When you use the Cluster gadget to define a category (points within a ROI on a plot), you 
can apply a differentiating color to points within the ROI. 

http://www.originlab.com/doc/User-Guide/OriginPro
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Note: To learn more about these gadgets, see:  

Help: Origin: Origin Help > Gadgets 

13.4 Topics for Further Reading 

http://www.originlab.com/doc/Origin-Help/Gadgets
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• Gadgets 

• The Data Analysis chapter of this User Guide 

• The Cluster Gadget (OriginPro) 

• The Vertical Cursor Gadget 

• The Digitizer 

• The Statistics Gadget 

• Masking Data 

• Data Filtering 

• Drawing or Deleting Data Points in the Graph 

• List of Origin Built-in Toolbars and Buttons 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/Origin-Help/Gadget-Cluster
http://www.originlab.com/doc/Origin-Help/Gadget-VerticalCursor
http://www.originlab.com/doc/Origin-Help/Tool-Digitizer
http://www.originlab.com/doc/Origin-Help/Gadget-Statistics
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/User-Guide/Data-Analysis
http://www.originlab.com/doc/User-Guide/Toolbars
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14 Gadgets 

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple: 
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis 
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object. 

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by 
clicking the arrow button in the upper-right corner of the ROI and choosing one of the menu options. For 
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context 
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file. 

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on 
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI. 

                

 

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 
and more tools are being released all the time. Please visit the File Exchange to review 
available tools. 

14.1 Origin Gadgets 

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin. 

http://www.originlab.com/fileexchange/index.aspx
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Gadgets are meant to be interactive. Any time you make an adjustment (to the region-
of-interest, for example), you can generate new output to your results sheet by 

pressing "O" on the keyboard. 

Cluster Gadget† View statistics on points inside/outside a rectangular or elliptical ROI.  

Differentiate Gadget Calculate and plot the nth-order derivative of selected data. 

FFT Gadget View FFT spectrum of selected data. 

Integration Gadget Calculate the area under a curve, or between two curves. 

2D Integration Gadget 
Calculate the 2D integration for a contour or image graph created from matrix or 

XYZ worksheet data.  

Interpolate Gadget Perform linear, spline, b-spline or Akima spline interpolation of selected data. 

Intersect Gadget Calculate the intersection points of two or more data plots. 

Quick Fit Gadget Perform linear, polynomial, or nonlinear fitting of selected data. 

Quick Peaks Gadget Locate peaks, and compute area and other peak properties. 

Quick Sigmoidal Fit 
Gadget 

Perform Sigmoidal fit of selected data. 

Rise Time Gadget Analyzes rise/fall time for the step-like signal.  

Statistics Gadget Compute and display simple descriptive statistics of selected data on the graph. 

Vertical Cursor Gadget 
Read and tag X, Y coordinate values for data plots across multiple graphs that 
share the same X axis. 

Image/Contour Profile Analyze the image or contour from matrix data and generate profiles. 

Curve Translate Gadget 
Drag a curve in the vertical or horizontal direction, adjusting source data in the 
process. 
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Note: To learn more about these gadgets, see:  

Help: Origin: Origin Help > Gadgets 

Help: Origin: Origin Help >Matrix Books Matrix Sheets and Matrix Objects > Viewing and 

Profiling Matrix Data 

 

† When you use the Cluster gadget to graphically define a category (within an ROI), 
you can apply a differentiating color to points within the ROI. 

 

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet 

1. With a new workbook active, import the file Peaks on Exponential Baseline.dat 

located in the Samples\Spectroscopy subfolder under the Origin installation folder. 

2. Create a line plot of the data in column B. 

3. With the graph active, go to the main menu and click Gadgets: Integrate.... 

4. In the dialog box that opens, click the Baseline tab and select Straight Line from 

the Mode drop-down list. 

5. Click the Output tab, and under the Output Quantities to node, select Append to 

Worksheet and clear the other check boxes. 

6. Expand the Quantities node, select None from the Dataset Identifier drop-down 

list and enable Beginning X and Ending X. 

7. Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is 

added to the graph. 

8. Resize and move the ROI object to cover just the first peak in the data plot, then 

press the arrow button located at the top-right of the ROI and select New Output; 

or press "O" on your keyboard. This will write the parameters for the first peak to a 

worksheet. 

9. Drag and move the ROI to cover the second peak, and repeat the steps above to 

generate output for the second peak. 

10. Press the arrow button again and this time select Go to Report Worksheet. A 

worksheet with the integration results will open. 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
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Click the arrow button in the top right corner of the ROI and you can opt to output 
results for all curves in the current layer (New Output for all Curves (N)) or for all 
layers of the graph page (New Output for All Layers (L)) or press the corresponding 
N or L hotkey. This allows for batch analysis of multiple curves in a graph. 

14.2 Topics for Further Reading 

• Gadgets 

• The Image/Contour Profile tool 

• Tutorial: Using Multiple Gadgets 

• Tutorials for Individual Gadgets 

• Peak Analyzer 

• Digitizer 

http://www.originlab.com/doc/Origin-Help/Gadgets
http://www.originlab.com/doc/Origin-Help/View-Profile-MatData
http://www.originlab.com/doc/Tutorials/Using-Multiple-Gadgets
http://www.originlab.com/doc/Tutorials/Gadgets
http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/doc/Origin-Help/Tool-Digitizer


 

229 

15 Data Analysis 

15.1 Introduction 

Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak 
analysis and signal processing. Most of Origin's analysis tools can make use of a stored collection of settings -- 
something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from 
one operation can become the input for another operation, thus allowing you to set up a chain of operations, 
with results that update whenever there are changes to data as might happen when importing a series of data 
files. 

The following sections cover (1) identifying the data that you wish to analyze and (2) the Origin and OriginPro 
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User 
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features. 

 

Origin 2016 introduced add-on tools called Apps. Since being introduced, many new 
exploratory and analysis-related tools have been added to OriginLab's File Exchange 

and more tools are being released all the time. To see what Apps are available, you can 
visit the File Exchange; or you can simply click on Add Apps at the top of the Apps 
Gallery. 

15.2 Selecting Data 

Origin's analysis tools may act on workbook data or plotted (graph window) data. By default, analyses will be 
on done on highlighted data in the worksheet or the active plot in graph. You may want to restrict your 
analysis to a subset of the data; say, a certain range of rows or columns in a worksheet, or a certain X range 
in a graph. 

You can either do the data selection before opening an analysis dialog or after opening the dialog. Most of 
Origin's X-Function based analysis tools have a Input branch with a range selection control that you can use 
to interactively select your data (we explain use of the control, below). 

 

While they are more useful as tools for exploratory analysis, the Data Highlighter and 
Object Manager can also select data in the graph and the worksheet. 

 

Origin 2020 adds these keyboard shortcuts for worksheet data selection: 

• CTRL + SHIFT + END extends selection to the last filled cell in the sheet 

• CTRL + SHIFT + HOME extends selection to the cell in row 1, column 1 

• SHIFT + arrow key extends the selection to additional columns or rows 

15.2.1 Selecting Data in the Worksheet 

 When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would 
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range 
selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior 
to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze. 

 

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/fileexchange/index.aspx
http://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
http://www.originlab.com/doc/User-Guide/Origin-Interface
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If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do 
upon opening the dialog is to select data in Input branch: 

 

1. Click the range selection control next to Input (or Input Data). The dialog box will roll up. 

2. Go to worksheet and highlight your worksheet data, then click the button at the right end of the 

rolled up dialog box. The Input branch will now show the selected range. 

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data 
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple 
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only 
supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will 
be picked in the analysis. 
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Notes 

• The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can 

add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its 

corresponding X, Y, Error and Row controls. 

• Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet 

and column). 

• A Rows control under each range node lets you set range by row index or X value. If you want to apply 

the same row range to all ranges under Input Data, click the arrow button to the right of the range node 

and choose Apply Row Range to All. 

• Depending on where you are in the Input Data hierarchy, the range selection button may have some 

limitations ( e.g. if you click range selection control next to Y, though you could select multiple columns in 

a worksheet, only the 1st column is accepted). 

• Clicking the arrow button to the right of the range selection control will show more selection options, 

including individual worksheet columns that can be quickly added to your data selection. 

• Depending on which level you are in, the selection options when clicking the arrow button may vary. For 

instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item, 

will open the Column Browser allowing you to select multiple columns from different worksheets. 
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1. Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can 

be sorted by clicking any of the column headings, making it easy to select, for example, all columns that 

share the same LName or Comments. 

2. Then click the Add button to add the column to your selection list in bottom panel. 

3. To modify the data input range of any dataset, click the range button to the right of any dataset added to 

the bottom panel and edit the From and To values. 

15.2.2 Selecting Data in the Graph 

  When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the 
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that 
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the 
interactive range selector button, changing a data range, etc.). 

The active dataset is the one that shows in the data list (bottom of the Data menu) with a check mark next to 
it. Note that this analysis dialog box behavior applies even to plot groups. You can force an Analysis dialog 
box to register a particular data range by clicking on another of the data plots listed at the bottom of the Data 
menu. 
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Alternately, you can graphically set the range for your analysis by selecting one or more plots in the graph 
window: 

• If your data plots are not part of a plot group, you can click once on the intended plot before opening an 

Analysis dialog box and this will set the Input Data range to the selected plot. 

• If your data plots are part of a plot group, click once on any of the plots in the group to set Input Range 

to all plots in the group; or click a second time on any plot to restrict analysis to the selected plot (note 

that this does not switch the active dataset). Alternately, you can pre-select multiple plots using the 

Regional Data Selector (see below). 

 

You can indicate the active dataset by placing a red rectangle around the plot's legend 
entry. To turn this feature on or off: 

• Click on your graph window, select Format: Page..., click on the Legends/Titles 

tab and enable or clear the Indicate Active Dataset box. 

• Right-click on the graph and choose Legend, then select/deselect Indicate Active 

Dataset. 

• Right-click on the graph and choose Legend: Update Legend and enable or clear 

the Indicate Active Dataset box. 

15.2.3 Selecting a Subset of Your Data Graphically 

There are a couple of ways to choose a subset of your data in the graph. 

15.2.3.1 The Regional Data Selector 

http://www.originlab.com/doc/User-Guide/Graphing
http://www.originlab.com/doc/User-Guide/Graphing


UserGuide 

234 

You can graphically select a range of data using the Regional Data Selector tool:  

1. With a graph window active, click and hold the Regional Data Selector button on the Tools toolbar, 

and then choose Selection on Active Plot or Selection on All Plots. 

2. Drag out a rectangle or freehand object to select an area of the plot(s). Press Space to toggle between 

rectangle and freehand modes . 

 

When you make your selection, data markers appear on the graph, delineating the selected range(s). You can 
work with graphically selected data using Origin's analysis tools (e.g., Linear Fit), but note that some analysis 
dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis: Signal 
Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot. 

 

Tutorial: Linear Regression on Partial X Range 

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new 

workbook. 

2. Select all Y columns and create a line plot. 

3. Click and hold the Regional Data Selector button on the Tools toolbar, and then 

choose the Selection on All Plots button . 

4. Drag out a rectangle to select the tail-end of the three curves between values of 

approximately 0.6 and 1.0 along the X axis. 

5. Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog. 

6. Input Data branch is filled with three ranges. Mouse over Input Data branch will 

show tooltip which shows 1X,1Y, ...3X and 3Y. 

7. If you want to change the data selection, click the arrow button in Input Data 

and choose Reselect All Data from Graph. The dialog will roll up. Drag out a 

rectangle in graph again to make your selection and then click the button at 

the right end of the rolled up dialog box. The new data selection will show in Input 

Data branch. 

8. Accept default Linear Fit settings and press OK to close the dialog. Linear fitting 

will be performed on all three curves over the selected range. 
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In addition to the data selection and data masking methods discussed in this 
section, Origin offers data filtering and data reduction tools. Please visit the linked 
pages for details. 

15.2.3.2 Editing a Data Marker 

To edit a Data Marker:  

• To modify a data range, right-click a data marker and choose Edit; or double-click on the data marker. 

The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-

hair. Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed 

below and modify the data range. To escape edit mode, double-click on the marker or press the Enter key. 

• There are other options when right-clicking the data marker such as Delete Marker, Delete Data, etc.. 

 

http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Wks-DataReduction
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Note: If you have used the Regional Data Selector tool to place markers on multiple plots (Selection on 

All Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of 

other selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector. 

 
Alternately, you can use these keyboard shortcuts to select and edit data markers: 

1. Select data markers using these keys ...  

Hot Key Action 

s Select the first pair of data markers on the graph (those marked with "1"). 

Tab 
Select the next pair of data markers (not in edit mode) or the other data 
marker of the pair (in marker edit mode). 

Home Return to the first data marker. 

End Go to the last data marker. 

2. ... then activate and edit the data marker using these key combinations:  

Hot Key Action 

Enter 
Activate the selected data marker for editing. (Press Enter again to exit 
data selection mode.) 

Arrow Move the active data marker exactly one data point. 

Ctrl/Shift + Arrow Move the active data marker multiple data points. 

Delete Delete the the active data marker. 

15.2.3.3 Difference between Data Markers and Analysis Markers 

  

• Data Markers define a sub-range that you select using the Data Selector tool. 

If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from 

the main menu, or click the Clear Data Markers button on the Markers and Locks toolbar. 



Data Analysis 

237 

 

• When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default, 

Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange, 

Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun 

your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the 

Input Data range and rerun the analysis. 

 

Note:  
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1. If you set Recalculate to None in the analysis dialog box, then no analysis markers are 

generated. 

2. Data markers and analysis markers are not exported when you choose File: Export Graphs. 

3. To select the exact same range again for another analysis, click the green lock and choose Plot 

Input Data with Data Markers to create a new graph and do analysis on it. 

4. There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker 

Hide Show to toggle analysis markers on or off, etc. There is also an Analysis Markers 

submenu, available from the Data menu; or when you right-click on an analysis marker or green 

lock and choose Analysis Markers. 

15.2.3.4 The Pick Points Tool 

You can also pick the data points in the graph using the Pick Data Points tool. This works best for scatter or 
line + symbol plots of smaller datasets. 

1. Select Data: Pick Data Points. The Pick Points dialog will pop up. 

2. With the square cross-hair, you can read the coordinate of current data points in the Pick Points 

dialog (also the Data Source). Double-click on the point you want to pick until the cross-hair cursor 

became round, the actual X&Y values will be recorded and the total number of picked points will be 

counted up.  

 

3. Once you finished the picking, click the Done button to output the results to a new workbook. 

15.3 Data Masking 

Masking is another tool that you can use when you want to analyze only a subset of your data, or when you 
have spurious data points that you do not want included in your analysis. Mask or unmask will trigger 
recalculation. 

You can mask data points in either your worksheet or your graph. When data exist in both the worksheet and 
the graph, masking data in one will mask the corresponding data in the other. 

Note that there are two toolbars with masking buttons: the Tools toolbar and the Mask toolbar. The masking 
tools on the Tools toolbar work only with graphs. The tools on the Mask toolbar work with worksheets or 
graphs. 

15.3.1 Masking Data in Worksheets 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
http://www.originlab.com/doc/Origin-Help/Picking-Points
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Masking of worksheet data excludes masked data from analysis operations. When plotted, masked data points 
display in the mask color.   

Action 
Toolbar 
Button 

Shortcut Command Notes 

Mask data 
 

Mask: Range 
Mask the selected data range. 
Masked data will display in the mask 
color. 

Unmask data 
 

Mask: Clear Range 

Unmask the selected data range. 
Unmasked points are included in 
analysis operations and plot 
"normally". 

Swap mask 
 

Mask: Swap 
Swap masked and unmasked points 
in the active dataset. 

Change mask 
color 

 

Mask: Change Color 
Change the mask color of the 
masked data range. 

Hide/Show 
masked points 

 

Mask: Hide 
Toggle display of masked points ON 
and OFF on-screen, and in printed 
and exported graphs. 

Disable masking 
 

Mask: Disable Masking 

Toggle the mask ON or OFF for all 
masked data in the worksheet. 
When toggled OFF, all data points 
are analyzed and included in printed 
and exported graphs. 

 

There is a tool for masking worksheet data by condition. With the worksheet column(s) 
selected, choose Column: Mask Cells by Condition. 

15.3.2 Masking Data in Graphs 

 With your graph window active: 

1. Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or 

Mask Points on All Plots button on the Tools toolbar, then hover on the graph. 

2. To mask a single point, double click on the point. To mask a region of points, press the space bar to 

toggle among masking by row index, by rectangular region or by freehand region (icons explained below), 

then drag out a region. 

3. Once data are masked in the graph, you can use the Mask toolbar buttons, described above. 
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Mask Points 
on Active Plot 

Mask Points on All 
Plots of Active 

Layer 
Purpose 

 
 

Mask data points by row index number. All data points between the 
lowest and highest selected index numbers are masked regardless 
of whether they lie inside your rectangle. 

 

 

Mask data points by rectangular region. Only the data points inside 
the rectangle that you drag out, will be masked. 

 

 

Mask data points by freehand region. Only the data points inside 
the region that you drag out, will be masked. 

 
To remove the mask from data points in the graph window: 

1. Choose either the Unmask Points on the Active Plot tool or the Unmask Points on All Plots of 

Active Layer tool on the Tools toolbar. 

2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then 

drag to unmask your data points. The tool will be active until press ESC or click the Pointer tool. 

15.4 Drawing or Moving, or Deleting Data Points in the Graph 

  This collection of tools and menu-driven operations is helpful in exploring certain "what if" scenarios, or to 
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D 
scatter plots. 

1. Activate the graph window. 

2. Click on the Draw Data Tool . 

3. Make sure that the correct graph layer is active and place the cursor on the graph. 

4. Double-click to create data points. The Data Display tool opens (if not already open) and displays the X 

and Y values for each created data point. 

5. When you have finished adding data points, click on another tool (on the Tools toolbar) to exit drawing 

mode. 

When you use the Draw Data tool, you simultaneously create a hidden worksheet named Drawn (worksheets 
are automatically enumerated, with n = 1, 2, 3, 4, etc.). 

15.4.1 Opening the hidden Drawn Worksheet 

Right-click on the data plot and select Go to Drawn from the shortcut menu or in Plot Details dialog, with data 

plot selected on left panel, click the Workbook button. 

A Drawn workbook will appear with A(X) and B(Y) columns with coordinate values of your drawn data plot. 
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15.4.2 Deleting a Data Point 

You can delete individual data points from your graph: 

1. Select Data: Remove Bad Data Points. 

2. Double-click on the data point, or click to select the data point and press ENTER key. 

3. Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode. 

The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell 
for the Y value will be cleared and shown as missing value. 

15.4.3 Moving a Data Point 

You can move individual data points in the graph. Understand that when you do this, you are changing the plot 
and the underlying data: 

1. Select Data: Move Data Points (you'll be warned that you are about to change your data). 

2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag; 

or use the arrow keys. 

3. Click the Pointer button on the Tools toolbar or press ESC to exit the Move Data Points mode. 

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell. 

15.5 Mathematics 

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume 
calculations. 

15.5.1 Basic Math 

Tool Name Description Menu Entry 

• Simple Column 

Math/Simple 

Curve Math 

• Normalize 

Columns/Curves 

• Average Multiple 

Curves 

• Differentiate 

• Perform basic calculations on 

worksheet columns or XY data plots 

 

New for Origin 
2020: 

• The 

Normalize 

Columns 

dialog box 

(rnormalize) 

now supports 

treating the 

entire input 

Analysis:Mathematics 
(workbook, graph) 
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range as a 

single 

dataset. 

• Simple 

Curve Math 

(mathtool) 

supports 

defining a 

custom 

formula using 

input and 

reference 

datasets. 

 

• Subtract 

Reference Data 
• Subtract one dataset from another Analysis:Data 

Manipulation 
(workbook, graph) 

• Subtract Straight 

Line 

• Subtract a straight line defined 

graphically by clicking in the graph. 
Analysis:Data 
Manipulation (graph) 

• Vertical Translate 

• Horizontal 

Translate 

• Use a Gadget to graphically translate 

curve(s) in vertical or horizontal. 
Analysis:Data 
Manipulation (graph) 

• Differentiate 

Gadget 

• Perform differentiation over a region 

of interest in a graph  
Gadgets:Differentiate... 
(graph) 

• Intersect Gadget 
• Calculate the intersection points of 

two or more data plots.  
Gadgets:Intersect... 
(graph) 

• Vertical Cursor 

• Read and tag X, Y coordinate values 

for data plots across multiple graphs 

that share the same X axis.  

Gadgets:Vertical 
Cursor... (graph) 
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• Set Column Values 
• Use formulae to set/transform 

worksheet column values 
Analysis:Mathematics 
(workbook) 

• Inverse • Generate pseudo inverse of a matrix Analysis:Mathematics 
(matrix) 

• Median Filter 

• Special Filter 

• Custom Filter 

• Apply median/special/custom filter to 

a matrix 
Analysis:Mathematics 
(matrix) 

15.5.2 Interpolation 

 

Tool Name Description Menu Entry 

• Interpolate Gadget 

• Perform interpolation 

over a region of 

interest 

Gadgets:Interpolate... 
(graph) 

• Interpolate/Extrapolate 

• XYZ Trace Interpolation(3D 

Graph) 

• Trace Interpolation(2D 

Graph) 

• Perform 

interpolation/extrapola

tion on a group of XY 

data. 

• Perform periodic 

interpolation on XYZ 

worksheet data 

• Perform interpolation 

on cycle or periodic 

curves 

Analysis:Mathematics 
(workbook, graph) 

• Interpolate/Extrapolate Y 

from X 

• 3D Interpolation 

• Perform 

interpolation/extrapola

tion on a group of XY 

data to find Y at given 

X values. 

• Perform 2D 

interpolation on a 

group of XYZ data to 

Analysis:Mathematics 
(workbook) 
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find Z at given XY 

values w/ choice of 8 

methods. 

• Perform interpolation 

with a 3D function on 

XYZ dataset. 

• 2D Interpolate/Extrapolate 

• Perform 2D 

interpolation/extrapola

tion for a matrix 

Analysis:Mathematics 
(matrix, graph from 
matrix) 

15.5.3 Area/Volume Calculation 

 

Tool Name Description Menu Entry 

• Integrate Gadget 

• Perform integration over a 

region of interest in a 2D 

Graph 
Gadgets:Integrate... (graph) 

• 2D Integrate Gadget 

 

• Calculate max height, 

volume, FWHM (X,Y) for a 

contour or image graph 

created from matrix or XYZ 

worksheet data (OriginPro 

Only).  

Gadgets:2D Integrate... 
(graph) 

• Integrate(2D Graph) 

• Polygon Area(2D 

Graph) 

• XYZ Surface Area 

(3D Graph)  

• Perform integration on 

input data 

• Calculate the area of 

enclosed plot regions 

• Calculate the area of the 

XYZ surface 

Analysis:Mathematics 
(workbook, graph) 

• 2D Volume Integrate 

 

• Matrix Surface Area 

• Calculate the volume 

beneath the matrix surface 

from zero plane 

Analysis:Mathematics: 2D 
Volume Integrate (matrix, 3D 
graph from matrix) 
or 
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 • Calculate the area of the 

matrix surface 

Analysis:Mathematics: 
Matrix Surface Area (matrix, 
3D graph from matrix) 

15.6 Curve Fitting 

 

A number of free Apps designed for various curve-fitting operations are available from 
the OriginLab File Exchange. To find and install these Apps click Analysis: Fitting: 
Find Apps. The App Center will open, displaying only fitting-related Apps. Browse 

available Apps and click the Download and Install button to install an App. 

15.6.1 Linear and Polynomial Fit 

 Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. The menu entries 
of these tools are listed in the table below. All are available for both workbook or plotted data. 

Tool Name Menu Entry 

• Linear Fit Analysis:Fitting:Linear Fit 
or 
Gadgets:Quick Fit (graph) 

• Fit Linear with X Error  
Analysis:Fitting:Fit Linear with X Error 

• Multiple Linear Regression 
Analysis:Fitting:Multiple Linear Regression 

• Polynomial Regression Analysis:Fitting:Polynomial Fit 
or 
Gadgets:Quick Fit (graph) 

15.6.2 Nonlinear Curve Fit 

  You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-
defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some 
tools are available only in OriginPro. 

The table below summarizes available nonlinear curve fitting tools: 

Tool Name Features Menu Entry 

• Quick Fit Gadget 
• Fit a region of interest in a 

graph interactively 

• Fit with built-in or user-

Gadgets:Quick Fit (graph) 
or 
Gadgets:Quick Sigmoidal 
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defined fitting functions 

• Fit one or multiple datasets 

• Choose from a number of 

pre-defined analyses (incl. 

Linear, Cubic, Peak and 

Sigmoidal). 

Fit (graph) 

• Nonlinear Curve 

Fitting 

• Fit with built-in or user-

defined fitting functions 

• Fit one or multiple datasets 

• Compare fit, multiple 

parameter sets 

• Global fit with parameter 

sharing 

• Global fit, parameter 

sharing with multiple 

functions  

• Fit with replicas 

• Advanced options including 

bounds, constraints, fit 

control 

Analysis:Fitting:Nonlinear 
Curve Fit (workbook, graph) 

• Implicit Curve Fitting 

 

• Fit with implicit functions 

• Orthogonal Distance 

Regression (ODR) 

algorithm 

Analysis:Fitting:Nonlinear 
Implicit Curve Fit (workbook, 
graph) 

• Surface Fit  
• Fit data from a matrix or 

worksheet XYZ columns 

Analysis:Fitting:Nonlinear 
Surface Fit (workbook, graph) 
or 
Analysis:Nonlinear Matrix 
Fit (matrix) 

• Fitting Function 

Builder 

• Create or edit user-defined 

fitting functions 
Tools:Fitting Function 
Builder 

• Fitting Function 
• Manage fitting functions by 

categories 

Tools:Fitting Function 
Organizer 
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Organizer • Move or share functions 

between categories 

• Simulate 

• Simulate a curve from a 

given function 

• Simulate a surface from a 

given function  

Analysis:Fitting:Simulate 
Curve 
or 
Analysis:Fitting:Simulate 
Surface 

• Fit Comparison  

• Compare fit results from 

two datasets using one 

function function 

• Compare fitting results for 

one dataset using two 

fitting functions 

Analysis:Fitting:Compare 
Datasets 
or 
Analysis:Fitting:Compare 
Models (workbook, graph) 

• Fit and Rank 

Functions  

• Compare fit results of two 

or more functions for a 

single dataset 

Analysis:Fitting:Rank 
Models (workbook, graph) 

15.7 Peak Analysis 

 

 

A number of free Apps designed for peak analysis are available from the OriginLab File 
Exchange. To find and install these Apps click Analysis: Peaks and Baseline: Find 
Apps. The App Center will open, displaying only peak-fitting related Apps. Browse 

available Apps and click the Download and Install button to install an App. 

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find 
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro. 

The table below summarizes various built-in tools available for peak analysis: 

Tool Name Features Menu Entry 

• Quick Peaks Gadget 

• Perform peak analysis over 

a region of interest  

• Create baseline 

• Subtract baseline 

• Find peaks 

Gadget:Quick Peaks (graph) 
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• Integrate peaks 

• Fit peaks 

• Multiple Peak Fit 
• Pick multiple peaks 

• Fit peaks 

Analysis:Peaks and 
Baseline:Multiple Peak Fit 
(graph, workbook) 

• Peak Analyzer 

• Create baseline 

• Subtract baseline 

• Find peaks 

• Integrate peaks 

• Fit multi-peak datasets 

 

• Fit baseline  

• Find hidden peaks 

• Compute many peak 

characteristics  

Analysis:Peaks and 
Baseline:Peak Analyzer 
(graph, workbook) 

• Batch Peak Analysis 

• Use a theme file created 

using Peak Analyzer tool 

• Perform batch peak 

analysis on multiple 

datasets 

Analysis:Peaks and 
Baseline:Batch Peak 
Analysis Using Theme 
(graph, workbook) 

15.8 Signal Processing 

Origin provides signal processing tools for many tasks, including producing signal transforms, 
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro. 

You may refer to the tables below for the signal processing tools and their menu entry. 

15.8.1 Signal Transforms 

Tools Menu Entry 

• FFT Gadget 
Gadgets:FFT... (graph) 

• Fast Fourier Transform (FFT) 
Analysis:Signal Processing:FFT 
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• Inverse Fast Fourier Transform 

(IFFT) 

(workbook, graph) 

• 2D FFT  

• 2D IFFT  Analysis:Signal Processing:FFT (matrix) 

• Short-time Fourier Transform 

(STFT)  
Analysis:Signal Processing:STFT 
(workbook) 

• Hilbert Transform  Analysis:Signal Processing:Hilbert 
Transform (workbook, graph) 

• Image Profiling Plot>2D:Profile:Image Profile(matrix, 
worksheet, XYZ data) 

15.8.2 Filtering 

   

Tools Menu Entry 

• FFT Filter Analysis:Signal Processing:FFT Filters 
(workbook, graph) 

• 2D FFT Filter  Analysis:Signal Processing:2D FFT 
Filters (matrix) 

• IIR Filter Design  Analysis:Signal Processing:IIR Filter 
(workbook, graph) 

15.8.3 Smoothing 

  

Tools Menu Entry 

• Smooth Analysis:Signal Processing:Smooth 
(workbook, graph, matrix) 
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15.8.4 Correlation 

 

Tools Menu Entry 

• Correlation Analysis:Signal Processing:Correlation 
(workbook, graph) 

• 2D Correlation  Analysis:Signal Processing:2D 
Correlation (matrix) 

15.8.5 Convolution 

 

Tools Menu Entry 

• Convolution Analysis:Signal 
Processing:Convolution (workbook, 
graph) 

15.8.6 Wavelet Analysis (Pro Only) 

 

Tools Menu Entry 

• Continuous Wavelet Transform 

• Discrete Wavelet Transform 

(Decomposition) 

• Inverse Discrete Wavelet 

Transform (Reconstruction) 

• Multi-Scale Wavelet 

Decomposition 

• Smoothing 

• Noise Removal 

Analysis:Signal Processing:Wavelet 
Analysis (workbook, graph) 

• 2D Wavelet Decomposition 

• 2D Wavelet Reconstruction 
Analysis:Signal Processing:Wavelet 
Analysis (matrix) 

15.8.7 Other Advanced Tools (Pro Only) 
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Tools Menu Entry 

• Rise Time Gadget 
Gadget:Rise Time (graph) 

• Decimation Analysis:Signal Processing:Decimation 
(workbook, graph) 

• Coherence Analysis:Signal Processing:Coherence 
(workbook, graph) 

• Envelope Curves Analysis:Signal Processing:Envelope 
(workbook, graph) 

15.9 Image Processing 

 Origin provides a collection of tools for basic image processing. These tools are accessible from the Image 

menu when a matrix book is active. Some tools are only. 

The tools are organized in the following sub-menus: 

• Image:Adjustments 

• Image:Arithmetic Transforms 

• Image:Conversion 

• Image:Geometric Transforms 

• Image:Spatial Filters 

15.10 Topics for Further Reading 

• Analysis Dialog Boxes: Specifying Your Input Data 

• Outputting Analysis Results 

• Recalculation of Analysis Results 

• Generating Analysis Report Sheets 

• Performing Math Operations on Datasets 

• Linear/Polynomial Regression 

• Nonlinear Curve Fitting 

• Peak Analysis using Origin 

• Signal Processing 

• Image Processing and Analysis 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-SpecifyInput
http://www.originlab.com/doc/Origin-Help/AnalyDialog-OutputResult
http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
http://www.originlab.com/doc/Origin-Help/Mathematics
http://www.originlab.com/doc/Origin-Help/Linear-Polynomial-Regression
http://www.originlab.com/doc/Origin-Help/Nonlinear-Curve-Fit
http://www.originlab.com/doc/Origin-Help/PeakAnalysis
http://www.originlab.com/doc/Origin-Help/Signal-Processing
http://www.originlab.com/doc/Origin-Help/Image-Processing-Analysis
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16 Statistics 

16.1.1 Apps for Statistics 

Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related 
graphing and analysis Apps have been added to OriginLab's File Exchange and more tools are being released 
all the time. 

A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no 
extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to 

show only statistics-related Apps. Browse available Apps and click the Download and Install button to 
install an App. 

 

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive 
"wizard" interface to help you choose appropriate statistical tests and to tell you where to 
find them in your Origin software, or -- if the test is available from another add-on App -- 
where to find it on the OriginLab File Exchange. 

 
 

16.2 Basic Statistics 

Origin provides several tools and methods to compute basic statistics on data from either the worksheet or 
from a graph.   

16.2.1 Basic Statistics on Worksheet 

Descriptive Statistics Menu entry with worksheet active 

• Statistics on Columns 

• Statistics on Rows Statistics:Descriptive Statistics 

• Cross Tabulation and Chi-Square  
Statistics:Descriptive Statistics 

https://www.originlab.com/Fileexchange/index.aspx?t=App&v2=NULL&o=UpdateOnDESC&s=statistics
https://www.originlab.com/Fileexchange/index.aspx?t=App&v2=NULL&o=UpdateOnDESC&s=statistics
https://www.originlab.com/fileexchange/index.aspx
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Frequencies/Counts  

• Frequency Counts 

• 2D Frequency Counts/Binning 

• Discrete Frequency 
Statistics:Descriptive Statistics 

Distribution  

• Normality Test 

• Distribution Fit  Statistics:Descriptive Statistics 

Relationship  

• Correlation Coefficient  

• Partial Correlation Coefficient  Statistics:Descriptive Statistics 

Detecting Outliers  

• Grubbs Test 

• Dixon's Q-test Statistics:Descriptive Statistics 

  

 

Origin 2019 added Conditional Formatting of worksheet cells, with which you could apply 
color to worksheet cells based, among other things, on worksheet statistics. For more 
information, see Conditional Formatting. 

 
 

http://www.originlab.com/doc/Origin-Help/conditional-format
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16.2.2 Descriptive Statistics on Graph 

Origin provides a couple of gadgets to explore and summarize data plotted in graphs. 

Descriptive Statistics Menu entry with graph active 

• Cluster Gadget  
Gadgets:Cluster... 

• Statistics Gadget 
Gadgets:Statistics... 

16.2.3 Statistics on Selected Range 

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data 
plot(s) in a graph. 

16.2.3.1 Status Bar 

 Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and 
you can use the CTRL key to select non-contiguous groups of cells.  

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar. 

Right click on the status bar to customize what quantities to display. 

 

16.2.3.2 Command or Script Window 
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Statistics, Report to Script/Command Window 

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in 

a graph. 

2. Open the Command Window or the Script Window from the Windows menu, and type one of these 

commands, then press ENTER: 

 

stats 

moments 

quantiles 

With the Command Window, the results are typed out below the command line. With the Script Window, you 
will need to issue an additional command to return your results: 

 

stats; 

stats.=; 

Note: For more information, please refer to the:  

Help: X-Function > X-Function Reference > Statistics 

16.3 Statistical Graphs 

 

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template 
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information. 

Graph Type 
Plot Menu 
Category 

Box Charts: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half 
Box, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box 
Charts. 

Statistical 

Box Charts, Violin Plots, etc., Grouped: Grouped Scatter - Indexed Data, 
Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped 
Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data, 
Grouped Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped 
Half Violin - Indexed Data, Grouped Half Box - Indexed Data. 

Categorical 

http://www.originlab.com/doc/X-Function/ref/Statistics
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Violin Plots: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile, 
Violin with Stick, Split Violin, Half Violin. 

Statistical 

Histograms: Histogram, Histogram + Rug, Histogram + Probabilities, Multi-
Panel Histogram, Distribution, Distribution + Rug, Histogram with Labels, 
Stacked Histograms, Marginal Histograms. 

Statistical 

 

Population Pyramid 

 

Statistical 

2D Kernel Density Contour 

Heatmap: Heatmap, Heatmap with Labels, Split Heatmap Contour 

Contour - Categorical Z Contour 

Cluster Plots Categorical 

Probability: Probability Plot, Q-Q Plot. Statistical 

Pareto and QC Chart: Pareto Chart - Binned Data, Pareto Chart - Raw Data, 
QC (X-bar R) Chart. 

Statistical 

Scatter Matrix Statistical 

Trellis Plot: Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot Categorical 

Parallel Plot: Parallel Plot, Parallel Sets, Parallel Index. Categorical 

 
The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs. 

Graph Type Menu Entry 

• Means Plot 

• Means Comparison 

Plot 

Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA 
 

Statistics: ANOVA: One-Way Repeated Measure ANOVA  



UserGuide 

258 

• Survival Curve 

• One Minus Survival 

Curve 

• Hazard Curve 

• Log Survival Curve 

Statistics: Survival Analysis: Kaplan-Meier Estimator  

• Scree Plot 

• Component Plot Statistics: Multivariate Analysis: Principal Component Analysis  

• Dendrogram 

Statistics: Multivariate Analysis: Hierarchical Cluster Analysis  

 

The drawing of dendrograms (aka 
"phylogenetic trees") is completely 
revamped for Origin 2020. The tree is now 
customizable, including the ability to 
distinguish nodes by color, to break out 
nodes as separate graphs, and to draw 
circular variants of the dendrogram. 

 

• Classification 

Summary Plot 

• Classification Fit 

Plot 

• Canonical Score 

Plot 

Statistics: Multivariate Analysis: Discriminant Analysis  

• ROC Curve 

Statistics: ROC Curve  

16.4 Comparing One, Two or More Groups 

Origin provides parametric and non-parametric tests to compare one, two, three or more groups. 

16.4.1 Parametric Hypothesis Tests 

Feature Menu Entry 

• One-Sample t-Test 

• Two-Sample t-Test 

• Pair-Sample t-Test 

Statistics: Hypothesis Testing 
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• One-Sample Test for Variance  

• Two-Sample Test for Variance  

• One-Sample Proportion Test  

• Two-Sample Proportion Test  Statistics: Hypothesis Testing 

• Two-Sample t-Test on Rows  

• Pair-Sample t-Test on Rows  Statistics: Hypothesis Testing 

16.4.2 ANOVA 

 

Feature Menu Entry 

• One-Way ANOVA 

• Two-Way ANOVA 

• Three-Way ANOVA 

• One-Way Repeated-Measures ANOVA  

• Two-Way Repeated-Measures ANOVA  

(Supports both Balanced and Unbalanced data) 

Statistics: ANOVA 

16.4.3 Non-parametric Tests  

 

Feature Menu Entry 

• One-Sample Wilcoxon Signed Rank Test 

• Paired-Sample Wilcoxon Signed Rank Test 

• Paired-Sample Sign Test 

• Mann-Whitney Test 

• Two-Sample Kolmogorov-Smirnov Test 

• Kruskal-Wallis ANOVA 

• Moods Median Test 

Statistics:Nonparametric Tests 
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• Friedman ANOVA 

Notes:  

Multiple nonparametric tests can be run simultaneously. (Accessible from the 

Statistics:Nonparametric Tests menu ) Available options are: 

• (NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test 

• (NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test 

• (NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov 

Test 

16.5 Advanced Statistics 

Several additional tools are available in OriginPro. 

16.5.1 Multivariate Analysis  

 Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from 
your data. 

Feature Menu Entry 

• Principal Component Analysis 

• K-Means Cluster 

• Hierarchical Cluster 

• Discriminant Analysis 

• Canonical Discriminant Analysis 

• Partial Least Squares 

Statistics:Multivariate Analysis 

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the 

Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System) 

menu. 

16.5.2 Survival Analysis  

 OriginPro includes widely used survival tests to quantify survivorship in a population. 

Feature Menu Entry 

• Kaplan-Meier Product-limit Estimator Statistics:Survival Analysis 
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• Comparing Survival Curves 

• Cox Proportional Hazards Model 

• Weibull Fit Model 

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator 

feature. 

16.5.3 Power and Sample Size  

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in 
designing experiments. Origin can compute the power of the experiment for a given sample size and can also 
compute the required sample size for given power values. 

Feature Menu Entry 

• One-Proportion Test 

• Two-Proportion Test 

• One-Sample t-Test 

• Two-Sample t-Test 

• Paired-Sample t-Test 

• One-Variance Test 

• Two-Variance Test 

• One-Way ANOVA 

Statistics: Power and Sample Size 

16.5.4 ROC Curve  

 ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two 
methods that are used to discriminate between diseased and healthy cases. 

Feature Menu Entry 

• ROC Curve 
Statistics: ROC Curve 

16.6 Topics for Further Reading 

• Statistics on Worksheet Columns 

• Statistics on Worksheet Rows 

• Descriptive Statistics 

• Statistics Charts, General 

• Appendix 2 - Origin Graph Types 

http://www.originlab.com/doc/Origin-Help/Statistics-on-Columns
http://www.originlab.com/doc/Origin-Help/Statistics-on-Rows
http://www.originlab.com/doc/Origin-Help/Descriptive-Statistics
http://www.originlab.com/doc/Origin-Help/Statistics-Chart
http://www.originlab.com/doc/Origin-Help/GraphTypes
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• Appendix: Statistical Graph Types by Template 

• Normality Testing 

• Distribution Fit 

• Parametric Hypothesis Testing 

• ANOVA 

• Nonparametric Tests 

• Multivariate Analysis 

• Survival Analysis 

• ROC Curves 

• Power and Sample Size Tests 

• LabTalk Supported X-Functions: Statistics 

http://www.originlab.com/doc/Origin-Help/Statistical-Graph
http://www.originlab.com/doc/Origin-Help/Normality-Test
http://www.originlab.com/doc/Origin-Help/Distribution-Fit
http://www.originlab.com/doc/Origin-Help/Hypothesis-Testing
http://www.originlab.com/doc/Origin-Help/ANOVA
http://www.originlab.com/doc/Origin-Help/NonPara-Test
http://www.originlab.com/doc/Origin-Help/Multivariate-Analysis
http://www.originlab.com/doc/Origin-Help/Survival-Analysis
http://www.originlab.com/doc/Origin-Help/ROC-Curve
http://www.originlab.com/doc/Origin-Help/Power-Sample-Size
http://www.originlab.com/doc/LabTalk/guide/LT-Supported-XFs
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17 How to Handle Repetitive Tasks 

  

  

17.1 Recalculation 

 All Analysis and most data processing dialog boxes in Origin include a Recalculate  control. This control 
allows you to tie output operations to the source data. When Recalculate is set to Auto or Manual, changes to 
the source data will trigger an update of the output (pending, in the case of Manual). This allows you to 
analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature 
is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.    

 

 
The Recalculate control has three modes: 

None 

• No lock is displayed in the output. 

• Changes to the input data will not result in an update of the output. 

Auto 

• An auto green lock is displayed in the output columns and graphs that contain plots 

of the output data. 

• The output will be automatically updated when input data is changed. 

• You can also click on a lock icon and open the dialog to make changes to the analysis 

settings, including changing the Recalculate mode. 

http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
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Manual 

• A manual green lock is displayed in up-to-date output columns, and graphs that 

contain plots of the output data. 

• A yellow lock indicates that input data have changed and recalculation operations are 

pending. You can trigger updates individually by clicking on a yellow lock and selecting 

Recalculate from the shortcut menu; or you can update all pending operations by 

clicking the yellow Recalculate button on the Standard toolbar. 

• You can also click on a lock icon and open the dialog to make changes to the analysis 

settings, including changing the Recalculate mode. 

 
Tips for Managing Recalculation Operations 

• A left-click on the lock displays a menu that provides multiple options including changing analysis 

parameters, opening source data sheet, switching to result sheets, and controlling the status of the 

operation such as switching from manual update to auto update. 

• The Standard toolbar displays a Recalculate button that shows green when all project operations 

are up-to-date and yellow when there are recalculation operations pending. If you have opened a 

project and you see that the Recalculate button is yellow, understand that calculations are pending and 

that the data and data plots you see in the project may not be up-to-date. 

• If a lock icon appears dark gray in color , this indicates that the associated operation was performed in 

OriginPro and the window or project has been opened in standard Origin. The operation is not supported 

by standard Origin and to modify or re-run the analysis, you will need to locate a computer with an 

OriginPro license. 

• If a lock icon appears red something has occurred which makes recalculation operations impossible. 

Such conditions are rare but would occur if, for instance, you passed a project file that included a user-

defined curve fitting operation to a colleague but failed to pass along your user-defined fitting function. 

• Having many recalculation operations in your project file can slow down your work. You can block 

recalculation -- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block 

Recalculation from the popup menu. Placing a block on pending recalculations places a yellow "block" 

icon on each associated operation in the chain. Placing a block on up-to-date calculations places a 

green "block" icon on each operation in the chain. To remove the block, click on the "block" icon and 

clear the check mark (Note that clicking the yellow Recalculate button on the Standard toolbar does 

not update blocked operations). 

• You can hide the lock icons on your graph window by clicking on the graph and, from the main menu, 

choosing View: Show and clearing the check mark beside Lock Icons. This does not remove associated 

operations from the graph window. To re-display the icons, repeat the procedure. 

17.2 Dialog Themes 

https://www.originlab.com/index.aspx?go=Products/Origin
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  Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file. 
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files 
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different 
settings. 

Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save 
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme 
that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box. 
The same Themes are also available from the main menu item associated with the analysis dialog box. 

 

 

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu. 

 

Tutorial: Saving and Re-using a Dialog Theme 

1. Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder. 

2. Highlight column B and select Analysis: Fitting: Linear Fit... 

3. In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit 

Options) and set the Fix Intercept at edit box to 0. 

4. Click the button next to the Dialog Theme control and select Save as .... In 

the Theme Name box, enter Zero Intercept and press OK. Press OK again to 

close the Linear Fit dialog box and perform the analysis. FitLinear1 and 

FitLinearCurve1 result sheets are added to the workbook. 

5. Return to the source data and highlight column C. Select Analysis: Fitting: 

Linear Fit from the menu. You will see a fly-out menu with multiple Theme options 

including the Zero Intercept Theme you saved in the previous step. 

6. Select your saved Theme. The analysis is automatically performed on Column C 
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using the settings saved in the Theme. Note that the dialog box does not open. 

 

Tips for Working with Themes: 

• Hold the SHIFT key while clicking on your Theme in the main menu and the 

associated dialog box will open with settings from the selected Theme loaded into 

the dialog box. 

• The default Theme Origin shipped for an analysis is called System Default. Click 

the fly-out menu in the analysis dialog and choose System Default to load it. 

• Click the fly-out menu in the analysis dialog and choose Delete to delete Themes 

you have created, including any customized <default> Theme. 

• The customized <default> Themes for all analysis dialogs are saved in 

Defaults.xml in the User Files Folder. Deleting this file restores system default 

settings of all analysis dialogs. 

17.3 Workbook and Project Templates 

  There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here 
are a few typical scenarios. 

• You might import data files that always have a fixed number of columns with a repeating pattern of 

column designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing 

these files (File: Save Template As). 

• You regularly import data files of similar structure and you perform some routine graphing and analysis 

operations on the data, then generate a report using a worksheet or a workbook embedded Notes window. 

This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template). 

• You perform some operations similar to those described in the previous example but you can't save your 

workbook as an Analysis Template because all data are cleared from the workbook on saving and that 

would destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to 

clear only the imported data and save your workbook as a window file (File: Save Window As). This 

preserves the sheet of reference data and like the Analysis Template, saves analysis and graphing 

operations with the workbook. 

• You routinely import data, do some analysis and generate a report and would like to make use of the 

Analysis Template concept (as in the second bullet point), but you have multiple windows in your project, 

including Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis 

Template won't do the job. In this case, you could save the project without data by "cloning" it (File: 

Clone current Project). 

17.3.1 The Workbook as Template 

The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices 
and notes, plus scripts, variables and other supporting data.  

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
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You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your 
needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU) 
or as an Analysis Template (OGWU): 

• Workbook (OGWU): Choosing File: Save Window As saves all workbook content. 

• Analysis Template (OGWU): Choosing File: Save Workbook as Analysis Template clears all data 

columns that are used in analysis operations in the workbook before saving. Operations are preserved as 

are data that are not associated with analysis operations. 

• Template (OTWU): Choosing File: Save Template As saves the structure of the workbook, plus any 

analysis operations that exist in the workbook, but all data including data that are not associated with 

these analysis operations, are cleared. 

 

A collection of workbook templates can be opened using the New Workbook dialog 
box, that opens when you start Origin. You can customize existing templates and save 
them as your default workbook template. 

 

Tutorial: Creating an Analysis Template 

1. Start with a new workbook and import the file Samples\Curve 

Fitting\Sensor01.dat. 

2. Select column B and use the Analysis: Fitting: Linear Fit and open the Linear 

Fit dialog. 

3. Change the Recalculate drop-down to Auto. 

4. Click the Fit Control tab, check the Fix Intercept check box and enter 0 in the 

Fix Intercept at edit box. 

5. Click OK to close the dialog and perform the linear regression. 

6. Answer "Yes" to the prompt and switch to the FitLinear1 report sheet to view 

results including plots of the best-fit line and residuals. 

7. Now switch back to the original data sheet and import the file Samples\Curve 

Fitting\Sensor02.dat. The analysis results will be automatically updated with this 

new data. Note that you could continue to use this workbook for importing other 

data; or you could right-click the workbook window title and choose Duplicate 

without Data to create a new workbook with the linear fitting operation saved 

into it. This allows you to import new data into the new workbook and thus save a 

project with multiple such workbooks, if desired. 

8. With the workbook active, select the menu File: Save Workbook as Analysis 

Template..., and in the dialog that opens, give a name such as Linear Fit of 

Sensor Data and click Save. 

9. Choose File: Recent Books and select the template that was saved in the 

previous step. The workbook will open and the data sheet will be empty. 

10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet 

(1st sheet). The analysis results will be automatically generated upon data import. 

http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
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Analysis Templates can include summary sheets and custom report sheets (worksheet-based or HTML), 
making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine 
analyses. When used in combination with the the Batch Processing tool, you can repeat a set of analyses 
and graphing operations for any number of data files and create a PDF summary report for each one, as it is 
processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the 
workbook as a template for handling repetitive tasks. 

 

Notes windows now support HTML. Notes windows can be added to the workbook 
(right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML 
reports into your Analysis Templates. For more information, see HTML Reports 
From Notes Windows. 

17.3.2 The Project as Template 

The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks 
-- particularly when your analyses and graphing tasks can't be resolved within a single workbook. 

The basis steps of creating a "project template" are as follows: 

1. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project. 

2. After saving the project, choose File: Clone current Project. A small dialog opens for configuring 

your cloned project:  

 

o Add Data Connectors: Check this box to add Data Connectors from the cloned project to your 

saved project. Each cloned worksheet will have a connection to the original worksheet in the 

saved project. If you plan to import data from other similar files in your cloned project, you 

should CLEAR this box. 

o Clear All: Clear imported data only. Analysis operations are preserved in the cloned project. 

o Clear Imported Data and Delete Calculations: Clears imported data and analysis operations. 

3. Click OK to to create your cloned project. Selected data are cleared and the cloned project named 

UNTITLED is added to the workspace. 

4. Name and save the cloned project and when you are ready to process more data files, you can open it and 

import new data: 

o If your analysis and graphing operations are linked to a particular set of data files that are 

periodically updated, you don't necessarily need to use Connectors. You can simply re-import the 

files (Data: Re-import... or Re-import Directly). 

http://www.originlab.com/doc/Tutorials/Create-Custom-Report
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/Origin-Help/Batch-Processing
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
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o If your operations are linked using Data Connectors, click the Connector icon and from the 

popup menu choose Import (this Connector only) or Import All (all Connectors in the book). 

o One possible scenario is that you store all of your data in a single Origin project file. If you have 

added Data Connectors from your cloned project, to your original project then you can selectively 

import just the data that you need to perform your graphing and analysis operations. When you 

have finished, you can save the file to a new name, preserving your cloned project for re-use. 

17.4 Batch Plotting 

 Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two 
sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data 
files. In addition to these two procedures, batch plotting can also be performed programmatically using 
LabTalk script or Origin C. 

17.4.1 Duplicating Graphs with Data from Other Books/Sheets/Columns 

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot 
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new 
data. There are two cases: 

• If you have plotted a graph with a single dataset and customized it, and want to clone the graph with 

other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New 

Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph. 

• If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you 

want to clone the graph with other worksheets or workbooks with a similar data structure: Choose 

Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books. 

Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook 

you want to plot from. Each worksheet or workbook will be plotted as a new graph. 

 

Tutorial: Duplicating a graph with data from other books/sheets 

1. Press the New Project button on the Standard toolbar. 

2. Press the Import Wizard button on the same toolbar. This opens the Import 

Wizard dialog box. 

3. Click the browse button to the right of the File box. Browse to the Import and 

Export folder and select the files S15-125-03.dat, S21-235-07.dat, and S32-

014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog box, 

press Finish. The files are imported into three separate workbooks. 

4. Drag and select all three Y columns in one of the workbooks, then select the menu 

item Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one 

shared X axis. Make any desired customizations to the graph. 

5. Right-click on the title bar of the graph window then select Duplicate (Batch 

Plotting) shortcut menu. 

http://www.originlab.com/doc/User-Guide/Import-Data
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6. In the dialog box that opens, press Ctrl and select the other two 

workbooks/worksheets then press OK. Two more graphs are created with data 

from the other two workbooks/worksheets. 

17.4.2 The Workbook as a Template for Processing Multiple Files 

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting, 
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your 
workbook and save the workbook as a template. Using this template you can process multiple files, creating a 
workbook for each file and its corresponding graph. 

 

Tutorial: Creating graphs from multiple data files 

1. With a new workbook active, choose Data: Import From File: Single ASCII and 

import the file Sensor01.dat from the Samples\Curve Fitting subfolder of the 

Origin installation folder. 

2. Highlight column B and create a line+symbol graph of the data. 

3. Double click on the X axis to open the Axis dialog. Make sure Scale tab is active. 

Select both Horizontal and Vertical on the left panel and set Rescale to be Auto 

and click OK. This will ensure that the graph scale will update automatically on 

data change. 

4. In the workbook, right-click on the worksheet tab and select Add Graph as 

Sheet, then select the graph created above and click Done. This will add a new 

workbook sheet containing an embedded graph. 

5. Switch to the data sheet, double-click on the tab rename the sheet as Data. 

6. Select the Worksheet: Clear Worksheet menu item to clear the data in this 

sheet. Note that this step is optional. Clearing the data will reduce the size of the 

template saved in the next step. 

7. Select the File: Save Window As... menu item, assign a name such as Sensor 

Data and Graph and press Save. 

8. Now we can use this template to process multiple files. Select the File: Batch 

Processing... menu item. 

9. In the dialog box that opens set the Batch Processing Mode to Load Analysis 

Template, then set the Analysis Template control to point to your saved 

template. 

10. Set Data Source to Import from Files and select the three files Sensor01.dat, 

Sensor02.dat, and Sensor03.dat from the Samples\Curve Fitting subfolder. 

11. Set the Data Sheet(s) to Data and set Result Sheet to <none>. 

12. Press OK to close the dialog box. You should get three workbooks with the data 

imported into the first sheet and the graphs updated in the 2nd sheet. To further 

edit any of the graphs, double-click on the graph to pop up an editable page. 
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If processing of your data requires some custom import settings, those settings will be 
saved to the data sheet by default. Settings thus saved to the sheet will be used for 

import when batch processing of multiple files using the workbook as a template. 

17.5 Batch Analysis 

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots. 

17.5.1 Analyzing Multiple Datasets in Dialogs 

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets. 
Report sheets created by these dialog boxes include a summary table listing the parameter values for each 
dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an 
external sheet for further processing. 

 

Two improvements to copying tables in Origin 2020: 

• Copy All Open Tables: Collapse unwanted tables in an Analysis Report Sheet, 

then right-click and choose this option from the shortcut menu. Unformatted data 

can then be pasted to MS Excel or other applications. 

• Copy Table (HTML,EMF): Right-click on any table node in the Analysis Report 

Sheet; or double-click on a result table in a graph, then right-click and choose this 

option from the shortcut menu. Data can be pasted as an HTML table or editable 

EMF (if supported by target application). 

  

 

Tutorial: Fitting Multiple Datasets 

1. Open a new workbook and import the file Samples\Curve Fitting\Multiple 

Gaussians.dat from the Origin installation folder. 

2. Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4. 

3. Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit... 

menu item to open the NLFit dialog box. 

4. Select Gauss from the Function drop-down list, then press the Fit button to perform 

fitting and close the dialog box. 

5. Switch to the FitNL1 report sheet. You will see a table named Summary which lists 

the fit parameters and fit statistics for each dataset. 

 



UserGuide 

272 

 

In the NLFit report sheet, click on the downward-pointing arrow button next to the 
table named Summary and select Create Copy as New Sheet. This will create a copy 
of the table in which all cells are linked to the report. Any updates/changes to the fit 
will automatically update the values in this copied sheet. This sheet can then be used to 
plot or to perform secondary analysis on the fit parameters. 

 

When enumerating something like a column Long Name, as you did in step 2 above, 
enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-
right corner. When the cursor becomes a "+", drag across the other cells and the 
contents of the first cell will be extended to those cells. 

 

17.5.2 Using Gadgets for Analyzing Multiple Curves 

 Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a 
data range of interest, switching from one dataset to another, and setting various preferences specific to the 
analysis being carried out. 

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in 
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings, 
and generating a table of results across all datasets. 

 

 

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves 

 
 
 

1. Open the project "Samples\Spectroscopy\Absorbance Spectra.opj". 

2. With the graph window active, choose Gadgets: Integrate from the main menu. 

3. In the dialog that opens, click the Baseline tab and set the Mode drop-down to 

Straight Line. 

4. Click the Output tab, expand the Output Quantities to node, and check Append to 

Worksheet. Press OK to close the dialog box. 

5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI 

and resize this object to cover the entire data range plotted in the graph. The integrated 

area will be displayed as a shaded region. 

6. Click the arrow button at the top right of the ROI object, then choose Change Data 

from the context menu and switch to another plot in the layer. Check that the current 

baseline setting works for other curves in the layer. 

7. Click the arrow button , select New Output for All Curves (N) or simply press the 

"N" key. Integration is performed on all curves. 

8. Click the arrow button again and select Go to Report Worksheet. Expand the 
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report worksheet to view the integration results from all curves. 

 

17.5.3 Batch Analysis Using an Analysis Template 

    The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template. 
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook, 
and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template 
to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and 
additionally, to create a summary table with select analysis parameters and other metadata that you have pre-
configured in your analysis template. 

 

Tutorial: Batch Analysis of Multiple Files using an Analysis Template 

1. From the main menu, choose File: Batch Processing.... This opens the Batch 

Processing dialog box. 

2. Set Batch Processing Mode to Load Analysis Template. 

3. Press the browse button to the right of the Analysis Template box and select the 

file Sensor Analysis.OGW located in the Samples\Batch Processing subfolder 
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under your Origin installation folder. This Analysis Template contains multiple sheets 

set up for linear regression analysis, reporting, and summary tables. 

4. Set Data Source to Import From Files, then click the browse button to the right 

of the File List and from the Samples\Curve Fitting subfolder under your Origin 

installation folder, select files Sensor01.dat, Sensor02.dat and Sensor03.dat . 

5. Set Dataset Identifier to File Name, Data Sheet to Data, and Result Sheet to 

Result, thus selecting the appropriate sheets in the Template. 

6. Uncheck Delete Intermediate Workbook. 

7. Click OK to close the dialog box and process the three files (you can answer "No" to 

the prompt). You will obtain three books with the data, analysis results, and report for 

each file, and a fourth book containing the summary table of analysis results from all 

files. 
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Saving the initial workbook as an Analysis Template is optional. You can simply save 
the Origin project (.opj) and next time replace the data in your workbook to update all 
results and graphs. The Batch Processing tool also has an option to repeatedly import 
files into the active window, allowing you to simply re-use an existing book within a 
project (which contains all desired analysis and graphs) as an on-the-fly template for 
the batch analysis. 

 

You can batch generate analysis reports using a custom MS Word template, with the 
option of outputting a PDF and/or an MS Word file for each report. For Origin 2020, 
you can opt to combine reports into a single file. For information on Batch Processing 
with a Word Template for Reporting, see this tutorial. 

17.6 Repeating Analysis on Other Datasets or Data Plots 

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the 
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the 
lock associated with the operation. 

• In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y 

columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet. 

• In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will 

repeat the analysis for all other data plots in the graph page, even if the plots are in different layers. 

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of 
only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can 
be repeated on all other datasets. 

 

Tutorial: Smoothing Multiple Columns in a Worksheet 

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty 

workbook. 

2. Select column B and click Analysis: Signal Processing: Smooth to open the 

smooth dialog box. 

3. Accept the defaults and press OK to perform smoothing. A new column will be 

added with the smoothed data. 

4. Click on the lock in the output column and select Repeat this for All Y 

columns. Three more columns of smoothed data with same settings will be 

generated from the data in columns C thru E. 

17.7 Repeating Analysis Using Data Filters 

 

http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
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Prior to Origin 2020, data filters needed to be reapplied manually after data import. 
Now, they will automatically run on import. 

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This 
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce 
multiple graphs from the same source data using different filtering conditions. The filtered data can also be 
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions. 

Selected columns from the source data sheet can be copied to create child sheets where the filter condition 
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is 
updated, all child sheets, associated graphs and analysis results will automatically update using their 
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to 
the parent sheet at any time. 

The image below displays the source workbook with data for several makes of automobiles. Two books were 
created with a subset of columns and a data filter to restrict the data to a particular make of automobile. 
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the 
two filters. 

 

 

Tutorial: Locking a Filter Condition on Copied Columns 

1. Import the file Samples\Statistics\Automobile.dat 

http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/copy-columns
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2. Click on the Make column, then click the Add/Remove Data Filter button on 

the Worksheet Data toolbar. 

3. Click on the filter icon that was added to the column, and uncheck all makes 

but Honda (Hint: Clear the check mark beside Select All, then check Honda and 

click OK). 

4. Hold down the CTRL key and click and select the Make, Power and Engine 

Displacement columns. Next, right-click and select Copy Columns to... from the 

shortcut menu. 

5. In the dialog that opens, expand Copy Labels and place a check mark beside 

Long Name and Units, then click OK. A new worksheet will be added to the 

workbook and it will contain only the Honda data, for Power and Engine 

Displacement. 

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the 

Origin workspace to create a separate workbook. 

7. Click on any of the locks in the columns of this copied sheet, and select 

Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you 

change the filter condition in the original data sheet, this copied sheet will not be 

affected. 

8. You can now return to the original automobile book, click the filter icon and 

change the filter condition to Toyota, then use Copy Columns to to create another 

worksheet. 

9. Highlight column B in your Honda workbook,then right-click and choose Set As: X. 

Do the same for the Toyota book. 

10. Highlight column C in your Honda workbook and click the Scatter button on 

the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots 

of Power vs Engine Displacement, one for Honda, one for Toyota. 

11. Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the 

dialog defaults and click OK. Do the same for the Toyota graph. A linear fit is 

performed for both datasets and an Analysis Report Sheet is generated for each. 

12. Compare the fitting results for the two automobile makes. 

 

By default, when there is a data filter on a column that is input for an analysis 
operation, filtered data (hidden rows) are ignored in the analysis. To include hidden 
rows, click on an analysis lock icon and set Ignore Hidden Rows = No. 
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17.8 Automating Tasks Using Programming 

 

In addition to the above mentioned methods for automating tasks  using the interface, graphing and analysis 
features can also be accessed programmatically from either the LabTalk scripting language or from Origin C. 
Access to Graph Themes and templates, and Analysis Templates can be programmed. You can set up some of 
the procedure manually by first creating the templates using the graphical user interface, and then write your 
code to call the templates as needed. 

You can get a broad look at what programming options are available in Origin by browsing the Programming 
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter. 

17.9 Topics for Further Reading 

• Recalculation of Analysis Results on Data or Parameter Change 

• Saving Analysis Dialog Settings as a Theme 

• The Theme Organizer, Dialog Themes 

• Analysis Templates 

• Batch Processing and Analysis Templates 

• Copy and Paste Operations 

• Using Data Filters to Obtain Different Views of Your Data 

• Analysis Report Sheets and Columns 

• Tutorials: Batch Processing 

• Video: Batch Processing 

http://www.originlab.com/doc/User-Guide/Programming-in-Origin
http://www.originlab.com/doc/User-Guide/Programming-in-Origin
http://www.originlab.com/doc/Origin-Help/AnalyDialog-Recalculate
http://www.originlab.com/doc/Origin-Help/Dialog-Theme
http://www.originlab.com/doc/Origin-Help/ThemeRef-ThemeOrganizer
http://www.originlab.com/doc/Origin-Help/Analysis-Templates
http://www.originlab.com/doc/Origin-Help/Batch-Processing
http://www.originlab.com/doc/Origin-Help/Copy-Paste-Oper
http://www.originlab.com/doc/Origin-Help/Wks-DataFilter
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols
http://www.originlab.com/doc/Tutorials/Batch-Processing
http://originlab.com/index.aspx?go=Support/VideoTutorials&ss=chm&pid=1559
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• Tutorial: Combine Quick Peaks Gadget with Peak Analyzer 

http://www.originlab.com/doc/Tutorials/Combine-QuickPeakGadget-PA
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18 Publishing and Export 
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18.1 The Master Page 

The Master Page feature is used to add one or more common objects to exported or printed graphs. Use 
the master page to add a set of properties and objects -- a custom background, a company logo, text labels, 
images, etc. -- to selected graph windows in your project. 

 

To make use of this feature, you must first create your Master Page. The Master Page should contain only the 
properties and objects that you want to display on your selected graph windows: 

1. From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting 

this menu item, you will be asked to switch to the project root folder. 

2. Customize the Master Template. Note that the comments that show beneath the Save Master Template 

button are "hidden" and will not be applied to your graph windows. 

3. Click the Save Master Template button. When you save, the Master Template will be saved to the 

User Files Folder as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User 

Files\Master.otpu"). 

 
Things to know about the Master Page: 

• Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension 

to All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio. 

• If you create a graph and modify page size, then choose File: New: Master Page and load a Master 

Template into the workspace, the Master Template will be loaded with the page dimensions of your 

modified graph page. 

• The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape 

and portrait). 

• When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of 

the same aspect ratio, or to all graphs of the same orientation (portrait or landscape). 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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• Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation 

and vice versa. 

• Edit: Copy Page normally copies an Origin graph object to the Clipboard. When the object is pasted into 

an MS Word document and the user subsequently double-clicks on the graph object, the graph opens in 

an OLE instance of Origin, where it can be edited. When Master Items are present on the graph, Edit: 

Copy Page places an image object (EMF) on the Clipboard, not the usual graph object. 

• Send Graphs to PowerPoint does not support Insert Graphs as Embedded Object if the graph 

contains Master Items (see previous bullet). Insert Graphs as Picture does support Master Items. 

• There is a mechanism for selectively excluding Master Items in your exported or printed page. Any object 

that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open 

an arrow object's Properties dialog and on the Programming tab, rename "Arrow" to 

"NoExport_Arrow"). 

• When you customize and save your Master Page to the User Files Folder, the next time you choose File: 

New: Master Page, you load your customized template. 

• If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove 

the check mark. The exported graph will still contain the Master Items (they just won't show in the 

workspace). 

• If you want to remove Master Items from a graph in both the workspace and exported images, click 

Format: Page..., Display tab and clear the Use Master Items check box. 

 

You could use the Text tool to add project and system information to your Master 
Template as static text objects, but since the idea is to build a template for re-use, 
consider "soft-coding" information in your text labels. To learn more, see these topics: 

• Substituting Variable Values in Text Labels] 

• LabTalk String Registers 

18.2 The Export Margin Offsets Dialog Box 

By default, the margins of your copied or exported graph are determined by the Margin Control in Copy 
Page Settings group of Preferences: Options (Copy actions) or the Export Settings branch of Export 

Graphs (Export actions). You can interactively modify the default margins using the Export Margin Offsets 
Dialog Box. 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/LinkVar-TextLabel
http://www.originlab.com/doc/LabTalk/guide/String-registers
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
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1. Click on the graph window (to activate) and choose Edit: Export Margin Offsets. This opens the Export 

Margin Offsets dialog. 

2. Drag the green selection handles that appear at the page margins; or enter values into the dialog edit 

boxes and click Apply. 

18.3 Fit Page to Layer and Layer to Page 

There are two small dialog boxes -- one new, one that has been part of Origin for some time -- that are also 
helpful for removing white space or placing a margin around your graph before exporting: 

• Fit Page to Layers: Choose Graph: Fit Page to Layers to open the pfit2l dialog box. 

• Fit Layers to Page: Choose Graph: Fit Layers to Page to open the gfitp dialog box. 
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Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph 
aspect ratio. You can view the documentation for both to decide which might work best for you but basically it 
boils down to whether you need to keep a particular page size (Fit Layers to Page); if not, either tool should 
do the job. 

18.4 Copying and Pasting Graphs to Other Applications 

   There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word): as a 
Picture, or as an Origin Graph Object. 

1. Click on your Origin graph to activate it, then ...  

o To copy the graph as a picture, choose Edit: Copy Graph as Picture. 

o To copy the graph as an editable Origin graph object, choose Edit: Copy Page. 

2. In your target application choose Paste or press CTRL+V. 

 
When you paste as a picture, the graph is inserted as an image. In MS Word, for instance, double-clicking on 
the image launches Word's picture-editing tools, but this method does not allow for further graph edits in your 
Origin software. 

When you paste as a graph object, you can later double-click on the object in the target application to launch a 
new instance of Origin. The graph, and any associated data sheets, will be available for editing. After editing, 
use Origin's File: Exit and Return to... menu item to update the embedded object, close Origin and return to 
the host application. 

 

There are several settings in the Options dialog (Preferences: Options, Page tab) 
that determine how the graph page is copied. These settings work with the newer 
Export Margin Offset dialog, to determine such things as graph copied size and page 
margins. Please review the Copy Page Settings and the Export Margin Offset dialog 
box. 

http://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
http://www.originlab.com/doc/Origin-Help/Export-Margin_Offsets
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Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs 

in Other Applications 

18.5 Organizing Your Graphs for Presentation or Export 

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide 
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder 
and arranging them there: 

• Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph 

window, to a new Favorites subfolder (visible in Project Explorer). 

• When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the 

corresponding dialog box or (2) set slide order following this procedure. 

 

If you are preparing a manuscript for publication, you may want to see FAQ-441 How 
do I export graphs with exact size and resolution as specified by publishers? 

18.6 Exporting Graphs and Layout Pages to an Image File 

  

To export a graph or a layout page as an image file, select the menu File:Export Graphs. This will open the 
expGraph dialog box. The expGraph dialog offers options for customizing the output size by scaling the 
height or width of the page, various settings that are specific to the chosen file format, options for naming the 
output file, and options to perform batch exporting of multiple pages. 

Origin supports 14 export file formats: 

Raster Formats BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF; 

Vector Formats CGM, DXF, EPS, EMF, PDF, WMF 

As is the case with most Origin dialog boxes, you can save your custom settings to a Theme file for repeat use. 
Once you have customized your settings: 

• Click the arrow to the right of Dialog Theme and choose one of the Theme save options. 

• Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme 

then becomes available for loading your last used settings and you can access it from the expGraph 

dialog box or from the File: Recent Exports menu item. 

http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
http://www.originlab.com/doc/Quick-Help/Set-ExpGraph-Size-Resolution
http://www.originlab.com/doc/Origin-Help/Dialog-Theme
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Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or 

Layout Page to an Image File 

 

Exporting to raster formats such as TIFF and specifying a high resolution (e.g. 600 DPI 
or above) can produce a very large output file size, depending on the page size. To 
reduce the file size, consider reducing the size of the page before export. Consult with 
your publisher to determine the actual width of a print column in your journal. 

 

You can export multiple graphs, such as all graphs in a folder or all graphs in a project file, 
to a single, multi-page PDF file. Choose File: Export Graphs and open the Export Graphs 
dialog box. Set Image Type to Portable Document Format (*.pdf) and Select 
Graph(s) to one of the following options and you will see a checkbox for Export as multi-
page PDF file. 

 

18.7 Send Graphs to PowerPoint 

  You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations 
of embedded objects and Master Items, explained above). Graphs inserted as an embedded objects can be 
edited, as needed, in your Origin software. Double-click on the graph in PowerPoint to open the graph in an 
OLE instance of Origin. 

http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
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There are two Send Graphs to PowerPoint tools in Origin -- the older, built-in tool and a newer Send 
Graphs to PowerPoint App that is installed with more recent versions of the Origin software. As most users 
favor the App, it will be discussed here. Documentation of the older, built-in tool, is found here and here. 

To launch the App, click the Send Graphs to PowerPoint icon in the Apps Gallery, docked to the right-side or 
your Origin workspace. If you do not see the Apps Gallery, click View: Apps or press ALT + 9. 

 

Tutorial: Send Graphs to PowerPoint 

1. Run Origin and open the sample file <Origin EXE 

Folder>\Samples\Graphing\Column and Bar.opju. 

2. Click on the Send Graphs to PowerPoint App icon to run the App. 

3. Click the Select Graphs button and choose Specified. 

4. Select all except Graph5B in the left panel and move them to the right panel by 

clicking the in the middle of the dialog box. Click OK. A scrollable list of 

graphs is added to the left panel in the App. 

5. Set Insert Graph as = Picture. 

6. Set the Slide Margin top dimension as 8% and leave the others as 0. 

7. Set Title Line = Top of Slide, and Title = Window Long Name. 

8. Set Starting Slide Index = 3 and Slide Mode = Start New. 

9. Use the browse button beside Load File/Template (optional) to load the file 

<Origin EXE Folder>\Samples\Import and 

Export\Column_Plots_in_Sample_OPJ.pptx. 

10. Specify a Save File as (optional) output path for the resulting PPTX file. 

 

There is also a Send Graphs to Word App that is available free-of-charge from the 
OriginLab File Exchange. This App is particularly useful for batch export of graphs to a 
book-marked MS Word document. 

18.8 Slide Show of Graphs 

  Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide 
show can be started in two ways: 

• Right-click on any folder in Project Explorer and select Slide Show of Graphs... 

or 

• Click the Slide Show of Graphs button on the Standard toolbar. 

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub 
folders, etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph 
window of the currently displayed slide). 

http://www.originlab.com/doc/X-Function/ref/pef_pptslide
http://www.originlab.com/doc/Tutorials/Send-Graphs-to-PPT
https://www.originlab.com/fileExchange/details.aspx?fid=238
http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
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Tutorial: Slide Show of Graphs 

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open 

the sample project. 

2. Click on the Slide Show of Graphs button in the Standard Toolbar. 

3. Accept default settings in the dialog that opens, and press OK to start the slide 

show. 

4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides. 

18.9 Creating Movies 

    Origin provides a Video Builder tool, accessible from the Open Video Builder button on the 
Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame 
at a time to a video (.AVI) file. 

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data 
and then writing out the graph as a frame in the video, at each step during the computation. 

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation 

 

For specific examples of programmatically created movies, including Origin Projects and 
code, please visit www.originlab.com/animation. 

18.10 Exporting Worksheets and Matrices 

18.10.1 Exporting Worksheets 

 

Export your Origin workbook as a multi-page MS Excel workbook. 

 
With a worksheet active, the File: Export menu item provides the following options: 

• ASCII, NI TDM (TDM, TDMS), and Sound (WAV)  

This option is available only for sheets containing data columns, and is not available when report sheets 

such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data 

from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored. 

• Excel  

http://www.originlab.com/doc/Origin-Help/Graph-Animation
http://www.originlab.com/animation


UserGuide 

290 

Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM). 

Note that analysis report sheets with their hierarchical tables, and things such as embedded graphs and 

images, are not exported to the Excel file. Analysis results that are output to regular Origin worksheets 

are exported. 

• As Multipage PDF File  

This option is available only on sheets with data columns, and not for report sheets. Use the View: 

Page Break Preview Lines menu item to view the vertical and horizontal page break lines that 

determine which columns and rows will be included in each page of the export. Floating or embedded 

graphs placed in the worksheet will be included in the exported image. 

• As Image File  

This option is available on both data and report sheets. In the dialog that opens, you can select whether 

to export the entire sheet, visible area, or selection. Image file formats including PDF are supported. 

Floating or embedded graphs placed in the worksheet will be included in the exported image. 

• As PDF File†  

This option is available for both data and report sheets. In the dialog that opens, you can opt for 

exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in 

the exported PDF. 

 

When creating a custom report from a worksheet that combines data, numeric results 
and graphs, the best option is to export the entire sheet as a PDF file, or export the 
sheet as a multi-page PDF file. 

18.10.2 Exporting a Matrix 

  Origin matrix data can be exported in these two formats: 

• ASCII  

This will create an ASCII file of the data contained in the active matrix object. 

• Image  

This option will export the image view of the active matrix object, as a raster file. 

Note: For more information, please refer to the:  

Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and 

Matrices 

http://www.originlab.com/doc/Origin-Help/Export-Wks-Mat
http://www.originlab.com/doc/Origin-Help/Export-Wks-Mat
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18.11 HTML Reports from Notes Windows 

Beginning with Origin 2019b, you can create HTML reports using Notes windows. You can build your HTML 
report using placeholders that link to report sheet elements such as metadata, statistical results or graphs. The 
resulting HTML report can be printed or exported; or it can be incorporated into your Analysis Template. 

Reports can also be created using Markdown syntax instead of HTML. If Markdown syntax is used, optional 
HTML syntax can be also included for advanced customization. 

To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most 
things, the more proficient the user is, the easier it will be to create professional-looking output. However, the 
skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance. 

 

 
The basic steps of creating reports using an Origin Notes window, are as follows: 

1. Create your project to include graphing and analysis results. 

2. Click the New Notes button to add a Notes window. 

3. From the menu, choose HTML: Syntax, then choose HTML or Markdown (Hint: You can toggle between 

text/view and markup modes by pressing CTRL+M and you can choose the default syntax by setting 

LabTalk System Variable @NPS). 

4. You can write your code in the Notes window's markup mode or you can use a text editor such as 

Notepad++, then copy and paste it to your Notes window. If you have no experience with HTML or 

Markdown, you may want to load samples by activating your Notes window and clicking HTML: Load 

Samples (HTML = ".html", Markdown = ".md"). 

5. You will likely want to incorporate graphing and analysis results from the current project, into your report. 

The simplest way to do this is to insert "placeholders" for each Origin object that you intend to include in 

your report, into your code. These placeholders can be named using any string that makes sense to you 

and they should be enclosed in double-curly braces (e.g. {{MyR-SquareValue}}). 

6. Right-click on the Notes window title bar and choose Edit Placeholders. Placeholders that you have 

incorporated into your code will be picked up and added to a Placeholders worksheet in the workbook. 

The sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B -- 

is blank and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing 

results, etc.) that you want to include in your report. 

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://blog.originlab.com/publishing/creating-html-reports-and-documents-in-origin-2019b
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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7. For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if it is 

a numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click 

and choose Copy, or press CTRL+C on your keyboard). 

8. Return to the Placeholders sheet, right-click in column B, beside the associated placeholder and choose 

Paste-Link. This associates your placeholder with the intended Origin object. 

9. If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab 

in your Analysis Template and choose Add Notes as Sheet. This inserts your Notes window into 

workbook and you can now choose File: Save Workbook as Analysis Template. 

 

When a Notes window is active, you can click the HTML menu and load a sample HTML file 
into the Notes window. 

 

18.11.1 Using Your HTML Report 

As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once 
completed, you can do various things with your HTML report, including: 

• Print to hard-copy or to PDF (File: Print). 

• Export the window as a webpage (HTML: Export to Webpage). 

• Click the embed button in the upper-right corner of the Notes window to embed the content into your 

workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis 

Template). 

18.12 Topics for Further Reading 

• The Preferences: Options Page Settings 

• Pasting or Embedding Graphs in Other Applications 

• Exporting Your Graph or Layout Page to an Image File 

• Which Image Format Should I Choose? 

• The Export Graph Dialog Box 

• Send Graphs to PowerPoint 

• Send Graphs to PowerPoint Dialog Box Settings 

• View Graphs as a Slide Show 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Paste-Embed-OLE
http://www.originlab.com/doc/Origin-Help/ExpGraph-to-Image
http://www.originlab.com/doc/Origin-Help/ExpGraph-Format-Comprison
http://www.originlab.com/doc/Origin-Help/ExpGraph-Dailog
http://www.originlab.com/doc/Origin-Help/Project-Explorer
http://www.originlab.com/doc/X-Function/ref/pef_pptslide
http://www.originlab.com/doc/Origin-Help/Project-Explorer
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• The Slide Show of Graphs Dialog Box Settings 

• Creating Graph Animations 

• Printing Graphs, Layout Pages and Analytical Results 

• The Print Dialog Box 

• The Print Options Dialog Box 

• Copying and Pasting Graphs inside Origin 

• Inserting Graphs and Images into Worksheet Cells 

• Tutorial: Creating a Custom Report Sheet 

• Using the Layout Page Window 

• Creating a Master Page Layout for Graphs 

http://www.originlab.com/doc/X-Function/ref/pef_slideshow
http://www.originlab.com/doc/Origin-Help/Graph-Animation
http://www.originlab.com/doc/Origin-Help/Print-Graph-Layout-AnalyResult
http://www.originlab.com/doc/Origin-Help/Print-Dialog
http://www.originlab.com/doc/Origin-Help/Print-Option-Dialog
http://www.originlab.com/doc/Origin-Help/CopyPaste-Graph
http://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
http://www.originlab.com/doc/Tutorials/Create-Custom-Report
http://www.originlab.com/doc/Origin-Help/ExpGraph-Layout-Window
http://www.originlab.com/doc/Origin-Help/Master-Page-Layout
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19 Apps for Origin 

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping 
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-
powerful graphing and analysis capabilities. 

Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be 
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition, 
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as 
a means to create and distribute tools for your company or user-community. 

As of the fall of 2019, most Apps can be downloaded for free. Note that some Apps require OriginPro; this will 

be denoted in the App description by the symbol. 

19.1 Where Do I Find Apps? 

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using 
your web browser, it easier to obtain and manage your Apps using the App Center. 

The App Center provides "one stop" App installation and maintenance: Browse and download new and 
popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab 
website. 

To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery. 

 

 
What to look for in the App Center: 

• Installed Apps with an Up-to-date Version icon beside them are up-to-date. 

• Apps with a clickable Download and Install icon beside them are not installed. Click 

this icon to install. 

• Apps with an Update icon beside them have an available update that you can install. 

Click this icon to update. 

• Click the New and Popular tab for a quick look at what's available. Download and update 

Apps. 

• Click the Search tab to find Apps by Category and Minimum Version. Download and 

update Apps. 

• The Updates tab will display a red circle icon when there is an update to one or more 

installed Apps. Improvements and bug fixes are listed for each. 

http://www.originlab.com/doc/APP/App-Development
http://www.originlab.com/fileExchange/
http://originlab.com/fileexchange/index.aspx
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19.1.1 Finding Apps from Analysis and Statistics Menus 

 

You can find Apps for these specific applications by clicking Find Apps... from Origin's 
main menu: 

• Analysis: Fitting 

• Analysis: Peaks and Baseline 

• Statistics 

These menu commands open the App Center Search tab to show only relevant Apps that are currently 

available from OriginLab's File Exchange. Click the Download and Install button beside an App, to 
install the App. 

 

19.2 How Do I Install Apps? 

If you install your Apps using the Download and Install button in the App Center dialog, you don't 
need to do anything else. The App is automatically downloaded and installed. When App updates become 

available, you can use the Update button to update an installed App. 

If your workstation does not have internet access: 

If your workstation does not have internet access, you will need to find a computer that does (does not need 
to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it 
back to your workstation. 

1. On the internet-connected computer, open a browser window and browse to 

originlab.com/fileExchange. 

2. Browse the list of Apps, go to the App's description and download page, then click the Download File 

button and copy the file to your thumb-drive. 

http://originlab.com/fileexchange/index.aspx
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3. Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer, 

browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App 

file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or 

drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps 

Gallery, docked to the right side of your Origin workspace. 

 
If you have questions, click the How to Install link below the Download File button on the File Exchange 
App description and download page. 

 

19.3 How Do I Run an App? 

• Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin 

workspace. 

• App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be 

operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps 

Gallery). 

• If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by 

double-clicking on it in the Apps Gallery. 

• If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View: 

Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the 

OriginLab workspace or to an existing toolbar. Close the dialog box. 

• Specific usage information is available on the description and download page for each App. 

19.4 Managing Your Apps 

You can use the App Center in combination with the Apps Gallery, to manage your Apps: 

• Use the App Center (discussed above) to add and update Apps, search for Apps, request an App or 

submit a review of an App. 

. To launch the App Center, click the Add Apps button in the Apps Gallery. 

http://www.originlab.com/doc/User-Guide/Origin-Interface
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• Organize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and 

choose New Tab, then double-click on the default tab name and give the tab a meaningful name. 

Additionally, you can Sort Apps alphabetically or by installation date. 

 

• A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery 

and choosing from the shortcut menu. 
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• Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App 

installation folder. 

• Uninstall: Uninstalls the selected App. 

• Open the File Exchange Page: Opens the App's description and download page on the 

OriginLab File Exchange. 

• Send Feedback...: Opens a Rate App dialog box to provide feedback. 

• Show All (user-added tabs only): Shows Apps from all Gallery tabs on the active tab. 

• Refresh: Refreshes the tab view. 

• Tab Views: Place or remove the check mark beside the App to determine on which Gallery 

tab(s) the App shows. 

19.5 Will I be Notified When Updates are Available? 

Several things will indicate when an App update is available: 

• A red dot appears in the upper-right corner of the Add Apps icon in your Apps Gallery (docked to 

the right side of your workspace). Additionally, the red dot shows on individual Apps when an update 

is available.  
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• In the App Center, the App will appear with a clickable "update" icon beside it.  

 

• The App Center Updates tab will show a red dot with a number indicating how many App updates are 

available. The tab will list updated Apps and allow you to apply updates for individual Apps or all 

Apps.  

 

 
To update an App: 

• Click the Update icon that appears next to the App in the App Center. 

• Right-click on the App in the Apps Gallery and choose Download and Install Update 

• Click the Update All Compatible button that appears on the Updates tab in the App Center; or click the 

"update" icon beside each App. 

• Right-click on the Add Apps icon in the Apps Gallery and choose Update All. 

 

 

You can verify the version of an installed App by hovering on the App in your Apps 
Gallery. 

19.6 How Do I Uninstall an App? 

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the 
shortcut menu. 
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19.7 How Do I Give Feedback on an App? 

OriginLab relies heavily on customer input to improve our software products. We encourage you to give 
feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It 
takes just a few seconds! 

 

19.8 Can I Request an App? 

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if 
you do not program but you find that you need some particular functionality that is not currently a part of the 
Origin product, you can request an App through the OriginLab website. OriginLab is continually building and 
posting new Apps to the File Exchange. 

1. To request an App, open the App Center and click the Request App button in the lower-left corner of the 

dialog box. This opens a web page on www.originlab.com. 

2. Verify that the Your Reason for Contacting Us drop down is set to Request an App. 
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3. Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form. 
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20 Programming in Origin 

  

 

As you gain experience with Origin, you may want to access Origin features programmatically, add your own 
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic 
programming options available in Origin. For more detailed information, see the following Origin programming-
related resources: 

• Programming documentation including guides, language references, and examples are available from the 

Help menu in the product. 

• Online programming documentation is available at www.originlab.com/doc. 

• You can typically locate online programming pages by performing a web search from your browser using 

phrases such as: labtalk importing , originc interpolate, or labview origin send data. 

• An Origin Programming Forum can be found at www.originlab.com/forum. 

• Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your 

Origin software. 

 

20.1 LabTalk 
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   LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can 
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots. 
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis. 

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections 
in a file, and those individual sections can be executed from the user-interface at the command prompt in the 
Script Window or Command Window; from buttons added to worksheets and graphs; from included or 
custom-made toolbar buttons; or from custom menu commands. 

 

The following "mini-tutorial" will demonstrate adding a button object to a worksheet, 

associating a short LabTalk script with the button, then using the button to execute the 
script and perform a basic statistical calculation while writing the results to the 
worksheet. 

1. Run Origin and start a new project by clicking the New Project button on the 

Standard toolbar. 

2. Click Data: Import from File: Single ASCII and browse to the file 

\Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is 

imported into the active worksheet window. 

3. With the worksheet window active, click Format: Worksheet. In the Worksheet 

Properties dialog, click the Size tab and set Gap from Top to 25, then click OK. 

A gap is added to worksheet window. 

4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added 

and type "Add Mean Label Row" into the text object. Click outside the text object 

to exit edit mode. 

5. Right-click on the text label and select Properties.... Choose Programming 

Control tab, set Script Run After to Button Up. Copy and paste the following 

script into the text box: 

6.  

 

wks.userParam1 = 1; 

wks.userParam1$ = "Mean"; 

for (int ii = 2; ii <= wks.ncols; ii++) 

{ 

        range rr = $(ii); 

        Col($(ii))[D1]$ = $(mean(rr),.2*); 

} 
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7. Click OK to apply settings and close the Text Object dialog box. Note that your 

text object now looks like a button. 

8. Click the button. Note that a new header row labelled "Mean" is added to the 

worksheet and the mean value of each column of data is written to the Mean row 

cell above the corresponding column. 

Note: For more information on LabTalk, Origin's built-in scripting language, please consult your 

product documentation at Help: Programming: LabTalk. 

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software. 

20.2 Python 

 Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports 
command line execution from the Script Window, or the running of .py files. To access Origin from Python, you 
can use the supplied PyOrigin module. 

The current embedded Python in Origin is version 3.7.2 and version 2.7.12. 

Note: For more information on integrated usage of Origin and Python, refer to the LabTalk Scripting 

Guide: Help: Programming: LabTalk > LabTalk Scripting Guide > Working with Python. 

Sample files can be found in the \Samples\Python folder of your Origin software. 

 

There is an API for calling Origin from Python. See note under Automation Server, 
below. 

20.3 R 

 Origin supports running R commands in the Origin environment. You can issue R commands in the Script 
Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through 
version 3.6. 

From Origin, you can connect with R in two ways: 

• R. Installed on your local computer. 

• Rserve. Installed on a remote PC. 

Note: For more information on integrating Origin and R, refer to the Origin Help file (R Console and 

Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve 

Objects). 

Sample files can be found in the \Samples\R folder of your Origin software. 

http://www.originlab.com/doc/LabTalk/guide
https://www.python.org/downloads/release/python-372/
https://www.python.org/downloads/release/python-2712/
http://www.originlab.com/doc/LabTalk/guide/work-with-python
http://www.originlab.com/doc/Origin-Help/R-Console-dlg
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/Origin-Help/R-Console-dlg
http://www.originlab.com/doc/Origin-Help/R-Server-dlg
http://www.originlab.com/doc/LabTalk/guide/LT-Running-R
http://www.originlab.com/doc/LabTalk/ref/R-obj
http://www.originlab.com/doc/LabTalk/ref/Rserve-obj
http://www.originlab.com/doc/LabTalk/ref/Rserve-obj
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20.4 Origin C 

 Origin C is a full-featured high-level programming language based on the ANSI C programming language 
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to 
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access 
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script. 

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled 
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and 
manageability for developing and debugging code of greater scope and complexity. 

Origin C also provides access to the NAG Numerical Library functions included in your Origin installation. 
NAG functions provide you with a large selection of algorithms for performing computations ranging from 
simple statistics and Fourier transforms to linear algebra and multivariate analysis. 

 

NAG Library updated to Version Mark 26.1 in Origin 2020. 

Note: For more information on Origin C, please refer to the Origin C documentation: 

Help: Programming: Origin C 

There you will find usage information, a language reference, developer notes, examples, etc. 

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software. 

20.5 X-Function 

 An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function. 
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of 
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-
Functions. Once an X-Function has been created, it can be accessed from anywhere in the interface that allows 
for script execution, such as the script window, toolbar buttons, or custom menu items. 

Note: For more information on X-Functions, please refer to your product documentation that is 

installed with your software: 

Help: Programming: X-Functions 

There, you will find information on creating and using X-Functions, a language reference, and tutorials. 

20.6 Automation Server 

  Origin can be used as an Automation Server. Client applications such as National Instruments™ 
LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and 
can also send commands to be executed within Origin. 

Note: For more information on Origin's Automation Server functionality, refer to the product 

documentation installed with your Origin software: 

Help: Programming: Automation Server. 

http://www.originlab.com/doc/OriginC/guide
http://www.originlab.com/doc/X-Function/guide
http://www.originlab.com/doc/COM
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There you will find examples and language reference information. Sample files can be found in the 

\Samples\COM Server and Client folder of your Origin software. 

20.7 LabVIEW 

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and 
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need 
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and 
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired 
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-
acquisition analysis and presentation. 

Origin ships with a collection of LabVIEW sub-VIs. LabVIEW users can simply incorporate these custom sub-VIs 
in their main LabVIEW application to communicate seamlessly with Origin. 

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed 

with your Origin software: 

Help: LabVIEW VI 

Examples and tutorials are provided. 

20.8 Orglab 

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other 
Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to 
use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their 
frontend software to output data as Origin files. 

The Orglab module is available for both 64-bit and 32-bit systems. To find out more about Orglab and 

to download the Orglab module, go to the Products > Orglab page of www.originlab.com. 

 

http://www.originlab.com/doc/
http://originlab.com/index.aspx?go=Products/Orglab
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21 Customizing Origin 

  

21.1 Customizing Default Settings 

21.1.1 Setting Preferences with the Options Dialog Box 

   The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display, 
file and system paths, text fonts, Origin program opening and closing behaviors, etc. 

To open the Options dialog box: 

• Choose Preferences: Options (any Origin window is active) 

• If you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active) 

 Controls For 

Axis Tab 

• Max number of ticks for numeric and date/time scales 

• Distances from the tick labels to tick marks, axis titles 

• Display of tick labels when using scientific notation, units display in axis 

titles 

Excel Tab 

• Use of default plot assignments 

• Scan datasets for legend text 

• Prompt before opening Excel files by drag-and-drop or saving Excel 

workbooks 

File Locations Tab 

• Set file paths to track last opened, last saved, last exported file 

• Set default path and file extension for importing different file types 

• Define applicable file types for ASCII import dialogs 

Graph Tab 

• Dash lines definitions, line to symbol gap, user-defined symbols, etc. 

• 2D graph anti-aliasing 

• Enable in-place editing of linked and embedded graphs in another 

application 

• Speed mode reminder watermark 

Miscellaneous Tab 

• Proxy server configuration 

• Default templates for ASCII import 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Excel-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Graph-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Misc-Tab
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• Custom date/time formats 

• Enable collapsible menus 

• Use of dataset names in the Origin workspace 

Numeric Format 
Tab 

• Thresholds for displaying numbers in scientific notation 

• Defaults for displayed digits in data and report sheets 

• Radians, degrees or gradians 

• Separators for decimal places 

Open/Close Tab 

• Default window closing behaviors 

• Project startup, backup and autosave options 

• Options dialog save options 

Page Tab 

• Defaults for page size of copy/paste or exported graphs 

Text Fonts Tab 

• Default fonts for text objects 

• WYSIWYG and in-place editing mode behaviors 

• Size and positioning of superscripts/subscripts 

• Footnote size, analysis report sheets 

System Path Tab 

• View/Change the location of the User Files, Autosave, Backup, Unsaved and 

Group folders 

• View locations of system folders (Program, License and Application Data) 

21.1.2 System Variables Dialog 

 System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors. 

Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set 
system variable values. In the dialog, there is a link named System Variables List which opens a web page 
with a list of all system variables, the default value, and description. 

To customize a particular system variable: 

1. Type the system variable name in the first column of Set System Variables, without the @ symbol. For 

example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type: 

DAM 

2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set 

Recalculate to Auto, type the value: 1. 

http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-NumFormat-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-OpenClose-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Page-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-TextFont-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-SysPath-Tab
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
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3. Add optional comments in the third column and click OK to close dialog. 

This modified value will be remembered and applied in every Origin session. 

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script 
Window) by typing @systemVariable= as, for example ... 

@DAM= 

... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the 
Script Window sets the variable value for the current session only. 

21.1.3 3D OpenGL Settings Dialog 

  Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced 
performance including fast drawing, fast rotation and zoom, transparency, and lighting support. 

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's 
support for OpenGL, run Origin and choose Preferences: 3D Open GL Settings.... Look under OpenGL Info 
for information on graphics hardware and the supported version of OpenGL. 

If your graphics hardware is older, you may experience compatibility issues with things such as transparency 
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as 
disabling transparency. The dialog box also provides information on disabling OpenGL. 

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this 
chapter. 

21.2 Customizing Menus 

21.2.1 Collapsible Menus 

Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a 
partial list of menu commands when opening longer menus. If you want to show all commands upon opening, 
click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check 
box. 

 

21.2.2 Custom Menu Organizer 

 If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom 
Menu Organizer you can... 

• Create up to 3 main menus and corresponding sub-menus 

• Assign LabTalk scripts and X-Functions to a menu item 

• Restrict menu item access to specific window types 

• Hide unused built-in menu items, streamlining your Origin workspace 



UserGuide 

312 

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu. 

Then press F1 or click the button in the upper-right hand corner of the dialog box for instructions. 

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from 
the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch 
from one configuration to another. A Default configuration is also available in the fly-out, to revert to default 
menu settings. Configuration files can be shared among colleagues so that you use a common set of menu 
commands. 

21.2.3 Displaying Bitmaps in Menus 

 You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap 
indicates that there is an equivalent toolbar button. 

On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening 
menus. To turn off the display of menu command bitmaps: 

1. Select Preferences: Options to open the Options dialog box. 

2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK. 

 

You can modify the size of the Plot menu icons using the LabTalk system variable 
@PPS. To find out how to change the value of a system variable, see Customizing 
Origin Using System Variables. 

21.3 Customizing Toolbars and Buttons 

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use 
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing 
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.    

21.3.1 Displaying, Hiding or Moving Toolbar buttons 

• Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context 

menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also 

available. 

• Press ALT key and drag a button to any new toolbar location. 

• Press ALT key and drag a button to blank Origin workspace to create a new toolbar. 

• Press ALT key and drag a button to any window till X shows, then release to delete the toolbar. 

21.3.2 Customizing Toolbar Button Appearance 

Use controls on the Options tab (View:Toolbars) to: 

• Show toolbar screen tips and shortcut keys on hover 

• Increase toolbar and toolbar button size 

• Toggle between "flat" or 3D toolbar buttons 

http://www.originlab.com/doc/Origin-Help/Create-Custom-Menus
http://www.originlab.com/doc/LabTalk/ref/sys-var-list
http://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
http://www.originlab.com/doc/Origin-Help/Customization-with-SysVar
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21.3.3 Displaying or Hiding a Toolbar 

• Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to 

dock. 

• In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to 

edge of the Origin workspace to dock. 

• In docked mode, drag the left/top end of a toolbar to reposition. 

• To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check 

boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag 

buttons from the Button Groups tab to add buttons on the new toolbar. 

• Use the Reset, Reset All buttons to reset toolbars. 

21.3.4 Creating New Toolbars with New Bitmap Images 

 Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run 
when click it. Choose View: Toolbars... and create new button group on Button Group tab. 

• Origin ships with three button groups starting with User Defined... with a bunch of bitmap images. 

• Click any button and click Settings... button to link .ogs (Script) file section with the button. 

• Drag the button to Origin workspace to create toolbar button. 

• If you are feeling really creative, Origin allows you to define a new button group that uses your own 16 

color, 16 x 16 pixel bitmaps. 

• Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag 

and drop the OPX file onto Origin workspace to install the toolbar. 

Note: To learn more about creating and exporting user-defined toolbars, see:  

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars 

21.3.5 Add a Custom Button to the Window Title Bar 

 Origin supports adding a system button to the left of the minimize button on the window title bar. A custom 
LabTalk script can then be associated with this button. 

Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:  

Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical 

Listing of Commands > Page 

21.4 Customizing the Status Bar 

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other 
useful information depending upon current action, selection, window, etc. 

• Right-click on Status Bar to customize the display. 
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• Press ALT and drag items along the Status Bar to reorder. 

21.5 Customizing the Origin Workspace 

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages 
Log windows. 

• Right click on the window title bar to specify dock, hide, auto hide, and other settings. 

• When auto-hide is unchecked, double click to float the window. 

• Drag the window title to move or dock to a new location. 

• Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space. 

• Choose View: Toolbars... from main menu. On the Toolbar tab:  

o The Reinitialize button resets menu, toolbar and dockable windows to default settings. 

o The Export button exports the current menu, toolbar and dockable window settings to an .OPX 

file. Drag and drop the OPX file onto another Origin installation to configure the workspace to 

match your customized settings. 

 

Occasionally, an Origin workspace component goes "missing" -- The Data Display 
window, one of the panels in Project Explorer, etc. When this happens, you can reset 
your workspace by choosing View: Toolbars: Reinitialize. The downside has been 
that this also resets workspace customizations and toolbar configurations. Beginning 
with Origin 2018, clicking the Reinitialize button produces an attention message 
asking if you want to restore the workspace settings from your previous version or use 
the 2018 system defaults. 

21.6 Templates and Themes 

  

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to 
the creation of custom settings for repeat use. You can save your custom settings either as templates or 
themes, described briefly in the following sections. 

Note: For detailed information please refer to Origin Help file, see:  

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM) 

21.6.1 Templates 

The Origin template concept applies to graphs, workbooks, matrix books, and Analysis Templates™. Templates 
allow you to choose a set of properties or operations and save those for repeat use. 

21.6.1.1 Workbook Templates and Analysis Templates 

You can save workbook or matrix book settings, such as the number of columns and sheets, column plot 
designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or 
dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files. 
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When the workbook or matrix window is active and you choose File: Save Template As, you save any 
window customizations, minus any data that might exist in the window at the time of saving, to a template 
file. The template file can then be used to create new windows, as needed, for storing and analyzing your data. 

Starting with Origin 2019, you can use the New Workbook dialog box for managing your workbook 
templates, both built-in (System Templates) and custom (User Templates). The dialog allows you to save a 
custom template with a description as well as a preview image, making it easier to keep your various 
workbook templates organized and ready for use. 

You can use the same New Workbook dialog to organize and open your Analysis Templates™. An Analysis 

Template starts from a workbook but differs in that when you save it as an Analysis Template (File: Save 
Workbook as Analysis Template), it is saved with whatever analysis operations and dependent graphing 
operations, exist in the workbook at the time of saving. Analysis Templates are discussed briefly in the Batch 
Analysis section of How to Handle Repetitive Tasks chapter of this guide. 

For a more in-depth discussion of Analysis Templates, see these topics: 

• Analysis Templates. 

• Creating and Using Analysis Templates (tutorial). 

• Batch Processing with Word Template for Reporting (tutorial). 

21.6.1.2 Graph Templates 

Origin ships with over 100 built-in graph templates that are used to create Origin’s many science and 
engineering graph types. Using one of these as a starting point, you can create your own graph, adding more 
layers, setting scale or dimensional relationships between layers, modifying data plot properties, etc., and then 
save your customizations as a user-defined graph template (.OTP) file by clicking File: Save Template as.... 

As with built-in workbook and matrix templates, you cannot overwrite built-in (system) graph templates. If 
you customize a built-in graph template then choose File: Save Template As and save the file with the 
default name, the file is saved to your User Files Folder (UFF). This UFF copy then becomes the default 
template associated with a given Plot menu command or graph toolbar button (e.g. Plot > Basic 2D: Scatter 

or the Scatter toolbar button). To reconnect a built-in template with these menu commands or toolbar 

buttons, delete (or remove) your customized template from your UFF. 

An important subset of graph templates are what are called “cloneable” templates. A cloneable template 
requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once 
created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or 
panels in your graph, then you shouldn't need to recreate this arrangement every time you want to recreate 
such a graph. Cloneable templates are identifiable in the Template Library by the presence of a “sheep” icon 
next to the template name or preview image. When the sheep icon is blue, a cloneable template is compatible 
with the current active workbook/matrix; when gray, the cloneable template is not compatible with the current 
active workbook/matrix. For more information, see the section on cloneable templates in Graph Template 

Basics in your Origin Help file. 

 

A Switch List Mode button is added to Template Library in Origin 2020 so that you 
can toggle between preview and list view. 

http://www.originlab.com/doc/Origin-Help/Wkbk-Saved-with-Template
http://www.originlab.com/doc/Origin-Help/MatBk-Template-What-is-saved
http://www.originlab.com/doc/Origin-Help/New-workbook-dlg
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/Origin-Help/Analysis-Templates
http://www.originlab.com/doc/Tutorials/AnalysisTemplate-Create-Use
http://www.originlab.com/doc/Tutorials/BatchProcess-WordTemplate
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics
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You can Search in the Template Library. Enter a keyword to in the Search Template box 
or clear the field to show all templates. Additionally, now collapse (or expand) individual 
categories when you do not want templates in that particular category. 

 

21.6.2 Themes 

 An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the 
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis 
dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that 
there are tabs for Graph, Worksheet, Dialog, Function and System Increment Lists. 

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you 
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take 
the object properties of one graph and apply them to all the other graphs in the same project. 
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Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose 
Copy Format context menu to copy format. Depending where you right click, the corresponding selection's 
format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste 
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste 
Format... to paste the Format to multiple target graphs. 

 

 

 

The Theme Organizer dialog box is opened from the Preferences menu. Use this dialog to organize your 
graph, worksheet, and dialog themes. 

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple 
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click 
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme, 
allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means 
that it will be applied to new graphs automatically, if the graph template allows a System Theme to override 
template settings (see the Allow System Theme & System Increment Lists to Override check box). 

http://www.originlab.com/doc/Origin-Help/OFileType-Template
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The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of 
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk 
as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the 
dialog, as needed, using the dialog box's Dialog Theme drop-down list. Saving multiple Themes for a dialog 
box allows you to customize your analysis routines from different experiments, when each requires using a 
specific (and unique) group of settings. 
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Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide. 

21.7 Topics for Further Reading 

• The 3D openGL Settings Dialog Box 

• Creating Custom Menus 

• The Custom Menu Organizer 

• Analysis Themes 

• How to Manage Multiple Menu Configuration (.OMC) Files 

• Managing Collapsible Menus 

• The User Files Folder 

  

http://www.originlab.com/doc/User-Guide/Handling-Repetitive-Tasks
http://www.originlab.com/doc/Origin-Help/GraphRef-3DOpenGL-Dialog
http://www.originlab.com/doc/Origin-Help/Create-Custom-Menus
http://www.originlab.com/doc/Origin-Help/CustomMenuOrganizer-Dialog
http://www.originlab.com/doc/Tutorials/AnalysisThemes
http://www.originlab.com/doc/Origin-Help/Manage-Multi-OMCFile
http://www.originlab.com/doc/Quick-Help/collapsible-menu
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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22 Sharing Origin Files 

 

You may want to customize some aspect of your Origin installation and then share your customizations with 
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and 
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard 
filters, LabTalk script files (.ogs), and X-Functions. 

22.1 Drag and Drop Sharing 

 A quick and easy way to share a file with another user is simply to send it as an email attachment. The 
recipient can then drag and drop the file into the Origin workspace. 

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files 
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in 
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a 
dialog opens asking how you want to categorize the new fitting function. 

22.2 Sharing Files with Multiple Machines for Single Users 

If you are a single user and have installed Origin on multiple machines, you can share your custom settings 
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, 
or even a USB flash drive, and use the same UFF path with each installation. 

Note: For information on changing the UFF path, see:  

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder


UserGuide 

322 

User Files Folder 

22.3 Sharing Files with Other Users in a Network 

 You can set up and use a group folder to share files among users. Multiple groups are allowed, and each 
group can have some power user(s) set as the group leader. The group leader can use the Group Folder 
Manager tool to publish custom files for sharing with other group members. When a group member launches 
Origin, the published files will be copied to their Origin automatically and made ready for use. 

 

Origin supports setting multiple group folders, making it possible to share different files 
between groups. A leader machine can set up multiple groups and publish different files 
to different groups. A member machine can belong to multiple groups and thus receive 
all files published by group leaders. 

Note: For information on group folders, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with 

Multiple Clients > Setting a Group Folder Location 

22.4 Packaging Files 

 Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file. 
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as 
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk 
scripts before and after installation. 

To access the Package Manager, click Tools, and then click Package Manager... 

To install the contents of an .opx file, simply drag and drop into the Origin workspace. 

Note: For information on packaging files, see:  

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaging Multiple Files 

as OPX 

22.5 The Origin Viewer 

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of 
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do 
not have Origin installed. 

• The Origin Viewer is distributed as a single EXE file - no installation needed. 

• Available as a 32- or 64-bit Windows application, or as a native Mac application. 

• Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view 

option. 

• Open a graph in a pop-up window for better viewing. 

• Supports viewing and rotating Origin's OpenGL 3D graphs. 

http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder-Location
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
http://www.originlab.com/doc/Origin-Help/FileShare-Pack-OPX
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Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer 
versions 9.6.5 or later allow anyone to save the Unicode-compliant OPJU project files 
to the pre-2018 OPJ format for sharing of projects with users of older versions of 
Origin. 

 
If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin, 
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more 
and download the free EXE. 

22.6 Topics for Further Reading 

• The User Files Folder 

• Attaching Files to the Origin Project 

• Package Manager 

• Setting Up a Group Folder 

• Exporting Custom Button Groups 

• Exporting Toolbar Settings 

• Apps for Origin 

http://www.originlab.com/viewer/
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-Append-to-OPJ
http://www.originlab.com/doc/Origin-Help/FileShare-PackageManager
http://www.originlab.com/doc/Origin-Help/FileShare-GroupFolder-Location
http://www.originlab.com/doc/Origin-Help/Export-Button-Group
http://www.originlab.com/doc/Origin-Help/Export-Toolbar-Setting
http://www.originlab.com/doc/User-Guide/Apps
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23 Origin Toolbars 

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default 
configurations. You will note that some buttons are missing from default toolbar configurations. This may be 
because a button has been deprecated (e.g. Open Excel), because it is duplicated on another toolbar, or 
simply because it is a lesser-used button. 

To add or remove buttons from a toolbar: 

1. Click View: Toolbars to open the Customize dialog box. 

2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the 

workspace. 

3. To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the 

upper right-corner of the toolbar (removes entire toolbar from the workspace). 

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool 
displayed on these "split buttons" carries out the action associated with the displayed tool. Clicking the arrow 
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used. 

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance, 
the 3D-Rotation Toolbar is only available when a 3D graph is active. 

23.1 Standard 

 

Button Description Hotkey Button Description Hotkey 

 

New Project  
 

New Folder  

 

New Workbook  
 

New Excel  

 

New Graph  
 

New Matrix  

 

New Function  
 

New 2D (Function) 
Plot 

 

 

New 2D Parametric 
(Function) Plot 

 
 

New 3D (Function) 
Plot 

 

 

New 3D Parametric 
(Function) Plot 

 
 

New Layout  
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New Notes  
 

Digitize Image  

 

Open Ctrl+O 
 

Open Template  

 

Open Excel  
 

Import Excel Ctrl+E 

 

Save Project Ctrl+S 
 

Save Template  

 

Recalculate Auto  
 

Recalculate Manual  

 

Import Wizard Ctrl+3 
 

Import Single ASCII Ctrl+K 

 

Import Multiple ASCII  
 

Batch Processing  

 

Zoom In and Out by 
Percentage 

 
 

Print  

 

Slide Show of Graphs  
 

Send Graphs to 
PowerPoint 

 

 

Open Video Builder  
 

Refresh F5 

 

Duplicate  
 

Custom Routine  

 

Project Explorer Alt + 1 
 

Object Manager 
Alt + 

8 

 

Results Log Alt + 2 
 

Command Window 
Alt + 

3 

 

Code Builder Alt + 4 
 

Add New Columns  

23.2 Import 
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Button Description Hotkey Button Description Hotkey 

 

Import Wizard  
 

Import Single ASCII  

 

Import Multiple ASCII  
 

Import Excel  

 

Re-import no Dialog 
CTRL + 

4 
 

Re-import with Dialog  

 

Clone Import  
 

Batch Processing  

23.3 Edit 

 

Button Description Hotkey Button Description Hotkey 

 

Cut Ctrl+X 
 

Copy Ctrl+C 

 

Paste Ctrl+V 
 

Undo Ctrl+Z 

23.4 Graph 

 

Button Description Hotkey Button Description Hotkey 

 

Enable/Disable Anti-
Aliasing 

 
 

Rescale Ctrl+R 

 

Rescale X  
 

Rescale Y  
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Rescale XY  
 

Rescale Z  

 

Exchange the X and 
Y axes 

 
 

Enable/Disable Speed Mode  

 

Extract to Layers  
 

Extract to Graphs  

 

Merge  
 

Duplicate with New 
Columns/Sheets/Books 

 

 

Add Bottom-X Left-Y 
Layer 

 
 

Add Top-X Layer  

 

Add Right-Y Layer  
 

Add Top-X Right-Y Layer  

 

Add Inset Graph  
 

Add Inset Graph With Data  

 

Zoom In  
 

Zoom Out  

 

Whole Page     

23.5 2D Graphs 

 

Note that a few plot types do not have a toolbar button. The most complete list of 
Origin plot types is found on the Plot menu. 

 

Button Description Button Description 

 

Line 
 

Horizontal Step 
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Vertical Step 
 

Spline Connected 

 

Scatter 
 

Grouped Scatter - Indexed Data 

 

Scatter Central 
 

Column Scatter 

 

Y Error 
 

X Y Error 

 

Vertical Drop Line 
 

Bubble 

 

Color Mapped 
 

Bubble + Color Mapped 

 

Line + Symbol 
 

Line Series 

 

2 Point Segment 
 

3 Point Segment 

 

Row-wise 
 

Column 

 

Column + Label 
 

Grouped Column-Indexed Data 

 

Bar 
 

Stacked Column 

 

Stacked Bar 
 

100% Stacked Column 

 

100% Stacked Bar 
 

Floating Column 

 

Floating Bar 
 

3D Color Pie Chart 

 

2D B&W Pie Chart 
 

Double Y Axis 
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3Ys Y-YY 
 

3Ys Y-Y-Y 

 

4Ys Y-YYY 
 

4Ys YY-YY 

 

Multiple Y Axes 
 

Stacked Lines By Y Offsets 

 

Colormapped Line Series 
 

Waterfall 

 

Waterfall Y: Color Mapping 
 

Waterfall Z: Color Mapping 

 

3D Waterfall 
 

3D Waterfall Y: Color Mapping 

 

3D Waterfall Z: Color Mapping 
 

Vertical 2 Panel 

 

Horizontal 2 Panel 
 

4 Panel 

 

9 Panel 
 

Stack 

 

Multiple Panels by Label 
 

Trellis Plot 

 

Cluster Plot 
 

Box Chart 

 

Violin with Box 
 

Grouped Box Charts-Indexed 
Data 

 

Grouped Box Charts-Raw Data 
 

Interval Plot 

 

Histogram 
 

Histogram + Probabilities 

 

Multi-Panel Histogram 
 

Marginal Histograms 
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Marginal Boxes 
 

Distribution + Rug 

 

2D Kernel Density 
 

QC(X-bar R) Chart 

 

Pareto Chart-Binned Data 
 

Pareto Chart-Raw Data 

 

Scatter Matrix 
 

Probability Plot 

 

Q-Q Plot 
 

Parallel Plot 

 

Area 
 

Stacked Area 

 

Fill Area 
 

Zoom 

 

Polar theta(X) r(Y) 
 

Polar r(X) theta(Y) 

 

Wind Rose-Binned Data 
 

Wind Rose-Raw Data 

 

Ternary 
 

Piper 

 

Smith Chart 
 

Radar 

 

Vector XYAM 
 

Vector XYXY 

 

High-Low-Close 
 

Japanese Candlestick 

 

OHLC Bar Chart 
 

OHLC-Volume 

 

Line (Stock) 
 

Bridge Chart 
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Template Library   

23.6 Add Object to Graph 

 

Button Description Hotkey Button Description Hotkey 

 

Add Color Scale  
 

Reconstruct Legend Ctrl+L 

 

Add Asterisk Bracket  
 

Add XY Scale  

 

Date & Time  
 

Project Path  

 

New Link Table  
 

Add Bubble Scale  

23.7 3D and Contour Graph 

 

Button Description Button Description 

 

3D Scatter Plot 
 

3D Trajectory 

 

3D Scatter + Error Bar 
 

3D Vector XYZ XYZ 

 

3D Vector XYZ dXdYdZ 
 

3D Tetrahedral 

 

3D Bars 
 

3D Stacked Bars 

 

3D 100% Stacked Bars 
 

XYY 3D Bars 
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XYY 3D Stacked Bars 
 

XYY 3D 100% Stacked Bars 

 

3D Ribbons 
 

3D Walls 

 

3D Waterfall 
 

3D Waterfall Y: Color Mapping 

 

3D Waterfall Z: Color Mapping 
 

3D Color Fill Surface 

 

Multiple Color Fill Surfaces 
 

3D X Constant with Base 

 

3D Y Constant with Base 
 

3D Colormap Surface 

 

Multiple Colormap Surfaces 
 

3D Color Fill Surface with Error 
Bar 

 

3D Colormap Surface with Error 
Bar 

 

3D Wire Frame 

 

3D Wire Surface 
 

3D Colormap Surface with 
Projection 

 

3D Ternary Colormap Surface 
 

Contour - Color fill 

 

Contour - B/W Lines + Labels 
 

Gray Scale Map 

 

Contour Profiles 
 

Polar Contour theta(X) r(Y) 

 

Polar Contour r(X) theta(Y) 
 

Ternary Contour 

 

Image Plot 
 

Image Profiles 

 

Heatmap 
 

Heatmap with Labels 
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23.8 3D Rotation 

 

Button Description Button Description 

 

Rotate counterclockwise 
 

Rotate clockwise 

 

Tilt left 
 

Tilt right 

 

Tilt down 
 

Tilt up 

 

Increase perspective 
 

Decrease perspective 

 

Fit frame to layer 
 

Reset Rotation 

 

Reset 
 

Rotate on any direction 

 

Rotation Angle   

23.9 Worksheet Data 

 

Button Description Hotkey Button Description Hotkey 

 

Statistics on Column(s)  
 

Statistics on Row(s)  

 

Sort  
 

Set Column Values Ctrl+Q 

 

Set All Column Values Ctrl+F5 
 

Row number  
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Uniform random 
numbers 

 
 

Normal random 
numbers 

 

 

Add/Remove Data 
Filter 

 
 

Enable/Disable Data 
Filter 

 

 

Reapply Data Filter     

23.10 Column 

 

Button Description Button Description 

 

Set as X 
 

Set as Y 

 

Set as Z 
 

Set as Y Error Bars 

 

Set as Labels 
 

Set as Disregard 

 

Set as Grouping 
 

Set as Subject 

 

Move to First 
 

Move Left 

 

Move Right 
 

Move to Last 

 

Swap Columns 
 

Add Sparkline 

23.11 Layout 

 



UserGuide 

336 

Button Description Button Description 

 

Add Graph 
 

Add Worksheet 

23.12 Mask 

 

Button Description Button Description 

 

Mask Range 
 

Unmask Range 

 

Change mask color 
 

Hide/Show masked points 

 

Swap mask 
 

Disable/Enable masking 

23.13 Tools 

 

Button Description Hotkey Button Description Hotkey 

 

Pointer  
 

Scale In  

 

Scale Out  
 

Screen Reader  

 

Data Highlighter  
 

Data Reader  

 

Data Cursor  
 

Data Selector  

 

Selection on Active 
Plot 

 
 

Selection on All 
Plots 
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Mask Points on 
Active Plot 

 
 

Mask Points on All 
Plots 

 

 

Unmask Points on 
Active Plot 

 
 

Unmask Points on 
All Plots 

 

 

Draw Data  
 

Text Tool  

 

Annotation  
 

Arrow Tool  

 

Curved Arrow Tool  
 

Line Tool  

 

Polyline Tool  
 

Freehand Draw 
Tool 

 

 

Rectangle Tool  
 

Circle Tool  

 

Polygon Tool  
 

Region Tool  

 

Zoom-Panning Tool 
Hold 
"A"  

Insert Equation  

 

Insert Word Object  
 

Insert Excel Object  

 

Insert Object  
 

Insert Graph  

 

Insert Worksheet  
 

Rescale Tool 
Hold "Z": Zoom; 
Hold "X": Pan 

 

Rotate Tool 
Hold 
"R" 

   

23.14 Object Edit 
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Button Description Button Description 

 

Left 
 

Right 

 

Top 
 

Bottom 

 

Vertical 
 

Horizontal 

 

Uniform Width 
 

Uniform Height 

 

Group 
 

Ungroup 

 

Distribute Selected Layers/Graphic 
Objects 

Evenly in Vertical Dimension 
 

Distribute Selected Layers/Graphic 
Objects 

Evenly in Horizontal Dimension 

 

Front 
 

Back 

 

Forward 
 

Backward 

 

Front(data) 
 

Back(data) 

23.15 Arrow 

 

Button Description Button Description 

 

Horizontal Alignment 
 

Vertical Alignment 



Origin Toolbars 

339 

 

Widen Head 
 

Narrow Head 

 

Lengthen Head 
 

Shorten Head 

23.16 Style 

 

Button Description Hotkey Button Description Hotkey 

 

Fill Color  
 

Line/Border Color  

 

Lighting Control Dialog  
 

Palette  

 

Line/Border Style  
 

Line/Border Width  

 

Fill Pattern  
 

Fill Pattern Width  

 

Pattern Color  
 

Clear Borders  

 

Left Border  
 

Top Border  

 

Right Border  
 

Bottom Border  

 

Frame Borders  
 

Inside Horizontal 
Borders 

 

 

Inside Vertical Borders  
 

Inside Horiz and Vert 
Borders 

 

 

All Horizontal Borders  
 

All Vertical Borders  
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All Borders  
 

Merge cells Ctrl+R 

23.17 Format 

 

Button 
Descriptio

n 
Hotkey Button Description Hotkey 

 

Font  
 

Font size  

 

Bold Ctrl+"B" 
 

Italic Ctrl+"I" 

 

Underlin
e 

Ctrl+"U" 
 

Superscript Ctrl+"+" 

 

Subscrip
t 

Ctrl+"=" 
 

SuperSubscri
pt 

Ctrl+"-" 

 

Increase 
Font 

Ctrl+">"  

Ctrl+Shift+
"." 

 

Decrease 
Font 

Ctrl+"<"  

Ctrl+Shift+
"," 

 

Greek Ctrl+"G" 
 

Left  

 

Center 
Horizont

al 

 
 

Right  

 

Top  
 

Center 
Vertical 

 

 

Bottom  
 

Font Color  

23.18 Auto Update 
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Button Description 

 

Block Auto Update 

23.19 Database Access 

 

Button Description Button Description 

 

Open SQL Editor 
 

Open Query Builder 

 

Load ODQ File 
 

Preview Import 

 

Import data 
 

Remove SQL 

23.20 Markers & Locks 

 

Button Description Hotkey Button Description Hotkey 

 

Add Data Markers Ctrl+Alt+M 
 

Clear Data Markers Ctrl+Alt+N 

 

Marker Size  
 

Marker Hide Show  

 

Lock Positions     
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